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Preface

IBM® DB2® Document Manager Version 8.3 (Document Manager) is one of the 
newest members of the IBM Enterprise Content Management portfolio. 
Document Manager provides a secure and robust platform to manage the 
complete life cycle of business documents. It helps ensure accurate and 
up-to-date documents are available on demand. When configured with IBM 
Records Manager Version 4.1.2 (Records Manager), the Document Manager 
solution also provide records management capability.

This IBM Redbook provides a general solution guide for the records-enabled 
document management solution using Document Manager and Records 
Manager. The solution uses Document Manager to manage the documents, 
Records Manager to manage the declared records, and IBM DB2 Content 
Manager Version 8.3 (Content Manager) as the back-end content repository for 
the documents and declared records. This redbook helps you to plan and design 
the solution, perform end-to-end product installation and configuration, and 
implement the solution using a practical case study as an example.

This redbook is logically divided into two parts. The first part consists of the first 
six chapters of the redbook focusing on solution overview, concept, and theory. 
The second part consists of the last six chapters of the redbook focusing on 
practical end-to-end solution installation, configuration, implementation, and 
deployment.

In Chapter 1, we introduce the overall integrated solution and the products 
involved, including IBM DB2 Content Manager Records Enabler Version 8.3 
(Records Enabler). We discuss what Document Manager is, the benefits of 
Document Manager, the Document Manager components, the need for records 
management, and overviews of Records Manager and Records Enabler.

The best way to learn a new product or a solution is to work with related 
demonstrations and case studies. In Chapter 2, we introduce a case study to 
help you get a quick start. We demonstrate the capabilities of the Document 
Manager solution along with Records Manager through various screen shots of 
the sample application created for the case study. We intend to help you 
understand, from a practical view point, what a Document Manager solution can 
do for your company and how you can operate in the Document Manager system 
environment. 

In Chapter 3, we discuss how to design and plan a Document Manager solution. 
In Chapter 4, we discuss different options available to integrate the Records 
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Manager functions into a Document Manager system. Specifically, we 
concentrate on different ways of declaring and classifying documents within a 
Document Manager system using Records Manager. 

In any document management solution, it is important that the solution protects 
the business assets. Using the security features provided by Document 
Manager, Records Manager and the back-end content repository, Content 
Manager, we can guard the system against unauthorized access, control what 
users can do once they are in the system, and ensure that the security 
management of the records comply with the record keeping mandates and 
regulatory guidelines. In Chapter 6, we discuss security measures you can apply 
in the solution. 

In Chapter 7, we describe end-to-end product installation and configuration for 
the solution, including the associated fix packs installation.

In Chapter 8, we provide the design overview and configuration steps you need 
in order to implement the basic Document Manager solution for the case study 
described in Chapter 2. In Chapter 9, we show you how to implement advanced 
Document Manager features, including application integration, property 
exchange, e-mail notification, rendition, dynamic search folders, and document 
templates.

To add records management functions to the Document Manager solution, in 
Chapter 10, we describe the practical steps involved in creating a file plan, and 
associating security and classification rules. We show you how to enable an item 
type for record declaration and how it is configured within Document Manager. 
We show you how to configure Document Manager classes for various record 
declaration options. In Chapter 11, we provide additional Records Manager 
configuration options. We show you different Document Manager and Records 
Manager configuration options. We cover the automation service declaration and 
Records Manager link and set creation.

In Chapter 12, we describe how to deploy a Document Manager system 
integrated with the Records Manager engine. We describe how to move your 
configuration from a development or testing system to a production system.

This redbook is intended for IT architects and specialists who will be responsible 
for planning, designing, and implementing a records-enabled document 
management solution using Document Manager and Records Manager. In this 
redbook, we focus on important areas that are related to the overall end-to-end 
solution. For product-specific information such as detailed installation steps, we 
recommend reading the existing product manuals in conjunction with this 
redbook.
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Chapter 1. Solution overview

IBM DB2 Document Manager (Document Manager) is one of the newest 
members of the IBM Enterprise Content Management portfolio. Document 
Manager provides a secure and robust platform to manage the complete life 
cycle of business documents. It helps ensure accurate and up-to-date 
documents are available on demand. When integrated with IBM Records 
Manager (Records Manager), the Document Manager solution also provides 
records management capability.

The records-enabled document management solution we cover in this redbook 
consists of Document Manager, Records Manager, IBM DB2 Content Manager 
(Content Manager), and IBM DB2 Content Manager Records Enabler (Records 
Enabler).

In this chapter, we introduce Document Manager, Records Manager, Records 
Enabler, and the overall integrated solution.

We cover the following topics:

� What is Document Manager?
� Benefits of Document Manager
� Document Manager components
� The need for records management
� Records Manager overview
� Content Manager Records Enabler (CMRE) overview
� Integrated solution overview

1
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1.1  What is Document Manager?
IBM DB2 Document Manager (Document Manager) addresses the origination, 
approval, distribution, and revision of unstructured information. In the simplest 
terms, Document Manager enables electronic files to be reused or repurposed 
by multiple individuals. 

Document Manager applies a discipline called library sciences to catalog 
corporate information which can be in the form of hard copy (physical 
documents), electronic files generated by desktop applications, or just metadata 
or XML information created internally or externally. In any form, Document 
Manager is an application that allows you to index and file corporate information 
in a uniform and centralized way.

Document Manager focuses on cataloging key corporate information, the 
majority of which is unstructured material that often includes memos, word 
processing files, spreadsheets, presentations, faxes, scanned images, audio 
files, invoices, and XML-based information. However, unstructured material can 
also include three-dimensional objects, such as paper documents or drawings, 
videotapes, or any physical objects (which do not have to be in electronic form).

Cataloging is only the first step in Document Manager; to be successful in 
enterprise-wide deployment, Document Manager must tightly integrate into other 
business applications. In today's corporate environment, the majority of desktop 
computers use some form of the Microsoft® operating system and Microsoft 
applications to generate information. While there are other operating systems 
and other applications, there are many personal computers that are Microsoft 
driven and use Microsoft Office or mail applications to create information. 

Document Manager as it pertains to Microsoft
The Microsoft operating system stores electronic files in a flat file structure. A flat 
file structure means files are bound to a single folder (directory) and files cannot 
have the same file names within that directory. Because of the flat file structure, 
users may struggle to locate and manage different versions of the electronic files. 
Just remembering the file name is not the only challenge. Sharing files is a real 
challenge because users must have the foresight to know where the files should 
be located, as well as what to do when updating documents. In many cases, 
keeping the original version is extremely important. (We discuss this versioning 
concept in detail later). 
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1.2  Benefits of Document Manager
Eighty percent of the information generated within a corporation is in an 
unstructured form, and analysts estimate that 40% of a user's time is spent 
waiting for information. Corporations looking for a competitive edge see major 
savings by just reducing information retrieval time by a small percent. 
Corporations that have effectively used Document Manager have seen a 
tremendous improvement in their competitiveness and operational efficiency.

Document Manager helps employees make better decisions in a more timely 
fashion, because Document Manager helps catalog information and track 
version history while maintaining access control throughout the document life 
cycle process.

Easier document storage and retrieval
One important aspect of Document Manager is how it helps information 
producers, approvers, and consumers. The information producers are those 
who contribute to the information. The information approvers are those who 
need to sign off on the information. And the information consumers are those 
who review the material and act on the information.

Document Manager works by tying file names and file locations to a set of index 
attributes (catalog) maintained in a database. This methodology is commonly 
called a library sciences approach to filing documents.

Using this library sciences approach, you can store or retrieve files based on 
more than just the file names. Another advantage is that you can store files in 
such a way that the versions are maintained with the same file name, which 
becomes extremely important when maintaining file relationships. 

Integrated access control
Document Manager maintains access control through the document life cycle 
process. No one can access the files, attribute tables, or the library catalog 
directly without authorization. In addition, users never access an original file; 
instead, users work with copies that are delivered as new versions. This way, 
users cannot corrupt, damage, or delete the original file, or any of its versions.

Users can have a quick, simple, and constant way to find all files stored in the 
network anywhere in the network (as long as they have at least view access). 
The Document Manager interface provides a familiar file folder structure where 
users can navigate to documents via folders that maintain pointers to files. Users 
can run search queries on system attributes, user attributes, and content. Users 
can in turn save these queries as files to create dynamic search folders and then 
reuse them. (We discuss dynamic search folders in more detail later in the 
redbook.)

 

 

 

 

 Chapter 1. Solution overview 3



Greater access control through life cycle process
In many organizations, document updates may require approval before view 
access is granted to the general audiences. Typically once a document is 
completed, the access control remains static for the most part. Users and groups 
typically only need view access. However, during an update or approval process, 
the access control changes as the document is circulated for approval. To 
automate the access control, Document Manager uses state-based change 
control.

State-based change control has three key states:

� It provides producers access to documents so they can edit the documents.

� It can remove their access when the producers submit the documents for 
approval.

� Once the information approvers approve the documents, the access changes 
once more to allow the consumers to view the final version of the documents. 

We discuss document life cycle state in more detail later in the redbook.

Version control
At the heart of any document management system is version control. Version 
control ensures that every time a user edits a document, the originating 
document is still available in some form. This ensures that users can track 
changes made and roll back to the original document if necessary. 

A common method of managing version control is through the checkout and 
checkin processes. The checkout process flags the originating file so users can 
tell that a particular file is being edited by another user. The user that checks out 
a document has the only copy that can be checked back in. Checking in creates 
a new version of the document. In most document management systems, a 
version is nothing more than a copy of the original that also includes changes 
that the user made to the file. Each version is stored in a way that it has some 
link to the originating file. 

Version versus the revision process
In many cases, documents are considered living documents. This means that 
these documents are constantly updated, approved, and distributed. When 
working with the living documents, it is a common practice that while these 
documents are undergoing changes and approval, the original versions of the 
documents still need to be accessible by the consumer.

It is typical in the process of updating the original document that several versions 
may be created before it is finally approved. Consequently, only the final 
approved version is actually considered an official revision or the approved 
amended version. In other words, a new revision can contain multiple versions. 
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But the approved version, the one that actually replaces the original one is 
commonly considered the new revision of the document.

Document Manager provides a key benefit because it allows users to manage 
both revisions and versions. 

The Document Manager Revise process creates a working copy of a document 
from the original, whereby access controls to the working copy can be distinct 
from the original document. This process ensures that edits do not impact the 
accessibility of the released version. 

By maintaining the relationship to the original document and the revision, 
Document Manager allows the revision to be approved and provides provisions 
about what to do with the original once the final version of the revision is 
approved. This feature is critical especially when you consider that these 
documents can be components of other documents. 

Application integration
Document Manager integrates common desktop applications with the content, 
where you can access documents and even build components from within their 
native application. In other words, Document Manager can provide you with 
access to simple Microsoft Office files from within the application or can provide 
access to the Office files that have OLE links or are composed as XML 
documents. Document Manager also tightly integrates into Microsoft Outlook® 
and Lotus Notes® to provide you the ability to save messages and any 
attachments. Furthermore, Document Manager integrates into the two most 
popular desktop CAD applications (Bently MicroStation and AutoDesk 
AutoCAD), providing native compound document support for any reference file 
attached through these applications.

Information repurposing
With Document Manager, you can automatically transform documents written in 
one format into another format through document renditions, print/plot, and XML 
transformations. Using this technology, you can easily transform documents 
produced in one application into a non-editable format, such as TIF or PDF, or 
using XML transformed from one Web format to another.

When you combine these technologies with the others we have mentioned 
previously, you can get an idea of how powerful Document Manager is. You can 
easily distribute documents, that are generated in their native application, to all 
consumers in the appropriate context and format once they are approved. 

Take the example of a common procedure that is used in an organization. The 
procedure is likely made up of several documents. Each document requires 
review and approval before you can update it. Once you update it, it may be 
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found in printed form, in a Web page, or as a distinct document maintained by 
the records group. Using Document Manager, you can automate the process of 
updating and disseminating the document to all the various formats using a 
structured business process that follows corporate guidelines.

1.3  Document Manager components
Document Manager is built on a three-tier model. The model consists of:
� Document Manager clients
� Document Manager server and services
� Content repository

The content repository for a Document Manager solution is Content Manager. If 
you need to provide records management to the solution, you need Records 
Manager and Content Manager Records Enabler.

Document Manager clients
There are three types of Document Manager clients:

� Document Manager Desktop
� Document Manager Designer
� Document Manager Item Loader

In this redbook, we focus on the first two.

The Document Manager client applications are accessed and installed directly 
from a URL configured at the system installation time. 

The Document Manager Desktop is a client interface provided to users to access 
and manage documents within Document Manager. It enables users to add, 
delete, and modify documents in the system. In addition, users can search and 
view documents from the Desktop. Other activities users can perform in the 
Desktop include checking in and checking out documents, and transitioning 
documents through their life cycles. 

The Document Manager Designer is a client interface provided for system 
administrators and the designers of Document Manager. It enables 
administrators and designers to configure the Document Manager environment, 
the system setup, and the Document Manager Desktops. Without programming, 

Note: In this redbook, we use the wording Document Manager solution/ 
system interchangeably with the wording document management solution/ 
system. In addition, when we write that we are records enabling a solution, we 
mean to provide records management to the solution. 
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the designers can use the interface to customize Desktops for different users, 
and control what users can see and do once they are in a Document Manager 
system.

Document Manager server and services
The Document Manager server (also known as the Document Manager Library 
Server) is the core component of a Document Manager system. It services 
requests from Document Manager applications and it serves as the 
communicator between the content repository and the Document Manager 
applications. It comprises a set of dynamic link libraries (DLLs).

Other basic components of Document Manager are:

� Cache server
� Life cycle service
� Notification service

The cache server is responsible for maintaining the system’s cache configuration 
files up-to-date. Document Manager uses these cache files to reduce server to 
client communication and to communicate with Document Manager clients about 
changes in the Document Manager system configuration, such as users, menus, 
views, states, users’ folder creation and modification. The cache manager runs 
at a configurable interval basis, pooling changes from the server repository and 
preparing the cache file for the next user connection. In addition, each Document 
Manager Desktop maintains its own cache file based in the server cache file. The 
Desktop copies the cached information on the cache server to the local server 
each time it connects to the Document Manager server if the information has 
been changed since its last copy.

The life cycle service manages documents’ life cycle. It is responsible for 
processing document actions submitted from the Document Manager Desktop, 
the Item Loader, or Automation Services. Examples of these actions include 
sending an e-mail notification, creating a printing job, and starting a rendition 
process.

The notification service processes e-mail notifications and sends e-mails to the 
designated users. The notification process is triggered by a Document Manager 
life cycle process and can either attach the document or include the document 
link to the e-mail.

Document Manager also offers the following optional services:

� Print/plot service
� Rendition service
� Automation service
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The print/plot service controls a print job queue and is responsible for sending 
documents to printers for printing in the system. You can manually define the 
print/plot jobs or you can automatically create them by a life cycle trigger. This 
service also allows users to print documents, even if they do not have the original 
application in their own workstations, because the print/plot service directs the 
print jobs to the printer/plotter attached to a server that has the necessary 
application to open and print the document in the required format.

The rendition service is responsible for rendering documents in PDF or TIFF 
format for document security or distribution purposes. Because renditions are 
usually created in popular formats, users can view the renditioned documents 
even if they do not have the applications that created the original documents or 
the necessary applications to view the documents in their original format.

The automation service is responsible for processing predefined, time-based, 
automatic actions. Examples of actions include delete, send to print, archive, 
transition documents, or trigger external applications.

Content repository
The content repository is responsible for physically storing the documents for a 
Document Manager system. For the records-enabled document management 
solution we cover in this redbook, Content Manager serves as the content 
repository for the documents in the system.

1.4  The need for records management
Document Manager addresses the origination, approval, distribution, and 
revision of unstructured information, but it does not address the record keeping 
needs of a business. Historically, the focus was on document creation and 
capture, and we often overlooked when and how to get rid of some information 
while preserving other information. This is why you need a records management 
component in your solution. Records management provides the ability of your 
solution to declare documents as records and apply retention and disposition 
rules to the records. Records management provides a structured means of 
preserving needed content and destroying that which is no longer needed. The 
rules for record keeping are based on regulations, laws, and business policies 
which usually are unique for every organization.

Each record has a life cycle associated with it. Life cycle specifies a collection of 
phases a record must go through from the time it is declared a record to the time 
it is disposed of. Retention schedule, also known as retention rules, specifies 
how long a record stays (is retained) in a phase and when the record transitions 
to the next phase. Retention rules are time, event, or event and time-based. It is 
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important to keep records as long as required and destroy them as soon as 
possible. Properly disposing of records reduces storage costs and liability of an 
organization.

A structured records management system simplifies record keeping and 
improves operational efficiency by reducing the retrieval time of records. A 
system that maintains records properly helps a business to prove compliance 
with regulatory and legal obligations. Litigation risk is reduced as compliance is 
increased.

In the records-enabled document management solution we cover in this redbook, 
it is mainly a Document Manager solution that integrates with Records Manager 
and Content Manager Records Enabler to provide records management 
functions.

1.5  Records Manager overview
IBM Records Manager (Records Manager) is an application and also an 
embedded engine that enables the management of enterprise’s electronic and 
physical records throughout their records’ life cycles. Records Manager delivers 
the record keeping functions through the embedded engine technology. It is 
integrated with applications such as IBM DB2 Content Manager, IBM DB2 
Document Manager, IBM DB2 CommonStore for Lotus Domino, and IBM DB2 
CommonStore for Exchange Server. Records Manager APIs facilitate the 
integration with any application that requires its record keeping capabilities.

Records Manager provides the following record keeping functions:

� Corporate records declaration and classification
� Records life cycle management
� Record metadata management
� Record content searching, retrieval, and viewing (including text search)
� Document auditing and reporting
� Users and security management

Some of the reasons why you might want to integrate Records Manager with 
your business applications include:

� Meet compliance requirements.
� Support required business processes, procedures, and standards.
� Embedded engine technology seamlessly integrates with other applications.
� Web-based administration client.
� API integration using Java, C++, and .Net.
� Scalable architecture.
� Flexible file plan design.
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� Content is maintained in the host application’s repository.
� DoD 5015.2 and PRO-certified.

With Records Manager, you can declare and classify records from using fully 
automatic procedures to manual processing.

1.5.1  Records Manager components
Records Manager has five components:

� Records Manager engine 
� Records Manager database
� Records Manager APIs
� Records Manager administration client
� Import export utility

Records Manager engine 
The Records Manager engine provides all the functions required for record 
keeping and life cycle management. The engine allows system integrators to 
customize a solution for any type of application. This records enabling 
technology is already integrated into IBM Enterprise Content Management 
solution.

Records Manager database
The Records Manager database stores the file plan data, schema, and stored 
procedures for use with the engine. Only metadata about the records is stored in 
the Records Manager database; the associated document content is maintained 
in the application repository.

Records Manager APIs
The Records Manager application programming interface is used to manage 
records programmatically. With the APIs, the business applications can embed 
the electronic records process, so that users can declare and classify documents 
within the business applications. The APIs can be called from most programming 
environments, including Java, C++, and .Net. You can access all engine 
functions through the APIs.

Records Manager administration client 
The Records Manager administration client is a Web browser-based application 
that allows administrators to perform all record keeping activities. The Records 
Manager administration client is fully customizable and uses the Records 
Manager APIs.
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Import export utility
Use the import export utility to efficiently manage the transfer of file plan data. 
Use the utility to transfer data from an existing Records Manager system’s file 
plan into another one. This is useful when you want to deploy the Records 
Manager configuration from a testing or development environment to a 
production environment. The utility is an application that uses the Records 
Manager APIs.

1.6  Content Manager Records Enabler (CMRE) overview
Content Manager Records Enabler provides comprehensive records keeping to 
any content placed in Content Manager (regardless of how), and integrates 
record management features into all the clients and access methods that can 
create and capture content in Content Manager.

Records Manager is an engine that, when integrated with a business application, 
enables the business application to provide records management. Content 
Manager Records Enabler (Records Enabler) provides the integration needed 
for a Content Manager application to integrate with Records Manager to provide 
this records management capability. Together with Records Manager’s record 
management functions, and Content Manager’s content repository, CMRE 
delivers the records management function to all Content Manager applications 
and clients. This complete record keeping solution is available through clients 
such as the Content Manager Client for Windows®, eClient, Document Manager, 
Lotus Notes, and Microsoft Outlook. Working with Document Manager, the 
solution provides extensive record creation and management capabilities.

With Records Enabler, you can declare corporate documents or content as 
corporate records within Content Manager, Document Manager, or 
CommonStore. Once a document is declared as a record, the content and 
associated document metadata remain in the original content repository (which is 
Content Manager) and the document can no longer be edited or deleted. Some 
of the document’s metadata and records-related information are also stored in 
the Records Manager database. The access permissions and life cycle of the 
record and its content are governed by Records Manager. Only authorized 
users, such as the record’s administrators, can process or manage the life cycle 
of records.

Records Enabler provides the following functions for Content Manager users: 

� Automatically or manually declare and classify Content Manager objects.
� View record information.
� Search, retrieve, and view record contents.
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� Perform text search on documents (including declared records) in the 
repository.

Records Enabler provides the following functions for records management:

� Perform on-demand and scheduled permission synchronization.
� Undeclare records.
� Import Content Manager user and group accounts into Records Manager.
� Perform text search on items stored in the Content Manager repository.
� Life cycle management, including record destruction.
� Provide defaults for record declaration and classification.

1.6.1  Content Manager Records Enabler components
Records enabler consists of the following components:

� Records Enabler Server
� Records Enabler Host Interface Server
� Records Enabler Permission Synchronization Server
� Records Manager Extensions 

Records Enabler Server
Records Enabler Server provides a centralized base for handling Records 
Enabler user requests and their appropriate actions.

Records Enabler Host Interface Server
Records Enabler Host Interface Server implements the Records Manager Host 
Interface application program interface (API) for Content Manager to enable 
communication between Records Manager and Content Manager. 

Records Enabler Permission Synchronization Server
Records Enabler Permission Synchronization Server performs on-demand and 
scheduled permission synchronization tasks from the latest file plan components 
that have their permission policies changed since the previous synchronization 
and the corresponding items in Content Manager or Records Manager.

Records Manager Extensions
Records Manager Extensions extends the Records Manager installation to 
support Records Enabler. It provides the notification service for permissions 
synchronization between Records Manager and Content Manager. You must 
install this subsystem on a Records Manager server. 
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1.7  Integrated solution overview
The records-enabled document management solution on which we focus in this 
IBM Redbook comprises the products we introduced in the previous sections and 
Content Manager:

� Document Manager
� Records Manager
� Content Manager
� Content Manager Records Enabler

Figure 1-1 shows the system architecture of the integrated system.

Figure 1-1   Records-enabled DM solution system architecture

Note, Records Enabler Extension is a part of the Content Manager Records 
Enabler (CMRE).

The integrated solution offers the following functions:

� Using the Document Manager Desktop, you can:

– Add, delete, or modify documents in the Document Manager system.

Document Manager Server

Records Manager
Admin Client

Browser

Content Manager
Records Enabler

Host 
Interface

Server Perm 
Sync

Records Manager Server

Records Enabler 
Extensions

Content Repository
(Content Manager Server)

Cache 
Server

Resource Manager

Item
Type

Library Server

Document Manager
Desktop

Rendition 
Service

Print/Plot
Service

Automation
Service

Life Cycle
Service

Notification
Service

 

 

 

 

 Chapter 1. Solution overview 13



– Search, retrieve, and view documents.
– Manage documents through their life cycles (non-records related).
– Declare and classify documents.
– View records management information.
– Search and retrieve declared records.

� Using Records Manager administration client, you can:

– Declare electronic and physical documents as records. 
– Destroy or undeclare records.
– Search, import, retrieve, and view record contents. 
– Retrieve record contents from Content Manager repository. 
– Query records or generate record reports. 
– Perform record’s life cycle management.
– Perform the administration for users who work with records.
– Perform other records-related management.
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Chapter 2. Quick start with case study

The best way to learn a new product or a solution is to work with the related 
demonstrations and case studies. To help you get a quick start with the 
records-enabled document management solution, we introduce a case study in 
this chapter that we use throughout this redbook. For this case study, we use a 
hypothetical company, ZXY Technologies. We discuss the company’s 
requirements for a document management solution, and demonstrate the 
capabilities of Document Manager along with Records Manager through various 
screen shots of the sample application that we create for the solution. We intend 
to help you understand, from a practical view point, what a Document Manager 
solution can do for your company and how you can operate in the Document 
Manager system environment. In later chapters of this redbook, we show you the 
steps involved in implementing the sample solution.

We cover the following topics in this chapter:

� Case study overview
� Sample solution demonstration

2
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2.1  Introduction
The purpose of the case study is to identify common, non-industry specific, 
document management applications, to demonstrate the Document Manager 
(along with Records Manager) capabilities, and to illustrate ways to create a 
solution that translates into any industry or corporation.

We begin by describing the requirements of a document management solution 
for the ZXY Technologies Company (see 2.2, “Case study overview” on page 16). 
We then show you what the final system looks like and what you can do with it 
(see 2.3, “Sample solution demonstration” on page 19). 

In later chapters, we show you:

� How to apply the requirements to design a solution for the ZXY Technologies 
Company (see Chapter 3, “Document Manager solution design and planning” 
on page 47).

� How to install the products for the solution (see Chapter 7, “Installation and 
configuration” on page 151).

� How to fulfill the requirements by creating a Document Manager system (see 
Chapter 8, “Basic Document Manager implementation” on page 239 through 
Chapter 11, “Other record declaration options in Document Manager solution” 
on page 399).

2.2  Case study overview
The case study involves a hypothetical company, ZXY Technologies. It sells 
hardware, software, and services to its clients.

2.2.1  Requirements
ZXY Technologies needs an enterprise-wide, document management solution to 
help the company with the proposal creation processes and keep track of all the 
correspondence related to the proposals.

We examine the requirement for proposals and correspondence in this section. 
In addition, we briefly review the requirements for records and confidential 
documents.

Proposals
Every month, ZXY Technologies handles hundreds of requests for proposals 
from its clients.
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Proposals are commonly used both to request information and to submit 
information. Customers issue proposal requests seeking pricing or product 
information. The ZXY Technologies Company issues proposal responses 
providing pricing or product information. 

Proposal requests are sources of unstructured data. They contain information 
critical to a project or critical to serving a customer. They can come in the form of 
an e-mail, phone call, fax, or a business letter.

With proposal responses, ZXY Technologies delivers the required product and 
pricing information to customers based on the customers’ proposal requests. 
There are multiple steps in the proposal response creation process: response 
creation, review, approval, and delivery to the customer.

ZXY Technologies needs a solution to manage all documents involved in the 
proposal creation process from end-to-end. This includes managing documents 
from the beginning, when the requests for proposals come in from customers as 
e-mails, faxes, phone calls, or letters, until the end, when the formal proposal 
responses are delivered back to the customers. 

The company has a different department that creates each type of proposal. 

There are three types of proposals:

� Sales proposals: These are proposals related to selling hardware and 
software to external customers. Salespeople create them and deliver them to 
customers.

� Services proposals: These are proposals related to selling services to 
external customers. Consultants create them and deliver them to customers. 

� Marketing proposals: These are proposals related to marketing campaigns 
for ZXY Technologies. Marketing people create them and deliver them to 
internal clients within the company.

ZXY Technologies wants to manage different proposals with separate controls, 
so that each department is responsible for the final proposal delivery. It also 
wants a system that can automatically send e-mails to people who must review 
or approve the proposals to accelerate the entire proposal creation process.

Generally, the proposal process goes through the following steps:

1. The external or internal client sends a request for proposal.

2. The sales, consulting, or marketing people create a proposal using a 
predefined proposal template. The proposal creator then sends the proposal 
for review.
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3. The reviewers are the department managers and financial people that control 
the proposal before it goes to the approved state.

4. Depending on the type of the proposal, usually, the manager of the 
department is responsible for final approval or rejection of the proposal.

5. If approved, the formal proposal is sent to the external or internal customer.

In addition, ZXY Technologies wants to automatically generate a unique ID for 
each proposal so that it is easier to keep track of the proposal. They can also use 
the unique IDs as references in other administrative documents.

The employees in ZXY Technologies use Microsoft Word to create proposals, 
but they use PDF as the standard delivery format for the final proposals to 
customers.

Correspondence
Every day, there are hundreds of pieces of correspondence coming in and out of 
ZXY Technologies. The correspondence helps in the completion of sales. For 
example, the account manager uses information received from the sales 
manager (e-mails with pricing approvals) and information received from the 
customer (courier delivery of a request for proposal) to deliver a completed price 
proposal and to close a sale. Correspondence can also hinder the company if 
correspondence is not managed properly, quickly, and efficiently. For example, if 
the account manager references information from an old e-mail with out-of-date 
price information and delivers the incorrect price information to the customer, 
ZXY Technologies can lose money in the price quoted to the customer. The 
account manager can lose the sale if the request for proposal does reach the 
account manager’s desk in time to respond, or if the account manager is out of 
the office and no one sees the request for proposal in time to respond by the 
deadline. 

ZXY Technologies must have a document management system that can help it 
capture, control, and access the selected data coming in and out through the 
basic correspondence channels of the organization.

In addition, ZXY Technologies requires employees to store project-related 
e-mails and attachments (based on their discretion) in the system.

Records and confidential documents
Due to regulations and company policies, employees must make all finalized 
proposals of ZXY Technologies official company records. ZXY Technologies 
therefore is looking for a document management system that can automatically 
declare these finalized proposals as records. In addition, ZXY Technologies 
needs to have the ability to manually declare special documents, such as 
reference documents or correspondence used for the proposals, as records.
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2.3  Sample solution demonstration
In this section, we demonstrate a sample Document Manager solution designed 
for ZXY Technologies using screen shots. Through the demonstration of the 
sample application, we introduce the various Document Manager functions and 
capabilities, and show how they apply to ZXY Technologies’ business 
requirements, and therefore potentially to your company’s business needs.

We feature the following Document Manager functions and capabilities in the 
case study solution:

� Easy to use Web interface for users
� Full text indexing using Net Search Extender
� Unique document numbering
� Role-based life cycle management
� Revision
� Microsoft Word and Lotus Notes integration
� E-mail notification
� PDF rendition
� Information organization using dynamic search folders
� Document templates
� Records Management integration, including:

– Manual declare
– Quick declare: Automatically and by selection
– Version history declare

We examine each portion of the case study solution through screen shots, so 
you have a practical understanding of exactly what the final solution looks like 
and how a Document Manager application generally operates.

2.3.1  User interface: Introducing Document Manager Desktop
Users interface with a Document Manager (DM) system through the Document 
Manager Desktop. The Document Manager Desktop is a Web client. All user 
interface configurations exist on the Document Manager server rather than on 
the local computers. 

You use the Document Manager Desktop to define the user experience. 

Note: The Document Manager solution enables quick application deployment 
and modification. No administrator has to go through every user’s workstation 
to make changes to the application and desktop. 
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Desktop templates control the look and feel of Desktops. You assign different 
Desktop templates to different users or groups of users, enabling a different 
Document Manager Desktop “look and feel” or template for various users.

For ZXY Technologies, we created three Desktop templates for the Document 
Manager system. Each Desktop template has unique menus and icons that 
those users need for their daily work.

The three Desktop templates are:

� Admin template: We designed this template for users whose primary 
function is to perform Document Manager system administration.

� Content producers template: We designed this template for users whose 
primary function is to create and contribute content and to manage the life 
cycles of that content through revisions and approvals.

� Viewers template: We designed this template for users whose primary role is 
to access and view information.

Figure 2-1 provides an example of the Desktop of a viewer.

Figure 2-1   Example of a DM Desktop for a Viewers Template 
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A Desktop consists of five main sections:

� Active menu: Provides access to the global actions in the system (for 
example, login, logout, and the about menus). In this redbook, we also refer 
to the active menu as the main menu.

� Top toolbar: Provides quick access to actions available to the users in the 
system (for example, the Add Document, Search, and Delete icons for 
content producers).

� Bottom toolbar: Provides quick access to actions available to the users in 
the system on the bottom of the window (not shown in Figure 2-1).

� Folder pane: Provides access to users’ folders and saved searches.

� Documents pane: Displays search results. You can use different views to 
see results. For example, one view may show all the attributes of the 
documents, while another view shows only certain attributes of the 
documents with filters. Depending on your configuration, there is a default 
view, and you can select from other views to see information if the views are 
available.

Figure 2-2 provides an example of the Desktop for content producers.

Figure 2-2   Example of a DM Desktop for a Content Producers Template 

Note, the Content Producers Desktop contains more icons, such as Add 
Document, Modify, Revise, and Delete, than the Viewers Desktop.
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2.3.2  Adding documents
Users can add documents into a Document Manager system in many ways, such 
as:

� Document Manager Desktop
� Microsoft Word integration
� Lotus Notes integration

Depending on your business requirement, you can configure the system to 
create a full text index on the added documents. 

In addition, once you add the documents, Document Manager gives you the 
option of checking out the document for edit, or checking out the document and 
launching the application with the document in edit mode.

Adding documents using the Document Manager Desktop
Usually, there is an Add Document icon or a menu selection in the Desktop that 
enables you to add a document to the system. 

For the sample application, use the following steps to add a sales proposal:

1. Launch the Document Manager Desktop from Internet Explorer using the 
following URL:

C:\Program Files\IBM\DB2 Document Manager\default.htm

2. Open the login window by clicking CorporateLibrary. Log in as usrSale, 
using password for the password. 

3. Click Add Document from the Desktop’s top toolbar.

4. Browse through the file system and find the document to add. Double-click 
the document or select the document and click Open.

5. Select Class → Sales Proposal. A dialog box appears (see Figure 2-3). 

6. Enter the necessary information, such as the Customer Name, Customer 
Number, Request for Proposal Number, Proposal Subject, and check the 
date box under the Create Date field. 

Full text indexing of a document is available through DB2 Net Search 
Extender. In Figure 2-3, the Search index option is checked. With this option 
checked, the system creates full text index for the entire document in the 
Document Manager system.

7. Click Apply to import the document into the system.
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Figure 2-3   Add dialog box

8. Once you import the document, the system displays the Process document 
checkout dialog box as shown in Figure 2-4. There are three choices 
implemented in the sample application:

– Checkout: Check out the imported document from the system.
– Checkout Launch: Check out and launch the document in edit mode.
– Cancel: Import the document to the system only and do nothing else.

Select Cancel for this exercise.

Figure 2-4   Process Document Checkout window
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Once you import a document into a Document Manager system, you can locate it 
by a manual search or via the dynamic search folder. We discuss document 
searching in 2.3.3, “Searching documents” on page 24 and 2.3.10, “Dynamic 
search folders” on page 36.

Adding documents using Word or Lotus Notes integration
Document Manager enables you to customize the Microsoft Word or Lotus Notes 
user interface (both menus and icons) for seamless application integration. 

For example, you can customize the applications so that, when you save a new 
or an existing document or e-mail, you can choose to add the document to the 
Document Manager system. In addition, you can customize the application so 
that additional actions are available (through menus and icons) to users to 
manually import the document to the Document Manager system.

We discuss this more in 2.3.7, “Microsoft Word and Lotus Notes integration” on 
page 31.

2.3.3  Searching documents
Once you add documents to the Document Manager system and optionally index 
them, users can search the documents via their attributes or their content.

Document Manager provides two search functions:

� Basic search: Search by document attributes and optionally by document 
content.

� Power search: In addition to the basic search function, power search 
enables users to use complex search queries to search for documents.

Both options usually appear as icons on the Desktop depending on the users 
role. To activate the searches, simply click the Search or Power Search icon.

Figure 2-5 shows the basic search window when the user clicks the Search icon. 
The General tab is the default tab. In this window, you can enter the attributes of 
the documents for which you want to search. Figure 2-6 shows the Document 
Content search tab. You can search documents via their contents and combine 
with the previous search tab criteria.
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Figure 2-5   General search tab

Figure 2-6   Document Content search tab

The search results appear in the documents pane. To open the document, you 
can double-click the document entry or right-click the document and select an 
action from the context menu (see Figure 2-7).
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Figure 2-7   View documents

Note, the Checkout-Launch option is available from the context menu of the 
resulting document. Here you can check out the document, launch it in the edit 
mode, and start modifying the document. If the document is written in Microsoft 
Word, Document Manager can automatically open the document in Word for you 
to edit - a seamless integration with Word.

2.3.4  Unique document numbering
Document Manager offers a unique document numbering feature, also known as 
item numbering. You can use it to assign a unique number to each document in 
the Document Manager system. The unique number can be numeric, alpha, 
alphanumeric, or a Globally Unique Identifier.

For the sample application, we use this function to automatically generate the 
proposal numbers and e-mail tracking numbers when we import proposals and 
e-mails into the Document Manager system (see Figure 2-8).

Figure 2-8   Unique document numbering (item numbering) function

Proposal Number
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2.3.5  Compound documents
Because a document can be an aggregate of other documents, the management 
of the individual document and the awareness of other associated documents 
are critical. Document Managers compound document management provides the 
capability to manage the relationships among Microsoft Office documents and 
their linked objects, CAD drawings and their references, complex parent-child 
document relationships, and peer-to-peer relationships.

You can associate documents with each other and create a compound document 
as shown in Figure 2-9. In the example, the ECM Solution Document also 
contains two child documents: the ECM Architecture Diagram and the ECM Price 
List.

Figure 2-9   Compound documents

Creating a compound document
To create a compound document, this is the general procedure:

1. Select the parent document first. 

2. Right-click and select CpDoc Manager from the context menu (see 
Figure 2-10).

Figure 2-10   Add compound document

3. The Compound Document Manager window appears (see Figure 2-11, 
except there are no child documents associated with it yet). 
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Figure 2-11   Compound Document Manager window

4. Click Add, Apply, and then select the document that you want to make a part 
of the compound document. For the example, we select the ECM Price List to 
be part of the compound document. Click OK to add it to the list.

5. Repeat Step 4 for other documents that you want to add to the compound 
document. For the example, we add one more document, the ECM 
Architecture Diagram. There are a total of two additional documents in the 
compound document (see Figure 2-11).

6. Click Done.

When you expand the parent document, the child documents display beneath it 
(see Figure 2-9 on page 27).

2.3.6  Role-based life cycle management
In the Document Manager system, a document can go through various states in 
a life cycle. Depending upon the business requirements, different types of 
documents go through different life cycles.

For the sample application, there are four states in a proposal’s life cycle: Draft, 
Review, Approval, and Issued.

From the Document Manager Desktop, you identify the current state of a 
document and can transition a document to the next step in the document life 
cycle.

 

 

 

 

28 IBM DB2 Document Manager with IBM Records Manager Solution Guide



Viewing the current state of a document in its life cycle
Users view the current state of documents in two ways:

� From the Document Manager Desktop (see Figure 2-12). The State column 
has the current document state (assuming the view contains the column).

� From a document’s life cycle map (see Figure 2-13). Do this by right-clicking 
the document and selecting Document Lifecycle from the context menu.

Figure 2-12   Current state in view

Figure 2-13   Current state in life cycle

State

 

 

 

 

 Chapter 2. Quick start with case study 29



Note, the current state has a different color that distinguishes it from the rest of 
the states in the life cycle. For Figure 2-13, the current state is the Issued state 
which is red. 

By selecting the Activity Log tab, you can view the entire life cycle’s activity logs 
(see Figure 2-14).

Figure 2-14   Life cycle Activity Log window

Transitioning a document from one state to another 
To transition a document from one state to another within its life cycle, there are 
two options. You can select the document and click the Transition icon in the 
Desktop toolbar, or select the document, right-click it, and select the Transition 
option from the context menu (see Figure 2-7 on page 26).

Both actions display the Transition Controlled Items window (see Figure 2-15). 

Figure 2-15   Transition Controlled Items window
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In the dialog box, you can transition the document from the Draft state to the 
Review state by selecting the document (optional) and clicking Submit. Note, 
you can transition multiple documents from one state to another.

2.3.7  Microsoft Word and Lotus Notes integration
Document Manager has the capability of integrating with other applications such 
as Microsoft Word and Lotus Notes. Users can perform Document Manager 
functions within these applications, when integrated. For example, after the user 
finishes working on a document in Microsoft Word, the user can check the 
document into the Document Manager system immediately while still in the 
Microsoft Word application. Document Manager provides easy access, retrieval, 
and management of the document for users.

In this section, we show application integration with Word and Notes. Examples 
of other applications with which Document Manager can integrate include 
Microsoft Excel® and Power Point.

Document Manager also provides a property exchange feature that enables you 
to copy document properties (attributes) from the integrated application to the 
Document Manager system (also called the library) or vice versa.

Integration with Microsoft Word
For the case study, the ZXY Technologies users are familiar with the Microsoft 
Word interface and use Word to create proposals. We configure Document 
Manager to integrate with Word to provide easy access for users.

Figure 2-16 shows how a Document Manager menu integrates within a Microsoft 
Word application. In the Word main menu, we add a Document Manager menu. 
Within the Document Manager menu, users can add the current document to the 
Document Manager system using the Update Library Item action, view the 
document life cycle using Document Lifecycle, and update its information using 
Update Library Item. 

Depending on your business requirements, you can integrate any number of 
actions in Word via the main menu, submenus, actions, or icons.

Note: Document Managers application integration feature enables users to 
work on the same applications (for example, Word or Lotus Notes) that they 
use when they create content (for example, a Word document or an e-mail). 
This reduces the learning curve for the users of the new system and provides 
users easy access to the system.
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Figure 2-16   Microsoft Word integration

Integration with Lotus Notes
You can add the Document Manager add-on menus in the Notes Actions menu. 
The options include DM Insert, DM Attach, DM Save, and DM Import. See 
Figure 2-17.

Note, for the case study, users use the Lotus Notes e-mail application to store 
e-mails received from and sent to ZXY Technologies.
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Figure 2-17   Lotus Notes integration

Property exchange
Document Manager provides the property exchange feature when integrating 
with other applications. For example, if you map the attributes of an e-mail in the 
creating application (Notes) to the Document Manager system, you can 
configure the Document Manager system to automatically fill these attributes in 
the Document Manager system when you import an e-mail to the system. In 
addition, you can set up the system so that it automatically reflects any changes 
to the attributes in the Document Manager system in the originating application 
(in this case, Notes).

Examples of exchanged attributes include To, From, and Subject from an e-mail, 
and Author from a Word document.

2.3.8  E-mail notification
Document Manager supports automatic e-mail notification. This is useful if you 
want to notify people when certain events happen. For example, when you 
create a sales proposal, you want to notify the reviewers immediately so they can 
review the proposal as soon as possible.
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In the sample application, we use the e-mail notification at two points of a 
document’s life cycle: When it is first created and when it is ready for review.

When we create a new proposal, the system sends an e-mail notification to a 
project manager. The project manager uses the e-mail information to create a 
new classification path in the company's file plan for records management. This 
classification path will be used to store all information related to the proposal, 
including the request for proposal, the final proposal, and the correspondence.

Figure 2-18 shows a sample of the e-mail that a project manager receives.

Figure 2-18   Project Manager notification

You can configure the body and subject inside the Document Manager designer. 
We also use a variable to add the new proposal number inside the e-mail. For 
the sample application, the project manager does not need to see the actual 
proposal request; rather, the project manager only needs the proposal number to 
create the new classification path in the company's file plan. 

What we show here is what you can do with a Document Manager system. The 
actual implementation depends on your business requirements.

The other point in the document’s life cycle when we use the e-mail notification 
feature is when a document is ready for review. In this scenario, the system 
automatically sends an e-mail to the appropriate reviewers. Reviewers need to 
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read, review, and control all the proposals, before the proposals are sent for 
approval. 

Figure 2-19 shows a sample of an e-mail that a reviewer receives.

Figure 2-19   Reviewers notification

The body of the e-mail has a direct link to the proposal that the reviewer has to 
review and read. This accelerates the review process, because this alerts the 
reviewer that the proposal is ready and reminds the reviewer to review the 
proposal as soon as possible. It also saves the reviewer time because the e-mail 
provides the link to the proposal, and the reviewer does not have to search for 
the proposal in the system.

2.3.9  PDF rendition
Often, when you review, approve, and finalize a document, you want to create a 
PDF rendition of the document to distribute to others. This is important if you do 
not want viewers to have access to the source document or the capability to 
modify the document in any way. PDF renditions are also useful if the viewers do 
not have the application to view the document in its original format. Document 
Manager provides the PDF rendition service to accommodate these business 
requirements.

For the sample application, when the approver has finalized and approved the 
proposal in Microsoft Word format, and the approver is ready to issue it to others, 
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the proposal enters the Issued state. When this happens, the Document Manager 
automatically creates a PDF rendition of the Word document, saves the new 
PDF rendition in a PDF state, and automatically creates a PDF relationship type.

The first entry in Figure 2-20 shows the original Microsoft Word document of a 
sales proposal in the Issued state. The proposal number is 00062. The second 
one is the PDF version of the same sales proposal with the same attributes, and 
is in the PDF state. These documents are related to each other. The PDF 
rendition object that we define in the Document Manager system establishes the 
relationship. As a result of this relationship, the system assigns the same 
attributes from the Word document to the PDF document when the PDF file is 
renditioned. Document Manager also allows duplication of the unique attribute, 
the proposal number, to both the Word document and to the PDF document.

Figure 2-20   Document PDF rendition

2.3.10  Dynamic search folders
In a Document Manager system, you can create dynamic search folders to 
quickly search for frequently used documents. A dynamic search folder is a 
folder that is associated with a predefined query. Selecting a dynamic search 
folder is similar to executing a saved search.

Figure 2-21 shows the Desktop with dynamic search folders. The left folder pane 
shows the PDF dynamic search folder. The right document pane shows all files in 
PDF states.
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Figure 2-21   Dynamic search folders

The visible difference between standard folders and dynamic search folders is 
that the dynamic search folders have a magnifying glass visible over their folder 
icons.

2.3.11  Adding documents from document templates
As we mentioned earlier, there are many ways to add (or import) a document into 
the Document Manager system. Document Manager offers the document 
template feature that enables you to standardize the user input and content 
format of a new document into the system. 

Document templates are also a place to consider records pre-classification. The 
best records solution is transparent and touchless (or no user interaction) for the 
user and provides repeatable, accurate record creation and classification. 
Sometimes, it is possible to define the classification and type of record in the 
document template (or life cycle) that can be used later to automate record 
actions.

For the case study, ZXY Technologies uses the document template to 
standardize the proposal document across the company and to accelerate the 
creation process. Each department has its own proposal document template.

For the sample application, you can add a new proposal from a template by 
selecting Template → Create Sales Proposal (see Figure 2-22). Figure 2-23 
shows the template with pre-filled attribute information.
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Figure 2-22   Create Sales Proposal

Figure 2-23   Add document from document template

With a document template, users do not need to create a new document from 
scratch. The document template command automatically creates a new proposal 
document from the standardized template. 

2.3.12  Revision
Document Manager supports document revision management. 

In the sample application, we demonstrate the revision capability by revising an 
already issued proposal. An issued proposal has already gone through its life 
cycle and is at the Issued state. 
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The original documents have revision number 01. If an issued document needs 
to be revised, the user can select the document, click Revise, and this creates a 
new document with revision number 01-0A. The new document begins at the 
Draft state again and it goes through the document’s life cycle until it is also in 
the Issued state.

Figure 2-24 shows the Revise Proposal dialog box when you click the Revise 
icon on the toolbar.

Figure 2-24   Revise Proposal window

On the dialog box, you can modify the proposal subject for the new revision and 
click Apply.

Once you create a new revision, the system looks similar to Figure 2-25. The 
sales proposal with proposal number 70 has two revisions. The original one is in 
the Issued state and the working revision is in the Draft state.

Figure 2-25   New revision and original revision

After the new revision goes through its life cycle (that is, after it is reviewed and 
approved) and is in the Issued state, the revision number of the new document 
becomes 02. The original document with revision number 01 is moved to the 
Superseded state. See Figure 2-26. 

 

 

 

 

 Chapter 2. Quick start with case study 39



Figure 2-26   New revision in Issued state and original in superseded state

Newer revisions increase the revision number. You can configure Document 
Manager to use a mixture of numbers and letters to indicate new revisions.

2.3.13  Records Management integration
Document Manager integrates with Records Manager to add the record 
management function to the Document Manager system. You can declare and 
classify records in many ways depending on your business needs. For example, 
you can automate the creation of a record based on the final approved life cycle 
step for a document.

Within a Document Manager system, you can implement the automatic quick 
declare function, so that when a certain event happens (for example, when a 
document enters or leaves a state), the system automatically declares the 
document to be a record. On the Document Manager Desktop, you can also 
configure quick declare and manual declare options for users to declare records. 

When working with versioned documents, Document Manager enables you to 
declare earlier versions of the document to become records in addition to 
declaring the latest version of the document as a record.

Automatic quick declare within the system
The automatic quick declaration capability enables documents to be declared as 
records without user intervention. In a production environment, automatic 
records declaration is the preferred way to do this because it reduces human 
errors and ensures that the key documents get declared as records.

In the ZXY Technologies case study, the proposal documents, requests for 
proposal documents, and correspondence related to the proposals must be 
declared as records because of regulations and company policies. 

Figure 2-27 shows that all the proposals in the Issued state have a small padlock 
in the first column. This padlock represents that they are records.
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Figure 2-27   Records Manager automatic declare functionality

In our sample application, we implement Records Manager so that for any 
document in the Issued state, the system automatically declares it as a record 
and classifies it according to predefined rules.

Quick declare and manual declare from the Desktop
From a Document Managers Desktop, you can provide quick declare and 
manual declare options to users. 

For the sample application, Figure 2-28 shows the available records 
management options you can choose when you right-click a selected document. 
Users with the proper rights can declare and classify records at this interface.

Note: Document Manager is extremely flexible. You can configure record 
declaration any way you want depending on your business requirements. 
What we have shown with the sample application only demonstrates some 
of the potential function you can have in a Document Manager solution.
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Figure 2-28   Records Manager menu

Quick declare
Quick declaration provides a user with several options for classification of 
documents.

To use quick declare from the sample application, you need to select the 
document you want to make into a record, right-click the entry, and select 
Records Menu → Quick Declare Record. 

Figure 2-29 shows a sample window that appears when a user is quick declaring 
a record using the selection option. The user needs to select from a short list of 
file plan locations and click Declare and then Done. No attribute values can be 
changed through quick declare in this sample.

Figure 2-29   Records Manager quick declare function

If the document is a compound document, the related pieces of the compound 
document can be automatically declared if that option is configured in Document 
Manager. See Figure 2-30 as an example.
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Figure 2-30   Declare compound documents

These files are considered to be one record in Records Manager. Figure 2-31 
shows what they look like in the Records Manager client interface. 

Figure 2-31   Compound document record in Records Manager

Manual declare
Manual declare provides users with complete control over the record declaring 
process. Users determine where in the file plan to classify a record and what 
values to enter for each attribute for the record (provided that users have the 
proper rights to perform this function and proper rights to the corresponding 
Records Manager’s file plan).

To use manual declaration from Document Manager, you need to select the 
document you want to make into a record, right-click the entry, and select 
Records Menu → Manually Declare Record. 
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Figure 2-32 shows the records profile window that appears when a user selects 
Manually Declare Record. In this sample, all the values are automatically filled 
in due to Records Manager’s auto-classification rules and attribute mapping in 
Records Enabler. Users can change any of the values. To complete the 
declaration and classification of the record, click Finish.

Figure 2-32   Records Manager manual declare functionality

Version history declaration
A document can have multiple versions. Document Manager allows users to 
declare the latest version and any of the older versions of a document to be a 
record. You can implement this feature from the Document Manager Desktop.

To declare any of the older versions of a document to be a record, right-click the 
document, and select Version History menu. 

The version history window (see Figure 2-33) shows all the versions of the 
document. Any version of the document can be declared from this version history 
window. At this window, select an older version of the document, right-click it, 
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and select Records Menu → Quick Declare Record to declare it as a record. 
Note for the sample application, you can also manually declare the record by 
selecting the Manually Declare Record option from the menu.

Figure 2-33   Version history declaration

2.4  Summary
By using a case study and a sample application, we intend to quickly get you 
familiar with what Document Manager together with Records Manager can do 
from a practical view point. 

We cover the following specifics:

� Document Manager Desktop
� Adding documents to a Document Manager system
� Searching for documents within the system
� Unique document numbering (item numbering)
� Compound document support
� Role-based life cycle management
� Microsoft Word and Lotus Notes integration (including property exchange)
� E-mail notification
� PDF rendition
� Dynamic search folders
� Adding documents from a document template
� Revision
� Records Management integration:
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– From the Document Manager system side, automatic quick declare
– From the Document Manager Desktop: quick and manual declare
– Version history declare

Document Manager enables you to control and manage documents with many 
more functions than what we show you in the sample application. Depending on 
your business needs, you can easily and quickly configure a Document Manager 
system to fulfill your business requirements.

In the next chapter, Chapter 3, “Document Manager solution design and 
planning” on page 47, we discuss how you can plan and design a Document 
Manager solution.
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Chapter 3. Document Manager solution 
design and planning

In this chapter, we discuss how to design and plan a Document Manager solution 
and extend it to incorporate records management function. 

We cover the following topics:

� Planning for a Document Manager solution
� Designing a Document Manager system
� Designing the Document Manager user interface

Appendix A, “Case study” on page 469 applies the principles and theories 
discussed in this chapter to a practical case study. We recommend you read 
through the appendix once you complete this chapter.

3
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3.1  Planning for a Document Manager solution
In this section, we discuss the general process and considerations in planning for 
a Document Manager solution. 

The general planning process includes:

1. Identify document types.
2. Identify producers, approvers, and consumers of documents.
3. Identify document characteristics and document life cycle.
4. Define documents that should be records.

3.1.1  Identify document types
The first step in planning for your Document Manager solution involves 
identifying the types of documents you must manage. These include the 
documents that you should store, share among others, search, and retrieve 
within the solution. 

For our case study, we identify the following types of documents:

� The RFP documents that customers send us

� The correspondence we receive from and send to our customers

� The sales proposal documents

� The marketing proposal documents

� The services proposal documents

� References documents, such as minutes, budgets, graphics, Microsoft 
PowerPoint presentations, and so on

� Standard document templates

3.1.2  Identify producers, approvers, and consumers of documents
To plan for a Document Manager solution, you must have a clear understanding 
of the participants and their interaction and responsibilities within the application. 
In this step, you need to identify the information producers, approvers, and 
consumers of these documents.

The information producers are those who contribute to the information. The 
information approvers are those who must sign off on the information. The 
information consumers are those who locate, view, use the completed 
information, and possibly act on the information. The producers and consumers 
can be users and business applications.
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The producers can tell you how the documents are created and how they should 
be organized. The approvers can tell you the process a document has to go 
through (if any) according to existing business policies. The consumers can give 
you insight about how they use the documents and what they do with the 
documents.

Identifying these people or applications is crucial for the next step of the 
Document Manager system planning process.

3.1.3  Identify document characteristics and document life cycles
Part of the planning process involves understanding the type of documents a 
Document Manager system manages and the life cycle process associated with 
the documents according to the business processes and policies.

To plan for your solution, you should interview the document producers 
(creators), approvers, and consumers to find out the following information:

� What software do you use to create the documents?

For example, they can create documents with Word or CAD. 

Knowing how users create documents helps you plan the necessary 
integration Document Manager needs with these software products. 
Application integration enables producers to continue to use the software with 
which they are already familiar to create, view, and modify documents, and 
therefore have a shorter learning curve with the new system. It is also 
important to obtain this information for planning document printing using the 
print/plot service Document Manager provides.

� Will any documents be composed of multiple parts?

If some documents are, you need to find out what they are. A document can 
be composed of a spreadsheet, some graphics, a logo, and different 
document sections. Or it may be composed of several different documents. 
Knowing how the documents are assembled helps you to determine the links 
between the documents for compound document relationship management.

� What are some of the attributes of the documents?

Document Manager can tie document file names and locations to a set of 
index attributes (catalog) for easy document storage and retrieval. With 
attributes associated with the documents, users can search against these 
attributes.

You need to find out from producers how to classify documents and the key 
information that can be used to represent and identify the documents. For 
example, in the case study we use for this redbook, some of the attributes of 
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a sales proposal are customer ID, product ID, proposal number, and proposal 
subject.

Some attributes can uniquely define a document. Are there any attributes like 
that? If so, do you need to enforce the uniqueness of these attributes among 
documents?

� What are the users’ search requirements for documents?

Will users only search on the document’s attributes to locate the documents 
or on the document’s content as well? This helps you to decide, when 
designing the data model, what attributes should be indexed, and whether 
you need to enable a text search index for the document content. Document 
Manager enables users to search documents by metadata or by content. Be 
sure to ask all the representative users to ensure you know all their potential 
requirements.

� What is the entire business process for a document?

Some documents go through multiple states (life cycle) in Document 
Manager. Depending on the business requirements, different types of 
documents go through different life cycles.

For the case study we use in the redbook, there are four stages (also known 
as states in Document Manager) in a sales proposal’s life cycle: Draft, 
Review, Approval, and Issued.

Some documents can never go through any life cycle, and some do.

For each document type, you work with the producers and approvers to 
identify whether the documents go through a life cycle or not. For the 
document types that go through a life cycle, identify what the stages are, and 
who can do what to the documents at each stage. This includes who can 
transition a document from one state to another, and under what conditions 
before a document of the type can transition to another state.

Will there be any automated process executed during any stage of a 
document’s life cycle? For the case study, when a proposal transitions into 
the Review state, the system automatically sends an e-mail notification to the 
reviewers to inform them the document is waiting for them to review.

� Do you need control document version and revision?

Version control ensures that every time a user edits a document, the 
originating document is still available in some form. This ensures that users 
can track changes made and roll back to the original document if necessary. 

Will people update this type of document in the system? Is it possible that 
multiple users can work on the same document at the same time? If this is 
possible, you must consider planning for version control for documents of this 
type.
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In addition, is it possible that several versions of a document can be created 
and updated by different people? If this is the case, usually, only one of the 
versions will replace the original version. Document Manager provide the 
revision function, so that you can promote only the approved version to 
become the next revision of the document to replace the original document or 
the previous release of the document.

� Is there any special numbering requirement for the document that Document 
Manager can do for the system?

Document Manager offers the document numbering feature (also known as 
item numbering in Document Manager) so that the system can create a 
unique number for a document. You can base this number on numeric, alpha, 
alphanumeric, or a Globally Unique Identifier. This is the time to review your 
current business process to see if it makes sense for Document Manager to 
create the number automatically instead of relying on users to do so.

3.1.4  Define documents that should be records
If you need to implement records management capability into your Document 
Manager system, this is the time to identify the documents that you must declare 
as your company’s official records to comply with the record keeping mandates 
and regulatory guidelines. 

The users may not necessary know about the business regulations. Make sure to 
work with your records staff and legal staff to identify the documents that you 
need to keep as records.

To get more information about what records management options are available 
for a Document Manager solution, refer to Chapter 4, “Records Manager options 
design and planning” on page 73.

3.2  Designing a Document Manager system
In this section, we discuss the general steps in designing a Document Manager 
system. 

The steps include:

1. Define users, groups, and roles.
2. Define a data model for your document system.
3. Define document life cycles.
4. Design a Document Manager application interface.

You do not have to follow these steps in a strict order. They are a guideline for 
you to evaluate and work through to help you start designing your system. 
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We do not cover records management-related design here. We discuss it in 
Chapter 4, “Records Manager options design and planning” on page 73.

3.2.1  Define users, groups, and roles
Part of designing a Document Manager system is defining the system’s users, 
user groups, and roles. 

Users are the people who use the Document Manager system. In the planning 
section, we identified the information producers, approvers, and consumers. In 
this step, you define users based on the identified users. 

You need to decide how these users are created. Does your company use LDAP 
or does your company have an SSO requirement? This can affect how you want 
to define and set up the users.

Group definition
You also need to define user groups. The criteria for mapping users into groups 
is based on users’ access requirements and their responsibilities. You place 
users who have similar access requirements and responsibilities into the same 
group. 

In our case study, we define six groups as you see in Table 3-1.

Table 3-1   User groups in the case study

Groups (Group name) Description

Managers
(grpManagers)

This group of users is the managers of the various 
departments. They have the responsibility to review and 
approve the proposal documents.

Sales
(grpSales)

Users in this group are the employees in the sales 
department. They receive requests for proposals from 
customers. They are responsible for preparing the sales 
proposal documents and delivering the approved ones to 
customers.

Marketing
(grpMarketing)

Users in this group are the employees in the marketing 
department. They receive requests for proposals from 
internal departments. They are responsible for preparing the 
marketing proposal documents and delivering the approved 
ones to internal departments.
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Role definition
Roles define the Document Manager actions that users (such as information 
producers, reviewers, approvers, and consumers) can have. 

There are many actions a user can perform on a document. When defining a 
role, you can specify whether users with a role can do any or some of the 
following:

� Add items: Add items to the system.
� Checkout: Check out an item from the system.
� Copy: Copy an existing item to another.
� Revise items: Revise existing items.
� Modify properties: Modify the attributes or metadata of items.
� Print: Print capability.
� Transition: Transition items from one state to another.
� View: View items.
� Markup: Mark up items.

For our case study, we determine that the solution needs four user roles:

Consultants
(grpConsultants)

Users in this group are the employees of the services 
department. They receive requests for proposals from 
customers. They are responsible for preparing the services 
proposal documents and delivering the approved ones to 
customers.

Financial Analysts
(grpFinancials)

This group of users are the company’s financial analysts. 
They are responsible for reviewing all the proposal 
documents to ensure that the financial information in the 
proposals is correct.

Viewers
(grpViewers)

Users in this group are the company employees who are not 
directly involved with the proposal creation process, but they 
are interested in viewing the delivered proposals.

Note: In a Document Manager system, an item includes any type of a 
document or other type of content, such as a graphic file, an audio file, or a 
video file. 

For simplification, in this redbook, we sometimes use the word document 
interchangeably with the word item. Other words we use interchangeably with 
document or item include: content and information. Most of the time, they 
mean the same thing in the redbook.

Groups (Group name) Description 
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� Approvers: Information approvers who can approve the content (for example, 
sales proposal documents).

� Creators: Information producers who can create the content.
� Reviewers: Users who review the content.
� Viewers: Information consumers who may read the content.

Table 3-2 lists the actions each role can perform. For example, only users in the 
Creators role can add items into the system.

Table 3-2   Role definitions in the sample application

Groups to roles mapping
Once groups are defined and roles are defined, you need to map the groups with 
the appropriate roles. 

Table 3-3 shows the mapping of the user groups to the roles. A group can have 
multiple roles. For example, users in the grpManager group have Approvers, 
Creators, and Viewers roles.

Although you can assign users to roles, we recommend that you always create 
user groups and only assign groups to roles for easier system maintenance.

Table 3-3   Role mappings to user groups in the sample application

Approvers Creators Reviewers Viewers

Add items X

Checkout X X X

Copy X

Revise items X X

Modify 
properties

X X

Print X X X X

Transition X X X

View X X X X

Markup X X X

Groups Approvers Creators Reviewers Viewers

grpManager X X

grpConsultants X
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3.2.2  Define data model
In the planning session, you identified the types of the documents your 
Document Manager solution must handle. At a very high level, they are 
correspondence documents, proposal documents, and reference documents.

In this section, we discuss the document data model that controls how you want 
to store the documents in the repository and how you want to retrieve them. 
Specifically, you need to define the following data model elements for the 
documents:

� Attributes
� Item types and document classes

Attribute (library property) definitions
An attribute (also known as library properties in Document Manager) stores a 
unit of data or values that describe a certain characteristic or property of an item 
(an item can be a document or some other type of a content file). Examples of 
attributes are proposal number and customer name. You use attributes to search 
for an item. In the planning session, the process included identifying the 
characteristics of a document type. You can use what you identified from that 
session here.

Sometimes you can end up with different attributes for different document types. 
Some of the attributes store similar information and they should not be created 
twice for different documents. Attribute groupings and reuses help simplify the 
system and avoid potentially creating too many attributes. Early consolidation or 

grpMarketing X

grpSales X

grpFinancials X

grpViewers X

Attention: You assign groups to the appropriate roles, and you associate 
roles with the appropriate document classes and states. 

We discuss classes and states in the next section, Define data model. Once 
you have read that section, you may want to return to this section to redefine 
your groups and roles to ensure that your design meets your business 
processes and requirements.

Groups Approvers Creators Reviewers Viewers 
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separation of the right attributes help avoid problems later in the implementation 
phases.

In our case study, we defined sales, marketing, and services proposal 
documents to have the following common attributes: Customer Name, Customer 
Number, Request for Proposal Number, Proposal Subject, Create Date, Author, 
Potential Revenue, Delivery Date, and From (customer e-mail). We defined the 
correspondence documents to have the following document attributes: Customer 
Name, Customer Number, From, To, Date Received, Request for Proposal 
Number, and Mail Subject. 

Table 3-4 shows the attribute definitions for the sample solution.

Table 3-4   Attributes (library properties)

Name Display name Attribute type Character 
type

Character 
length

Customer
Name

Customer
Name

Variable 
character

Extended 
alphanumeric

32

Customer 
Number

Customer 
Number

Variable 
character

Extended 
alphanumeric

32

RequestPropNum Request for 
Proposal 
Number

Variable 
character

Extended 
alphanumeric

32

Proposal Number Proposal 
Number

Variable 
character

Extended 
alphanumeric

32

Proposal Subject Proposal 
Subject

Variable 
character

Extended 
alphanumeric

32

Author Author Variable 
character

Extended 
alphanumeric

32

Potential
Rev

Potential Rev Variable 
character

Extended 
alphanumeric

CreateDate Create Date Date

DeliveryDate Delivery Date Date

eMailNumber eMail Track 
Number

Double

From From Variable 
character

Extended 
alphanumeric

64

To To Variable 
character

Extended 
alphanumeric

256
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Item types and document class definitions
An item type is a structure (template) you use to define a type of the documents 
that will be stored in a Content Manager repository. In an item type definition, you 
specify authorization schema, repository characteristics, where, and how you 
store documents of this type. In addition, you define the attributes 
(characteristics) of the documents.

Internally, Content Manager defines an item type as a physical database table 
and attributes are defined as columns in that table. How you define item types 
can have a performance impact on your system.

From the item type definitions, you can define multiple document classes 
associated with each item type. Document Manager uses classes to model a 
business process for managing documents. 

There are two types of Document Manager classes, controlled and stateless. 
Controlled classes are for documents which need to go through one or more 
states in their life cycles. Stateless classes are for documents which do not need 
to go through any life cycle.

Document Managers class is derived from an item type. You use Document 
Manager classes to logically separate different kinds of documents inside a 
single item type. 

Tips for defining item types
Depending on the type of documents you have for your solution, you can define 
one item type for each document type, define one item type for all document 
types, or be somewhere in the middle.

Defining one item type for all document types is the easiest way to set up a 
Document Manager system. However, there are many instances when you do 
not want to do that. Some of them include the following:

� If the document types do not have any common attributes or share very few 
common attributes, you may want to define one item type per document type. 
If you lump all document types with different attributes together under one 
item type, you end up with an internal database table with too many columns. 
Space can be wasted and not used efficiently.

MailSubject Mail Subject Variable 
character

Extended 
alphanumeric

256

DateReceived Date Received Date

Name Display name Attribute type Character 
type

Character 
length
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� If searches will always be performed against one type of the documents or 
another, but never against all these document types together at the same 
time, you may want to consider separating the document types into item types 
(thus different tables internally) for better system performance. This is 
practical if you expect high volume of documents will be added into the 
system every day or eventually.

� The text search indexing requirement also determines how many item types 
you should define. If users only perform text search index on one document 
type, but not the others, you should consider defining an item type especially 
for this document type.

� For security reasons, you can define different item types. This way, you can 
associate a different ACL for each item type.

Tips on classes versus item types
We provide tips to help you determine if you need to define more than one class 
within an item type:

� If some documents have to go through a life cycle and some do not, you want 
the document types that do not go through a life cycle to be in one class (the 
stateless class) and those that must go through a life cycle to be in a different 
class (controlled class).

� If the documents that require life cycles go through different states in their life 
cycles, you must define one class for each type of life cycle because each 
class can have only one life cycle associated with it.

� If there are different access control requirements for the document types (for 
example, each type of document must be accessed by a different set of user 
groups), you must separate the document types with different access control 
into different classes.

� If you want to sequentially enumerate different types of documents with an 
independent serial number and you want the system to automatically create 
it, you need to define separate classes for different document types. This is 
because one class can only have one item numbering assigned to it.

� If different types of documents need distinct version or revision numbering, 
then you must define different classes for different document types.

In our case study, we define two different item types: CustomerData and 
LibraryObjects. The item type CustomerData stores proposals and 
proposal-related files, all of which have similar attributes. The item type 
LibraryObjects stores saved searches and document templates, which have 
completely different attributes from the proposals and proposal-related files. See 
Table 3-5.
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Table 3-5   Item type definition summary

We further define multiple classes under the CustomerData item type and two 
classes for the LibraryObjects item type. 

Table 3-6 shows the classes that we define to model different type of documents 
represented by the CustomerData item type. See the description of each class to 
get a better understanding of how you can define item types and classes for your 
business requirement.

Table 3-6   CustomerData classes for the sample case study

Item types Comments

CustomerData Store proposal-related files because all of them have similar 
attributes. 
The CustomerData item type stores the following document 
types:
� Customer Request for Proposal (RFP)
� Sales proposal
� Marketing proposal
� Services proposal
� Correspondence
� Reference documents

LibraryObject Store predefined queries (saved searches) and standard 
document templates, because the saved search and 
document templates have different attributes from the 
proposal-related files.
Note, the predefined queries are specific to Document 
Manager. We store them so that users can reuse them.

Classes Description

Correspondence Store the correspondence documents received from and 
sent to customers.

RFP Store the Request for Proposal (RFP) documents received 
from customers.

Marketing Proposal Store the marketing proposal documents.

Sales Proposal Store the sales proposal documents.

Services Proposal Store the services proposal documents.
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Table 3-7 shows the classes that we define for documents we store under the 
LibraryObject item type.

Table 3-7   LibraryObject classes for the sample case study 

To manage who can access what documents in the system, you need to define 
Access Control Lists (ACL). An ACL is a mapping between users or user groups 
and privilege sets. Access control lists are authorization schemas that define 
who can read, write, and delete items from the content repository. We cover this 
topic in more detail in Chapter 5, “Security” on page 91.

3.2.3  Defining life cycle processes
For documents that go through different states (Document Manager controlled 
classes), you identify the states that the documents go through and model them 
in Document Managers’ life cycles. 

The process of translating the different states that your documents go through 
into Document Managers life cycle consists of the following steps:

1. Identify the classes that are control classes.

2. Define the states that a document goes through during the change and 
approval processes. Example of states are Draft, Review, and Approval.

3. Map roles to states. This defines who (having the role) can access the 
document when the document is at that state. For example, in the sample 
application, users with the Approvers role are mapped under the Approval 
state of a document class Sales Proposal. This means that users belonging to 
this role can access the sales proposal documents when the documents are 
at the Approval state. 

Reference Documents Store reference documents, such as meeting minutes, 
budgets, presentations, and video.
This is a stateless class because the documents of this type 
do not go through a life cycle. All other classes are controlled 
classes that go through a life cycle.

Classes Description

Document Template Store company standard document templates.

Saved Search Store Document Manager predefined queries.

Classes Description 
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We discussed roles in 3.2.1, “Define users, groups, and roles” on page 52. 
This is a good time to go back and review what you have defined and refine 
your design.

4. Graphically create the document process model using the Document 
Manager Designer tool.

In the case study, a person receives a request for a sales proposal creates a new 
sales proposal document and adds it into the Document Manager system. When 
the document is first added into the system, it starts out in the Draft state. After 
the salesperson finishes writing the proposal, the salesperson transitions the 
document to the Review state. A team member in the Reviewers role reviews the 
document and transitions the document to the Approval state. Then, a 
supervisor in the Approvers role approves the document and transitions it to the 
Issued state. At the Issued state, the document is automatically declared as a 
record and the document is rendered into a non-editable PDF document. Once 
the PDF version of the proposal is available, the salesperson can send it to the 
customer. At this point, the life cycle of the document, as defined in Document 
Manager, is complete. 

Based on the business process, we define the following states that the sales 
proposal documents must go through in their life cycle:

� Draft 
� Review
� Approval
� Issued

We also define the following roles for the sales proposal document life cycle (or 
you can define this earlier and redefine at this stage):

� Creators: Users who create the proposal.
� Reviewers: Users who review the proposal.
� Approvers: Users who approve the proposal for publication.
� Viewers: Users who can view the proposals.

We map the roles to the states, see Table 3-8.

Table 3-8   Mapped roles to states for a sales proposal document class

State Role

Draft Creators, Viewers

Review Reviewers, Viewers

Approval Approvers, Viewers

Issued Approvers, Viewers
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We graphically create the sales proposal document’s life cycle map using the 
Document Manager Designer tool. Figure 3-1 is an illustration of the sales 
proposal document’s life cycle map.

Figure 3-1   Sales proposal life cycle

3.3  Designing the Document Manager user interface
After defining users, groups, roles, document item types, document classes, and 
document life cycles as covered earlier in this section, we design the Document 
Manager application user interface. 

Note: It is important to consider the consequences of a record declaration 
within a document’s life cycle. When a document is declared as a record, 
Records Manager restricts access to the document by changing its ACL in 
Content Manager. This effectively ends the document’s life cycle in Document 
Manager, until a new version or revision of the document is created. The final 
state in a document’s life cycle is probably to the most appropriate place for 
the record declaration to occur. 

Also, note that there is a difference between a Document Managers life cycle 
and a Records Managers life cycle. Prior to a document becoming a record, 
the life cycle in Document Manager controls which states a document has to 
go through. As soon as a document becomes a record, Records Manager 
takes over the control and puts the document in the record’s life cycle, which 
is related to the record keeping policies of the company.

We cover more Records Manager-related discussion in Chapter 4, “Records 
Manager options design and planning” on page 73.
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Document Manager application interface design comprises the following tasks:

1. Define actions and dialogs.
a. CVL lists and links
b. Item templates

2. Define Desktop templates.
a. Menus
b. Views
c. Searches
d. Property exchanges
e. Application integration

3. Define folder structure.

3.3.1  Define actions and dialogs
In previous sessions, you identified the types of the documents to be managed 
by the Document Manager system. In addition, you defined item types and 
classes for these document types. Now, you need to decide what actions can be 
performed on each class and define the dialog boxes that will be used when a 
particular action is performed on a document. In Document Manager, you define 
the actions and dialog boxes by configuring the actions and dialog objects.

Table 3-9 shows the Document Manager actions that you can configure. The 
Dialog box column indicates whether a dialog object is required for that action or 
not. It is possible that an action is available to a document but no dialog box is 
necessary for the action.

Table 3-9   Document Manager actions and dialog object options

Action Dialog box 
options

Description

Add Required Add an item to the content repository.

Check in Optional Check in one or more items.

Check out Optional Check out one or more items.

Copy None Copy one or more items to a specified location.

Modify Required Modify an item’s attributes (properties).

Revise Optional Create a revision of an item.

Transition None Transition one or more items from the current 
state to a new state.

Version History Required View all versions of a selected item.

View None Display one or more items.
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In the case study, the Document Manager system needs to manage sales 
proposals. When you add a document of the Sales Proposal class to the system, 
you need to enter document attributes (to categorize, search for, and allocate the 
document later). In this scenario, we need an add action and a dialog box 
associated with the action. We therefore configure an action and dialog object, 
Sales Proposal - Add, and associate the object to the Sales Proposal class. In the 
Sales Proposal - Add action and dialog object, we configure the user interface 
and the attributes users enter when adding a sales proposal to the system. This 
involves no programming. 

Once you configure all the actions and dialog objects, you assign them to the 
appropriate classes. 

In the case study, we create a set of actions and dialog objects for each class 
(see Table 3-10). As you can see, under the item type CustomerData, the class 
Sales Proposal, there are four actions and dialog objects:

� Sales Proposal - Add
� Sales Proposal - Modify
� Proposal - Checkin
� Proposal - Revise

Note, you can use an action and dialog object (such as Proposal - Revise) by 
more than one class; however, a class cannot have multiple objects of similar 
type. For example, if we have a new action and dialog object, Proposal - Add, we 
cannot assign this object along with the Sales Proposal - Add object to the Sales 
Proposal class, because both of these objects are of the add action. The Sales 
Proposal class can have only one add action and dialog object type.

When you create the action and dialog object, you must also assign users or 
groups to the actions and dialog objects for security control. Users who are not 
on the list or who do not belong to any of the groups that are assigned to the 
action and dialog object cannot perform the action specified in the object.

In the case study, users in the group grpSales can add a document of class Sales 
Proposal, using the Sales Proposal - Add action and dialog object. Other users 
cannot do that. Users in the groups grpFinancials, grpManager, or grpSales, 
can modify a document of class Sales Proposal, using the Sales Proposal - 
Modify action and dialog object.

Although you can assign users to actions and dialog objects, we highly 
recommend assigning only groups to the actions and dialog objects. 
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Table 3-10   Actions and dialogs for the sample case study

Item type Class Action and dialog
object 

Associated 
groups

Customer
Data

Correspondence Correspondence - Add grpConsultants
grpMarketing
grpSales

Correspondence - Modify All five groupsa

RFP RFP - Add grpConsultants
grpMarketing
grpSales

RFP - Modify All five groups

Marketing 
Proposal

Marketing Proposal - Add grpMarketing

Marketing Proposal - Modify grpFinancial
grpManager
grpMarketing

Proposal - Revise grpManager

Sales Proposal Sales Proposal - Add grpSales

Sales Proposal - Modify grpFinancials
grpManager
grpSales

Proposal - Checkin All five groups

Proposal - Revise grpManager

Services Proposal Services Proposal - Add grpConsultants

Services Proposal - Modify grpConsultants
grpFinancials
grpManager

Proposal - Revise grpManager

Reference 
Documents

Reference Document - Add grpConsultants
grpFinancials
grpManager

Reference Document - Modify Same as above

Library
Objects

Document 
Template

DocTemplate - Add All five groups + 
Admin

Saved Search Saved Search - Add All groups
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CVL lists and links
CVL lists and links are used by dialog windows to present to users with the 
predefined list of options to fill an attribute value. 

For example, in the case study, we create a CVL list, Proposals. The list contains 
three document proposal types: Sales Proposal, Service Proposal, and 
Marketing Proposal. We link the list to the Class field in the Proposal search 
template. When you perform a search using the Proposal search template, you 
select a proposal type from the drop-down list of the Class field and search only 
documents of this proposal type.

CVL lists can be static or dynamic. Links link the CVL lists to attribute fields. You 
can integrate multiple CVL lists and links to generate lists, so that a list of values 
depend on the selected option from another list. 

For example, we have the CVL list, Proposal:

� Sales Proposal
� Service Proposal
� Marketing Proposal

Each proposal type has a list of different accounting control codes:

� Sales Proposal has the following corresponding accounting control codes:
– SA1-001
– SA1-002
– SX2-004
– SX3-005

� Service Proposal has the following corresponding accounting control codes:
– SE1-001
– SE1-002
– SPX-004
– SPX-005

� Marketing Proposal has the following corresponding accounting control code:
– MKZ-103

You can create three accounting control code CVL lists, one for each proposal 
type, and link the accounting control code CVL list to its corresponding proposal 
type. In an action and dialog object, you can define a proposal type and an 
accounting control code field. Associate the Proposal CVL list to the proposal 
type, and the special accounting control code/proposal type link to the 
accounting control code field. When a user selects a proposal type (for example, 
Sales Proposal) in the proposal type field, the accounting control code field will 

a. The five groups include: grpConsultants, grpMarketing, grpSales, grpManager,
and grpFinancials. 
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display only the accounting codes associated with that proposal type in the 
drop-down list (in this example, they are SA1-001, SA1-002, SX2-004, and 
SX3-005). If user changes the proposal type (for example, to Service Proposal), 
then the accounting control list will again change to the codes for the Service 
Proposal type (in the example, they are SE1-001, SE1-002, SPX-004, and 
SPX-005).

Use CVL lists and links in search templates and all actions and dialog objects, 
except in the View action because the View action does not have a dialog 
associated with it.

Using CVL lists and links can simplify your user interface, reduce user input 
errors, and ensure consistent user input.

Item templates
Use item templates to generate predefined values for dialog boxes in much the 
same way that lists generate predefined values for fields. The difference is that a 
list is for a particular field, and an item template is for an entire dialog box. With 
the item template, you can predefine values of multiple fields in a dialog box.

Using item templates simplifies the user interface. You can configure several 
item templates with different populated values. When a user wants to create a 
sales proposal, default values related to the sales proposal can be pre-filled. If 
the user wants to create a service proposal, you can use another template with 
different sets of pre-filled fields to present to the user. This makes the Document 
Manager interface more user friendly, reduce input errors, and ensure more 
consistent and accurate data input.

In the case study, we created an item template called New Sales Proposal that 
automatically fills out the Customer Number and Class fields in the add dialog for 
the Sales Proposal class.

3.3.2  Define the Document Manager Desktop
Document Manager users access the Document Manager system through the 
Document Manager Desktop. The Document Manager Desktop is completely 
configurable. This requires no programming. As a Document Manager 
administrator or designer, you configure the Desktop for each user or user group 
through the Document Manager Designer tool. Alternatively, you can use the 
Designer tool to import a pre-configured Desktop design.

When you design a Document Manager Desktop, consider what interface a user 
requires and what responsibilities the user has in the system. 
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Figure 3-2 shows a sample Document Manager Desktop of a user who belongs 
to the usrSales group and can create content in the system. Figure 3-3 shows a 
Desktop of a user who belongs to usrViewers group and can only view the 
content in the system. 

Figure 3-2   A Content Creators Document Manager Desktop

Figure 3-3   A Content Viewers Document Manager Desktop

 

 

 

 

68 IBM DB2 Document Manager with IBM Records Manager Solution Guide



The first user has a lot of commands (icons and menu items) available to use. 
The second user’s Desktop is simpler, with only search-related commands. You 
can set the views to present to users differently depending on business 
requirements.

The process of designing a Document Manager Desktop involves configuring:

� Menus
� Views
� Searches
� Property exchanges
� Application integration 
� Desktop templates

Table 3-11 provides a brief description of each Desktop object.

Table 3-11   Document Manager Desktop objects

Desktop 
objects

Description

Menus The Document Manager menus are designed to fit the requirements 
of each user and group. They provide the user with the tools to work 
with documents and information within the system. Menus are 
assigned to Desktop templates. A menu can be composed of one or 
more submenus. 
For example, on Figure 3-2, the active menu (main menu) consists of 
the following submenus: 
� Library Menu
� Folder
� Records Menu
� Templates
� About Menu 
In addition, the Library Menu consists of the following Document 
Manager commands:
� Log in
� Log out
� User Preferences
� Change Password
� Desktop Refresh

Views The Document Manager views display the document property 
information on the Document Manager Desktop. 
For example, on Figure 3-4, the Proposal view displays property 
information such as State, Proposal Number, and Customer Name. 
The View drop-down box shows that the user has multiple views from 
which to choose. Each view represents data in a different way.
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Figure 3-4   Document Manager views

Search dialogs The Document Manager search dialogs are search templates that 
users can use to search on attribute values (properties) to retrieve 
documents. The properties included in the search template contain 
item-specific information to help users identify the items that they are 
looking for in the Document Manager system.
For example, Figure 3-5 shows a search dialog for a proposal type 
document. The search drop-down box shows that the user has been 
given multiple search templates from which to choose. Each template 
is relevant to a type of document because the template contains 
properties that are relevant to that specific document type.

Desktop 
templates

The Document Manager Desktop template is used to configure the 
Document Manager Desktop for users. You typically create a 
Desktop template for each user group or groups. For example, the 
Document Manager administrative user group has its own template. 
The content creators, reviewers, and approvers can share the same 
template that is different from the administrator’s template.
The Desktop template pulls together the previously defined Desktop 
objects, such as menus, views, search dialogs, and more to form the 
Document Manager Desktops for users.

Desktop 
objects

Description 
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Figure 3-5   Document Manager search dialogs

In later chapters of this redbook, we show you how we create the sample 
application for the case study.

For more details about designing a Document Manager Desktop, also refer to the 
IBM DB2 Document Manager V8.3 System Administration Guide, SC18-9254.

3.3.3  Define folders structures
You do not define Folders in the Document Manager Designer tool but they can 
be created in the Folder Administrator utility that is part of the Document 
Manager menu actions. You create folders to organize documents into 
directory-like structures so users can easily find documents without performing a 
document search action. 

There are two types of folders, standard and dynamic folders. With standard 
folders, you can manually drag and drop documents to the folders. The dynamic 
folders, also known as the dynamic search folders are linked to saved search 
documents. The saved search documents store saved queries. Every time a 
user opens a dynamic search folder, an associated saved search to the dynamic 
search folder is executed and the folder content is refreshed. Dynamic search 
folders are useful for quick lookup of certain groups of documents, without having 
users manually drag and drop the documents there.

Use folders appropriately. Do not overuse them or else you can impact system 
performance.

You can configure the folder security so only specific users have access to 
folders.
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Note: The Export/Import utility does not export or import a folder from one 
system to another. If you create the folder in the testing environment, you 
must either manually recreate it in the production environment or drag and 
drop it to the new environment.
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Chapter 4. Records Manager options 
design and planning

In this chapter, we discuss different options available to tailor the Records 
Manager functions into Document Manager. Specifically, we concentrate on 
different ways of declaring and classifying from Document Manager.

We cover the following topics:

� General Records Manager planning and design
� Records Manager options in Document Manager
� Choosing the optimal records declaration process

4
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4.1  General Records Manager planning and design
Adding Records Manager function to a Document Manager solution involves the 
following planning and design steps:

1. Identifying corporate records
2. Reviewing or defining the records retention schedule
3. Identifying how documents are organized
4. Defining file plan
5. Defining a record’s life cycle
6. Defining users and security
7. Planning for records destruction

We assume you already have experience working with Records Manager in 
general. The section provides a general overview for Records Manager planning 
and design.

It is beyond the scope of this redbook to provide detailed information about how 
Records Manager works, how to set up a Records Manager solution from 
end-to-end, and to repeat the materials (publications) that have already been 
published. 

If you are not familiar with Records Manager, Chapter 3 of the following redbook 
provides a good overview:

� E-mail Archiving and Records Management Integration Solution Guide: Using 
CommonStore and Records Manager, SG24-6795.

For a quick review of the basic terms and concepts related to records 
management, refer to the Technote at the following Web site:

http://www.redbooks.ibm.com/abstracts/tips0595.html?Open

For more detailed information about Records Manager, refer to the following 
Records Manager product publications:

� IBM Records Manager: Administrator’s Guide, SC18-9180
� IBM Records Manager: Technical Reference Guide, SC18-9181

4.1.1  Identifying corporate records
Before adding any Records Manager function to your solution, identify the types 
of the documents to declare as corporate records as mentioned in 3.1, “Planning 
for a Document Manager solution” on page 48. 

The main tasks here are what are corporate records, when they can be declared, 
and how to declare and accurately classify them.
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4.1.2  Reviewing or defining the records retention schedule
After identifying the types of the documents that should be corporate records, 
review the retention schedule for these corporate records according to regulatory 
rules and your company policies. The record retention schedule specifies how 
long you keep a record in the system once the document becomes a record. If 
there are multiple stages a record goes through, review:

� How many stages there are in a record’s life cycle.
� How long the record stays in each stage.
� What to do with the record when it is in the stage.
� How to move the record from one stage to another.
� How to dispose of the record in the end.

If your company does not have a pre-established retention schedule, the records 
management staff and legal staff in your company get together and define the 
retention schedule for each type of corporate records.

4.1.3  Identifying how documents are organized
Once the retention schedule is established, review how your company currently 
organizes all the physical files and electronic files. Every organization uses 
certain ways to organize its information, such as by files, prefix, section, folder, 
and volume. This helps you define a file plan for the solution.

4.1.4  Defining file plan
A file plan specifies how to organize records hierarchically in a Records 
Manager environment. Establishing an effective file plan is crucial to both the 
ease of use as well as to the retention schedule that you apply to records 
managed by Records Manager. Usually, a Records Manager’s file plan maps to 
the existing physical and electronic file organization scheme of your company 
that you identified earlier.

A file plan consists of multiple file plan components. Much like a drawer contains 
a collection of related documents in an old-fashioned file cabinet, a file plan 
component stores a collection of related records. In the old fashioned file cabinet, 
each drawer has multiple folders, and each folder store documents of similar 
subjects or the same projects. Some file plan components can store actual 
records, while others like the drawer can be further divided into multiple 
subcomponents indefinitely. In the end, a file plan component stores the actual 
records. 

When you declare a document as a record, you classify the record at the same 
time. Classifying a record is assigning a record to one of these file plan 
components.
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4.1.5  Defining a record’s life cycle
A life cycle is a collection of phases a record goes through from the time a 
document is declared as a record until the time it is discarded. A life cycle can 
consist of one or more phases. A retention schedule specifies how long a record 
is retained in a phase and when the record transitions to the next phase.

When you define a record’s life cycle, consider the retention schedule associated 
with each record type. Each file plan component (where a record is assigned) 
has a life cycle code associated with it. The life cycle code corresponds to the 
retention schedule you reviewed or defined earlier. Each life cycle code 
represents a specific set of retention schedules that you apply to a file plan 
component.

Do not confuse the record’s life cycle with the Document Managers life cycle. 
The process a document goes through prior to its becoming a record is the life 
cycle in Document Manager. The process a document goes through from the 
time it becomes a record until the time it is destroyed is the life cycle in Records 
Manager. 

4.1.6  Defining users and security
Identify record users, those who can declare and classify records, and those who 
can view documents once the documents become records.

Document Manager is the core application that manages all the documents in the 
system in the records-enabled document management solution we cover in this 
redbook. Content Manager is the back-end content repository. Records Manager 
is the records management engine that enables the system to support the 
records management function. In the system, you create the users in Content 
Manager and import the users into Document Manager. When you identify the 
users who can declare and classify records, and the users who can search and 
view records, you import these users from Content Manager into Records 
Manager. In addition, you import users who log on to a Document Manager 
administration client (for example, DDMSERVICE) and the administrative user 
for CMRE (in the example, ICMADMIN) into Records Manager.

The Content Manager users, who perform record declaration and classification, 
need at a minimum the File Plan Administration function access right to access 
the file plan. In addition, the users need the privileges to the file plan hierarchy 

Note: Ensure that all IDs imported into Records Manager conform to its 
naming rules, or declaration fails due to failed logins.
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locations where they classify documents. Administrative users need additional 
rights and privileges to perform other Records Manager functions.

For more detailed discussions about users and security, refer to Chapter 5, 
“Security” on page 91.

4.1.7  Planning for records destruction
Planning for records destruction is very important in a records-enabled system. 
Records Manager does not automatically delete the records once they reach the 
last stage in their life cycles. You work with the legal staff and records 
management staff to determine how and when to destroy records.

Refer to Chapter 10 of the following redbook for a high level discussion about this 
topic:

� E-mail Archiving and Records Management Integration Solution Guide: Using 
CommonStore and Records Manager, SG24-6795.

4.2  Records Manager options in Document Manager
The process of declaring and classifying Document Manager documents as 
records should be made appropriate to the skill and knowledge level of the users. 
Integrating with Records Manager, Document Manager provides a number of 
methods to create records in the solution:

� Quick declare
� Manual declare

4.2.1  Quick declare
Quick declare provides users with an option for automatic classification of 
documents. Touchless (or no user interaction) declaration and classification of 
documents provide a seamless way to enforce record keeping without burdening 
users. 

Document Manager provides three options for quick declare (see Figure 4-1): 

� Auto
� Selection
� By Property 

All three options vary in degrees of user interaction at record declaration time. An 
option is specified for each document class and it determines the classification 
method for that class.
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Figure 4-1   Quick declare configuration

Quick declare option: Auto classification
The Auto classification option works in conjunction with Records Manager’s auto 
classify rules and CMRE settings to automatically classify a document. The 
Records Manager’s auto classify rules are invoked to identify any candidate file 
plan locations that meet pre-established criteria. If there are multiple or no 
candidates identified, the CMRE settings arbitrate the final file plan location and 
the classification occurs. The IsRecord attribute of the declared document is set 
to auto and CMRE processes it based on the polling interval.

The user sees a dialog box similar to the one in Figure 4-2 when the auto option 
is used for classification.

Figure 4-2   Classification using auto option of quick declare

Quick declare option: Selection classification
The Selection classification option is a low touch classification option. This 
option requires the Document Manager Designer to designate a set of file plan 
locations (including a default location) into which you can classify documents. 
When you declare a document, you see a short list of possible file plan locations 
for classification (see Figure 4-3). You must choose one to complete the process. 
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With the selection option, should a document be declared during a Document 
Manager process, such as a state transition, the default file plan location is used 
for classification. In addition, all attribute values required by Records Manager 
must be provided through a means such as attribute mapping in CMRE; 
otherwise the classification will fail.

Figure 4-3   Classification using selection option of quick declare

Quick declare option: By Property
The By Property option is a low touch method for classification. This option 
allows the Document Manager Designer to create attributes (library properties) 
that collect values for record types and file plan locations. You can then use 
these properties in dialogs to specify the values for a record declaration and 
classification. At quick declare invocation, these values are used to complete the 
process. 

To facilitate entry of correct values, you can create CVL lists (picklists) to contain 
all the valid values, and users can choose from the lists. You can set up default 
values in the CVL lists and use the CVL lists for automatic declare processes in 
Document Manager also. Figure 4-4 shows two fields in a dialog box used for the 
By Property declaration, the record types, and the file plan declaration fields. 
Using CVL lists can speed up record declaration, the classification process, and 
reduce human input errors. 
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Figure 4-4   Quick declare with the By Property option

4.2.2  Manual declare
The basic type of record declaration is manual declare. This method allows for 
complete control of the process by a sophisticated user. The process requires 
you to know the precise location in the file plan to classify a document, and this 
process allows you to enter values for all the attributes for the record. You 
perform a manual declaration in Document Manager by selecting the Manual 
Declare command on a menu or having it optionally start automatically upon 
completion of an action. 

When selecting the Manual Declare command, the Manual Declare profile 
appears. See Figure 4-5.
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Figure 4-5   Manual Declare profile

Records Manager generates this window. This window is common to all products 
that use CMRE. 

Tips about manual declare
You can do a number of things to simplify the manual declare operation and 
reduce potential user input errors, such as:

� Prepopulate the required fields. 
� Limit the fields the user has to deal with via tailoring the records profile.

In the manual declare dialog box (Figure 4-5), populate the Source by name field 
by using settings in CMRE. 

The manual declare and classify configuration dialog box (Figure 4-6) has a 
setting for Should classification be filled in automatically. Setting this to yes 
invokes the auto classification rules defined in Records Manager and lists them 
by weight in the Source by name field. 
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Used in conjunction with the auto declare and classify configuration (Figure 4-7), 
specify a default value for the Source by name field if there are no candidates 
identified through the auto classify rules. 

This configuration can also provide a default value for the record type (Select 
Component Definition) field. 

If you do not use the CMRE settings, once the manual declare dialog box 
displays, pressing Auto Classify invokes the auto classify rules and populates 
the field with any candidates.

Figure 4-6   Manual declare and classify configuration in CMRE
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Figure 4-7   Auto declare and classify configuration in CMRE

In the manual declare dialog box (Figure 4-5 on page 81), other required fields 
are designated with an * preceding the label. You can populate the fields using 
the Defaults feature of Records Manager. 

Find the Defaults dialog (Figure 4-8) through File Plan Design → Defaults in 
Records Manager. As shown in Figure 4-8, you can assign defaults to all the 
attributes in the component, not just the required ones.
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Figure 4-8   Setting defaults in Records Manager

Fields can also be assigned values that are set through Document Manager 
dialogs. Through Attribute Mappings in CMRE, values can be mapped from 
Content Manager attributes to Records Manager attributes, thus prepopulating 
the fields in the manual declare dialog. 

An example of the attributes mapped for the proposal document record type is 
shown in Figure 4-9.
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Figure 4-9   Attribute mapping in CMRE

In addition to prepopulating the fields in manual declare, you can also limit the 
fields the user has to deal with via tailoring the records profile.

At times, the number of component attributes displayed on a record declaration 
and classification window can be overwhelming to users. You can create a 
profile for the component to limit the number of the fields shown (see Figure 4-5 
on page 81). 

You define a profile through File Plan Design → Profiles in Records Manager. 
You create a profile (Figure 4-10) by selecting attributes from a list of all fields of 
a component and adding only the desired ones to the selected field list.

A good practice for setting up a profile is to only show the fields that pertain to 
users. 
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Figure 4-10   Setting profiles in Records Manager

4.3  Choosing the optimal records declaration process 
Base the process you use to declare and classify records in your environment 
upon your unique requirements. All the methods for records declaration in 
Document Manager are valid, but all are not necessarily optimal for your 
environment. As a general guideline, it is best to use a simple low touch process 
that fits naturally into the users’ normal work sequence. For example, if a user 
normally works in a AutoCAD environment, it may be best to allow the 
declaration to occur when a user adds or checks a document into the system. 
You should not force the user to go to the Document Manager Desktop to 
declare the document.

Consider these suggestions for designing your record keeping process:

� Ensure that whatever process you choose meets the five second rule (an 
operation taking five seconds or less) for record declaration and classification.

� Make the process a part of the users’ normal working environment.
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� The less interaction you require to classify a document, the better. 
Completely automatic is best.

� If you require manual declaration and classification, use the Records 
Manager and CMRE tools, such as defaults, profiles, and attribute mapping 
to assist in the classification.

� Use auto classification rules whenever possible.

� A file plan that is relatively fluid, requires regular updates to the auto 
classification rules. It can be less burdensome and easier to use low touch 
classifications, such as selecting By Property, if you are updating Document 
Manager components.

� For a high document volume environment, consider using the Document 
Manager automation service to declare and classify records during off-peak 
hours.

� If declaring documents during a Document Manager life cycle, consider that 
the document gets locked down at the point of declaration. This effectively 
ends the document’s life cycle in Document Manager. So, a declaration at the 
final state in a Document Managers life cycle is prudent.

� Use the Document Manager auto declare option for simple, single document 
declaration. Use other quick declare options (or manual declare) to include all 
parts of a compound document in a single declaration or to include related 
documents in a single declaration.

4.3.1  Records management implementation in the sample solution
The records management portion of the solution consists of designing a file plan 
that meets the needs of the Document Manager solution and deciding what 
documents should be records and when to declare these documents as records. 
We also establish a retention schedule and consider user setup.

File plan
Our file plan is a simple one; but in your environment, the file plan design 
process is a complex one. Plan on months to years of development for a file 
plan.

Figure 4-11 displays the file plan design for our solution. The file plan consists of:

� Five file plan components:

– Component-type: Department
– Component-type: Proposal
– Record-type: Proposal Document
– Record-type: Request for Proposal
– Record-type: Correspondence
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� One custom attribute (in all record-types):

ProposalID, to allow auto classification of all related documents into the 
correct proposal container

Figure 4-11   Solution file plan

Records declaration 
For the sample solution, proposal documents that have been approved and go to 
the Issued state automatically become records. Any correspondence that enters 
the Incoming or Outgoing states also automatically becomes records. Other 
non-automatic records declaration is also configured in the Desktop for users to 
use.

For all the reference documents, users can decide whether the reference 
documents should be made to be records or not. Users can declare reference 
documents as records in their Desktops, using selection declaration with a 
predefined list of file plan destinations.
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Retention schedule
For the sample solution, we define a single retention schedule that applies to all 
of the proposal-related documents. This rule, shown in Figure 4-12, retains the 
proposal in active status for one year (at which point we close the proposal) and 
then we retain the proposal for seven years in a completed status. After seven 
years, we destroy the proposal. 

Figure 4-12   Life cycle code for proposal documents

Users’ setup
We import users who perform record declaration and classification from Content 
Manager into Records Manager. We import DDMSERVICE into Records 
Manager, because this user needs access to the file plan when performing quick 
declare configurations. We import ICMADMIN into Records Manager, because it 
is the user that administers CMRE. ICMADMIN logs into the CMRE administrator 
client and sets the options. We add ICMADMIN to the Records Manager 
administrators group.

We give the File Plan Administration function access right to all the Content 
Manager users and provided the privileges to the file plan hierarchies. Table 4-1 
shows the function access rights and privileges given to the users.
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Table 4-1   Permissions and function access rights given to users 

User Function Access Right Privileges

usrSale File Plan Administration Add, View, and Link for entire file 
plan

usrConsultant File Plan Administration Add, View, and Link for entire file 
plan

usrMarketing File Plan Administration Add, View, and Link for entire file 
plan

usrProjectManager File Plan Administration Add, View, and Link for entire file 
plan

usrManager File Plan Administration Add, View, and Link for entire file 
plan

usrFinancial File Plan Administration Add, View, and Link for entire file 
plan

ICMADMIN All - through administrator 
group

All - through administrator
group

DDMService File Plan Administrator View entire file plan 
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Chapter 5.  Security

In any document management solution, it is important that the solution protects 
the business assets. Document Manager, Records Manager, and the back-end 
content repository, Content Manager, all provide security features. Using these 
features, we can guard the system against unauthorized access, control what 
users can do once they are in the system, and ensure that the security 
management of the records complies with record keeping mandates and 
regulatory guidelines.

In this chapter, we discuss the security measures you can apply in a 
records-enabled document management solution. 

We cover the following topics:

� Document Manager security overview
� Records Manager security overview
� Access control of a declared record document

5
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5.1  Document Manager security overview
This section provides an overview about how IBM DB2 Document Manager 
manages security. The topics we cover are:

� Authentication and authorization
� Document access control
� Security through document life cycle
� Security through actions and dialogs
� Security through Document Manager Desktop design

5.1.1  Guarding against unauthorized access
In the records-enabled document management solution we cover in this redbook, 
Content Manager is the back-end content repository for the solution. Document 
Manager leverages the security infrastructure of Content Manager to handle user 
authentication and authorization. Authentication is the process by which the 
system determines if users are who they claim to be. Authorization is the 
process of establishing if users have the permissions to perform the requested 
action. Both are required to properly guard the system against unauthorized 
access.

Authentication
When a user logs on to Document Manager, Document Manager passes the 
user logon ID and password to Content Manager. Content Manager performs 
authentication. If the user passes Content Manager’s authentication, the user 
logs on to Document Manager successfully. Otherwise, the user is denied 
access.

When planning for your Document Manager solution, as described in 3.1, 
“Planning for a Document Manager solution” on page 48, one of the steps is to 
identify users and groups that will use the system. You must create these users 
and groups in Content Manager. 

If your Document Manager system requires Lightweight Directory Access 
Protocol (LDAP) support, only configure Content Manager to use LDAP for user 
management and authentication. Refer to the Content Manager Version 8 
Release 3 System Administration Guide, SC27-1335, for instructions about how 
to configure Content Manager to use LDAP technology. There is no additional 
configuration required in Document Manager to support LDAP. 

Note: When using Content Manager as the back-end repository for Document 
Manager, use Content Manager’s system administration client to perform all 
Content Manager user and group management.
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If your Document Manager system requires Single Sign On (SSO) capability, this 
requires configuring both Content Manager for SSO and Document Manager to 
support SSO. Refer to the DB2 Document Manager Version 8 Release 3 
Installation Guide, GC18-9272, for instructions about how to set up Document 
Manager for SSO.

In the case study, there is no LDAP or SSO requirement. We use the Content 
Manager server authentication method. We define the user IDs, passwords, and 
group information in Content Manager. When a user logs on to the Document 
Manager client Desktop, Document Manager passes the user ID and password 
to Content Manager. Then, Content Manager uses the user ID and password 
information stored in the Content Manager Library Server to authenticate the 
user.

Authorization
Once Content Manager authenticates users, they can only access documents for 
which they have permissions (or privileges) to access.

To set up the proper access for an user, perform the following steps in Content 
Manager using the Content Manager system administration client:

1. Create privilege sets.

2. Assign a privilege set to the user to indicate the maximum privileges the user 
has in the system.

3. Create access control lists to restrict access to objects, such as item type.

Privileges and privilege sets
Privileges grant the right to perform a specific action on a specific item in a 
system. Examples of privileges include ItemAdd that grants the right to create 
an item and ItemDelete that grants the right to delete an item. 

A privilege set consists of privileges. A privilege set usually combines a list of 
related privileges. 

When you create a user, you define the maximum privilege set the user has by 
assigning a privilege set to the maximum privilege set field. A user’s access 
rights do not exceed the maximum privileges defined within the privilege set.

Access control lists 
The access control list (ACL) is a list consisting of one or more individual user 
IDs or user groups and their associated privilege sets. ACLs are used to control 
user access to objects in the Content Manager system (such as items and item 
types). When defining a user, you specify the maximum privilege set the user 
has for the system. When defining an ACL, the privilege set associated with the 
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user restricts the user’s access wherever this ACL is used. An ACL does not 
grant additional privileges to an user, even if the privilege set associated with a 
user in the ACL contains more privileges than the maximum privilege set 
associated with the user. An ACL limits user access, it does not grant more 
access.

For more information about Content Manager’s authorization process, refer to 
Chapter 9, “Managing user access”, in Content Manager V8.3 System 
Administration Guide, SC27-1335, or Chapter 8, “Security”, in Content Manager 
Implementation and Migration Cookbook, SG24-7051.

Special consideration in a records-enabled system
When working with a records-enabled document management system, do not 
grant the ItemSuperAccess privilege to users, because if the system detects that 
a user has the ItemSuperAccess privilege, the system bypasses any ACL 
checking for that user. 

For example, when a document is declared as a record, your permission settings 
in Records Manager control your right to view and modify the declared 
document. However, if you have ItemSuperAccess privilege, the system 
bypasses any ACL checking and allows you to modify the record, regardless of 
the permission settings in Records Manager.

When you install Content Manager Records Enabler (CMRE), it creates a default 
privilege set RMEUserAllPrivs, and a default ACL RMEClientACL. If you do not 
know which privilege set or ACL to use, start with these defaults. When you 
create a user in Content Manager, assign the value RMEUserAllPrivs as the 
user’s Maximum privilege set and assign the value RMEClientACL as the 
Default item access control list. In order for the user to see the declared 
document and view the record information, the user must be able to access the 
RMEconfig item type. To allow the user access to RMEconfig item type, add the 
user (or the user’s group) to the PublicReadACL, because the RMEconfig item 
type is assigned the PublicReadACL when Records Enabler creates it during the 
installation.

Table 5-1 summarizes the user settings in Content Manager as a starting point 
for setting up a records-enabled document management system if you are not 
familiar with or have not decided which privilege set or ACL to use.

Note: Content Manager comes with default privilege sets. One of them is the 
ClientUserAllPrivs. Do not use this privilege set for a records-enabled 
document management system because it contains the ItemSuperAccess 
privilege.
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Table 5-1   Content Manager default settings for users who can declare records 

5.1.2  Managing security through document access control
In Document Manager, document access control is based on Content Manager’s 
access control model. 

A user can only gain access to the Document Manager system when the user 
has a login ID and password defined in Content Manager. The login ID has a set 
of privileges associated with it. That set specifies the maximum actions the user 
can perform in the system.

Any document that you add to the Document Manager system is associated with 
a Document Manager class. A Document Manager class is derived from an item 
type. When you create an item type, you specify the ACL to which it is bound. A 
Document Manager class derived from the item type inherits the ACL of the item 
type. A document by default inherits the ACL of the Document Manager class.

When you initiate an operation on a document in Document Manager, the system 
checks your privileges and the ACL that is bound to the document. The system 
allows you to proceed if you have the privilege to perform the action. For 
example, if you initiate a search action, the search result only returns documents 
that you have the right to see. Furthermore, you can only check out documents 
that you have the right to edit.

There are two ways you can bind ACL to an item type, at the item type level or at 
the item level. You can also change the ACL setting of a document in Document 
Manager objects if the ACL is bound at the item level.

Binding ACL to an item type at item type or item level
When defining an item type, you bind the ACL to the item type at the item type 
level or at the item level. 

If you bind the ACL at the item type level, all documents created under that item 
type inherit the item type’s ACL. You cannot change the ACL of any individual 

Setting Value Comment

Maximum privilege 
set

RMEUserAllPrivs Default privilege set provided by Records 
Enabler

Default item access 
control list

RMEClientACL Default ACL provided by Records Enabler

PublicReadACL Add the user or 
the user’s group

Must have access to RMEConfig item 
type, which is assigned to PublicReadACL
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document because the system only checks the access right at the item type level 
and not at the individual document level.

If you bind the ACL at the item level, documents created under that item type by 
default inherit the item type’s ACL; however, you can change the ACL of an 
individual document because the system always checks the access right at the 
individual document level. 

Figure 5-1 shows the Access Control tab of an item type configuration window 
using the Content Manager system administration client. You select the ACL to 
bind the item type from the drop-down list. You also select whether you want the 
ACL checking to be at the item type level or item level. In the sample window, the 
ACL PublicReadACL is bound to the item type at the item level.

Figure 5-1   Item type ACL selection

Note: When you enable an item type to store records, if at the time the item 
type’s ACL checking is set at item type level, Records Enabler automatically 
changes the ACL checking to item level. Records Enabler does this because it 
manages the access control of a record at the individual item or document 
level.
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Changing the ACL setting of a document
In Document Manager, there are several places where you can change a 
document’s ACL. This works only if the item type of the document has its ACL 
bound on the item level.

Table 5-2 lists the Document Manager objects where you can change the ACL 
setting of a document. You change the settings through the Document Manager 
Designer. Refer to the DB2 Document Manager V8.3 System Administration 
Guide, SC18-9254, for detailed instructions about how to change the ACL setting 
for each of these objects.

Table 5-2   Document Manager objects where you can change the ACL setting

Note: The behavior you expect from changing the ACL setting only works if 
you create the document’s item type with the ACL bound at the item level.

Document Manager 
objects

Description

New item templates The new item templates object provides you the ability to 
specify default information for properties, security, and 
standard folders for new items being added to a system. The 
security section is where you can specify ACL setting. If you 
specify an ACL setting at the state object, this setting 
overrides the ACL setting that is bound to the item type. 
Otherwise, the item that you create using this new item 
template inherits the ACL setting of the item type.

State The state object has a security section for you to specify the 
ACL you want an item to have when it transitions into this 
state. If you specify an ACL setting at the rendition object, 
this setting overrides the ACL setting that the item has 
before it transitions into this state. Otherwise, the item ACL 
setting remains unchanged.

Rendition destination 
configuration

You can specify ACL settings when you define a rendition 
destination configuration object. If you specify ACL 
settings, the rendition object is bound to the ACL settings 
that you specify. Otherwise, the rendition object has the ACL 
of the item type under which it is created.

Action process object The action process object falls under the Document 
Manager automation services. There are different types of 
action process objects. The Modify ACL action type is one 
of them. The action modifies the ACL of the item.
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Document access control in the sample solution
In the sample solution (described in Chapter 2, “Quick start with case study” on 
page 15), we create the CustomerData item type with the ACL bound at the item 
level. From the CustomerData item type, we create the following classes:

� Marketing Proposal
� Sales Proposal
� Services Proposal
� Correspondence
� RFP

Since we create these classes from one item type, the documents created for 
these classes share the same ACL. 

We have the following groups of users who can create proposal documents:

� Sales group creates sales proposal documents.
� Marketing group creates marketing proposal documents.
� Services group creates services proposal documents.

All three groups have read, write, and delete privileges in their user ID profiles. 
Subsequently, they all have read, write, and delete rights to the three types of 
proposal documents because all documents share the same ACL. 

If there is a security requirement to limit the access right of the sales proposals to 
the sales group, we must change the ACL of every sales proposal document to 
limit the marketing and services group from accessing the sales proposals. This 
is possible because Document Manager provides ways to change the ACL of an 
individual item (in this example, the sales proposal). However, this design is 
cumbersome and there is a performance impact to pay as well. 

If the design requires different access control for different types of the 
documents, a better data model is to create three different item types. One item 
type is for the sales proposal, one for the marketing proposal, and one for the 
services proposal. Each item type has its own ACL and has one class associated 
with it. Subsequently, we can set up an ACL for the sales proposal item type so 
that the marketing and services groups do not have access to the sales proposal 
item type. The same is done for the marketing proposal item type and services 
proposal item type.

Security menu 
command

The security menu command is a Document Manager 
Desktop command. This command enables you to change 
the ACL setting of an item.

Document Manager 
objects

Description 
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5.1.3  Managing security through document life cycle
Document Manager provides you with building blocks so you can model your 
organization’s business rules that govern document life cycle without any 
programming. The life cycle building blocks have security features to help protect 
your business documents. The building blocks are:

� Users and groups
� Roles
� States
� Classes

We have already discussed users, groups, and classes. In this section, we focus 
on roles and states.

Roles
Roles allow you to define the actions that users or groups of users can perform 
on documents of a particular class or state. When you define a role, you decide 
what actions you want the person in this role to be able to do on the document. 

The actions that users can perform on a document include: 

� Add items
� Checkout
� Copy
� Revise items
� Modify properties
� Print
� Transition
� View
� Markup

Figure 5-2 shows you the Role Configuration window for the Creator role from 
the Document Manager Designer. 
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Figure 5-2   The Role configuration window

You can create a role to include any number of actions. After you define the role, 
you can associate users or groups to this role. This enables the users or groups 
associated with this role to perform a list of the actions set in the role. For 
example, if you did not select the Checkout action for the role Creators, the users 
of the Creators role will not be able to checkout the document, even though the 
user has the right to edit the document based on the user’s privilege set and the 
document’s ACL.

State
In a document life cycle, a document goes through multiple states. When you 
define a state, you specify what actions users can perform at the state.

Basic security actions include:

� Items can be added as this state.

� New revisions can be created as this state.

� Apply all access privilege modifications to single-parent children of same or 
stateless class.

The Items can be added as this state option in the state definition allows you to 
add a document into the system at this state of a document life cycle. For 
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example, in the sample application, we define the Draft state with this option 
selected. This means that users can add a new sales proposal in the system with 
its state set to Draft. You can choose not to add documents into just any state. 
For example, the Issued state usually represents documents that have gone 
through the approval process and are published for general consumption. For 
the Issued state definition, you do not want to check this option because you do 
not want users to add proposal documents with Issued state; otherwise, the 
proposals have bypassed the approval process set by company policy.

The New revisions can be created as this state option allows you to start a 
revised copy of a document at this state. This is a security feature because you 
want to be selective where in the document life cycle you allow the user to start a 
revised copy of the document. For example, in the sample application, the life 
cycle of a sales proposal is: from Draft to Review to Approval to Issued. We want 
the revise sales proposal document to begin its lifecyle at the Draft state because 
that is the business rule. It is a violation of the business rule to allow a revised 
copy to begin at another state. In the Draft state definition, we select this option. 
In any other states, this option is not selected.

The last option, Apply all access privilege modifications to single-parent 
children of same or stateless class, allows the system to apply the parent’s 
security setting to the children if the children have only one parent (the current 
item) with the same class affiliation as the parent or are of a stateless class.

Figure 5-3 shows you the State Configuration window for the Draft state from the 
Document Manager Designer. 
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Figure 5-3   The security tab of the Modify State Configuration window 

You can select any of the three options. In addition, you can set additional 
security actions by clicking Set from the window. This displays the Security 
Action Definitions window as shown in Figure 5-4. 
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Figure 5-4   Security Action Definitions window

In this window, you can specify the ACL setting for the document that is in 
transition into this state. If you do not specify anything, the document retains 
whatever ACL setting it has prior to transitioning into this state. 

Pulling it all together in the life cycle map
Figure 5-5 shows a life cycle map of the sales proposal class from our sample 
solution. There are four states in this life cycle: Draft, Review, Approval and 
Issued. The life cycle starts from the Draft state, to the Review state, to the 

Note: Once again, we must emphasize that the only way you can change a 
document’s ACL here is if the document is created from an item type that has 
an ACL bound at the item level. If the ACL of the item type is bound at the item 
type level, the document’s ACL will not change. 
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Approval state, and finally to the Issued state. At the Review state, the document 
can be moved back to the Draft state for rework.

Figure 5-5   The life cycle map of the Sales Proposal Class

Figure 5-6 shows you an expansion of the Draft state object as it appears on the 
Document Manager Designer. 
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Figure 5-6   Expansion of the Draft state object

The Draft object is associated with the role, Creators. The Creators role is 
associated with the groups: grpConsultants, grpMarketing, and grpSales. At the 
Draft state, only users who are in the role Creators can carry out the actions 
permitted by the role Creators (see Figure 5-2 for the actions selected for the role 
Creator). Users who are in the Creators role are users who are defined in the 
grpConsultants, grpMarketing, and grpSales user groups. 

If your user’s privilege allows you to edit a document, but you are not in the 
Creators role, you can read the document, but the system does not allow you to 
checkout the document or transition it from the Draft to the Review state.

Transition authentication option
When defining the life cycle map, you can require a user to authenticate when 
the user transitions a document from one state to another. The system prompts 
the user to enter their user name and password. This can serve as an electronic 
signature. Figure 5-7 shows an example of state transition from Approved to 
Issued, which requires authentication.
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Figure 5-7   User authentication required during a transition

This is an optional feature. You set up the transition authentication option when 
you configure the life cycle map using Document Manager Designer. Refer to 
Chapter 7, “Configuring a life cycle”, in the IBM DB2 Document Manager V8.3 
System Administration Guide, SC18-9254, for detailed instruction about setting 
up this option.

5.1.4  Managing security through the actions and dialog objects
Actions and dialog objects provide interfaces for managing documents (items) in 
a Document Manager system. Actions result from interactive menu command 
selections, which can or cannot display a dialog, depending on the configuration. 
Dialogs are displayed for the user to input or update document attribute 
information.

Document Manager has the following type of configurable actions and dialog 
objects:

� Add
� Check in
� Check out
� Copy
� Modify
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� Revise
� Transition
� Version History
� View

Table 5-3 shows which Document Manager actions require configuration, which 
are optional, and which have no requirement.

Table 5-3   Configurable actions and dialogs

Depending on your system requirements, you can create actions and dialog 
objects for the desired actions and associate them with a class. When you create 
these objects, you need to specify the users or groups that have access to them. 
If a user is not part of the users or groups who are associated with the actions 
and dialog objects, the user cannot perform the actions.

For example in the case study, users need to:

� Add a sales proposal document
� Modify the properties (attributes) of a sales proposal document
� Revise a sales proposal document

In the sample application, the sales proposal class has three actions and dialog 
objects (see Figure 5-8):

� Proposal - Revise
� Sales Proposal - Add
� Sales Proposal - Modify

Actions Dialogs When used

Add Required Add an item to the content repository.

Check in Optional Check in one or more items.

Check out Optional Check out one or more items.

Copy None Copy one or more item to a specified location.

Modify Required Modify an item’s attributes.

Revise Optional Create a revision of an item.

Transition None Transition one or more items from the current 
state to a new state.

Version History Required View all versions of a selected item.

View None Display one or more items in the configured 
viewer.
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Figure 5-8   Mapping actions and dialog objects to Sales Proposal Class

Each object has its associated groups mapped to it. See Figure 5-9.
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Figure 5-9   Document Manager actions and dialog objects

In the sample application, the user group grpSales is associated with the Sales 
Proposal - Add action and dialog object. This means that users who are in the 
grpSales group can add a sales proposal document to the system. Users who 
are not in the grpSales group will not be able to add a sales proposal document 
even if the ACL for the sales proposal class permits them to add documents for 
this class.

5.1.5  Managing security through the Desktop design
Users interface with a Document Manager system using the Document Manager 
Desktop client. Document Manager enables you to customize the Desktop client 
to provide security to the system. 

You can create different Desktops for different users. You can control the menus 
and the icons available to users, and you can control the folder pane users see to 
control users’ views, folders, and searches. 

For illustration purposes, we show you the Document Manager Desktop view of 
two types of users, the administrative user (ICMADMIN) and an occasional 
Document Manager user (USER). 

Actions and dialog objects
Each object has groups associated with it.
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Figure 5-10 and Figure 5-11 show the Document Manager Desktop view of an 
administrator user whose user ID is ICMADMIN.

Figure 5-10   An administrator’s Document Manager Desktop (part 1 of 2)

Figure 5-11   An administrator’s Document Manager Desktop view (part 2 of 2)
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Figure 5-12 shows the Document Manager Desktop view of an occasional 
Document Manager user whose user ID is USER.

Figure 5-12   An occasional Document Manager user’s Desktop view

If you compare the ICMADMIN’s Document Manager Desktop to the USER’s 
Desktop, you see that ICMADMIN has many more commands on its Desktop 
than the USER’s Desktop. One way for you to manage system security is to 
decide what menu commands users can have on their Document Manager 
Desktops.

For example, the ICMADMIN user has menu commands such as Configure and 
Power Modify. The Configure command starts the Document Manager 
Designer from the Document Manager Desktop. Users who have the Configure 
command on their Desktop can change the Document Manager configuration. 
You probably only want to give the Configure command to users who have 
Document Manager administrative responsibility.

The Power Modify command allows the user to change the value of the library 
properties in a Document Manager system. For example, users who have the 
Power Modify command on their Desktop can change the value of a document’s 
state property. Users can change a document’s state from Draft to Issued. They 
can also change the class value from sales proposal to marketing proposal. You 
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need to be selective deciding who can have the Power Modify command on 
their Document Manager Desktop.

Security in folder
Document Manager folder has security parameters to enable you to specify who 
has access to the folder that you create. 

You create a folder through the Folder Administration command which is a 
Document Manager Desktop command. When you select Folder 
Administration → New, the New Folder Configuration window displays (see 
Figure 5-13).

Figure 5-13   Folder configuration window

You specify the type of folder you want to create on the Type drop-down box. 
There are two types of folders: Standard and Dynamic. Standard folder is similar 
to a normal Windows folder; a user or a Document Manager service can add 
documents to it. A dynamic folder behaves like a query. When you create a 

Note: Every aspect of the Document Manager Desktop is configurable. You 
need to examine each command and decide which ones are appropriate to 
which user groups. 
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dynamic folder, you associate a predefine query to the folder. When a user 
selects the dynamic folder, the system executes the predefined query that is 
associated with the dynamic folder and returns the search result in the 
documents pane.

You specify the default view on the View drop-down box. When a user selects 
the folder, the system displays the result in the default view that is associated 
with the folder.

You specify the default access control for the folder on the Default Access 
drop-down box. The choices are listed in Table 5-4.

Table 5-4   Default access control choices for folder

After you create a folder, you can further refine the folder’s access control by 
modifying the folder security information through the Folder Administration 
menu command from the Document Manager Desktop. To do that: 

1. From the Document Manager Desktop menu, select Folder → Folder 
Administration. A Client Folder Administration window displays.

2. Right-click the folder you want to modify, and select Modify from the context 
menu.

3. Select the Security tab. See Figure 5-14.

4. Specify the type of access control you want certain users or groups to have. 
The access control choices are Owner, Author, Viewer, or No Access. We 
explained them in Table 5-4. 

Owner access gives the users the ability to open the folder, add items to the 
folder, delete items from the folder, and modify the folder configuration with the 
Folder Administration menu command. By default, the folder creator has owner 
access.

Access control 
choices

Description

Author Give users the ability to open the folder, add items 
to the folder, and delete items from the folder.

No access Prevent users from seeing the folder on the Desktop 
or seeing the folder with the Folder Administration 
command. This does not apply to the person who 
creates the folder. The creator of the folder has 
owner access control.

Viewer Give users the ability to open the folder and see the 
result list.
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Figure 5-14   Modify Folder Configuration window

Figure 5-15 shows that two additional groups, tstGrp and tstGrp2, are added with 
owner access level control to the folder My Minutes. Users who are in the tstGrp 
and tstGrp2 groups can now see the My Minutes folder on their Desktops. They 
can also open the folder, add items to and delete items from the folder, and 
modify the folder configuration with the Folder Administration menu.

Figure 5-15   Granting selected groups access to folder
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5.2  Records Manager security overview
This section provides an overview about how IBM Records Manager manages 
security. The topics we cover are:

� Security basics
� Local and host Records Manager users
� Function access right basics
� Permission basics

The objective is to provide you with information about how Records Manager 
handles security from the perspective of performing records declaration and 
classification. The intent is to give you enough information to help you get started 
setting up Records Manager for your Document Manager solution. There is 
much more to Records Manager security and administration than what we cover 
here. For an in-depth discussion of Records Manager security and 
administration, refer to Chapter 10, “Security”, of the IBM Records Manager: 
Records Administrator’s Guide, SC18-9180.

5.2.1  Security basics
Records Manager’s security revolves around two elements:

� Function access rights
� Permission

Every user who wants to access Records Manager needs a user account in 
Records Manager. Having a user account in Records Manager only enables you 
to log on to Records Manager. To perform any task in Records Manager, you 
must have the appropriate access rights to the Records Manager’s application 
features. Records Manager calls this type of access rights function access rights. 
For example, if the user needs to declare records, the Records Manager’s user 
account needs the function access rights, File Plan Administration, assigned to 
it.

If the user’s task involves the file plan components, the user also must be 
granted the appropriate access permissions on the individual file plan objects. 
For example, the File Plan Administration function access right gives a user the 
ability to do records declaration; but to declare a record successfully, the user’s 
account also needs to be given access permission on the individual objects that 
made up the file plan.

Before we examine function access rights and permission in detail, let us 
examine the different types of users in Records Manager.
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5.2.2  Local and host Records Manager users
There are two types of users in Records Manager: local users and host users. In 
a records-enabled document management solution, host means the Document 
Managers content repository. In this solution, the host is Content Manager. 

Local users
Local users are user accounts that are defined exclusively for Records Manager. 
Content Manager does not know about the Records Manager’s local users. If 
you, as a local user, log on to Records Manager, you only need to enter your 
user ID, password, and the Records Manager database. You do not need to 
enter the host name. Records Manager performs authentication on local user 
accounts.

You may want to create local user accounts for those who need to perform 
Records Manager, Records Administrator, and Records Technical Administrator 
tasks. The local users do not need to access contents in the host application.

Examples of Records Manager tasks are:

� Prepare and run reports in Records Manager.
� Link retention rules to file plan components.
� Initiate suspensions (audit, compliance, legal, or tax holds).
� Execute life cycle management functions, including record dispositions.

Examples of Records Administrator tasks are:

� Maintain and assign security, permissions, and function access rights.
� Perform audits.
� Create file plan components.
� Create the file plan structure.
� Apply changes to user group definitions.

Examples of a Records Technical Administrator’s tasks are:

� Create and maintain style sheets for generating reports (using XML).
� Back up the database.
� Perform database maintenance.
� Address performance issues.
� Add indexes.
� Schedule tasks.

Host users
Host users are users who have accounts in the application that hosts Record 
Manager. 
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In the records-enabled document management solution, Document Manager is 
the application that enables users to manage documents. Content Manager is 
the back-end content repository that stores Document Manager’s documents. 
Users in Content Manager need to be imported to both Document Manager and 
Records Manager. The Content Manager users are considered the host users in 
Records Manager. 

Unlike local users, Records Manager does not authenticate host users. Records 
Manager relies on the host application (Content Manager) to perform the 
authentication. 

Host users access Records Manager in one of two ways:

� Through the host application 

For example, users can access Records Manager functions through Content 
Manager. In this scenario, Content Manager is the host application.

� Through logon to Records Manager directly 

A host user can log on to Records Manager directly. To do so, you enter the 
user ID, password, the Records Manager database name, and the host 
name. Records Manager passes the user ID and password to the host 
application and relies on the host application to do the authentication.

Note, in the records-enabled document management solution, because 
Content Manager is the back-end content repository for the system, and the 
host users are imported from Content Manager, the host name the user 
enters should be the Content Manager Library Server name.

Only users who have user accounts in Records Manager can access Records 
Manager and perform records-related functions in the host applications. When 
designing your solution, determine which Document Manager users and Content 
Manager users perform record functions. These include users who declare and 
classify records and who view and access the declared records. You must create 
all these users in Content Manager and import them into Records Manager. 

Note: Although you can import user groups from the host system (Content 
Manager) into Records Manager, that is insufficient. You have to also import 
the users from the host system into Records Manager.
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Host users can also perform Records Manager administrative tasks as long as 
you have granted these host users the proper function access rights and 
permissions on the Records Manager file plan objects.

5.2.3  Function access right basics
Function access rights (FAR) define a user’s or a group’s access to the 
application features of Records Manager. Examples of the function access rights 
include File Plan Design, File Plan Administration, and Life Cycle Management 
Design. Table 5-5 lists the function access rights in Records Manager. Records 
Manager controls access to its features and capabilities through these function 
access rights. Every capability is mapped to a right and the right must be granted 
to a user before the user has the potential to exercise the function.

As we mentioned in the previous section, for a host user to perform records 
declaration and classification, the user must have the File Plan Administration 
access right. The File Plan Administration access right gives the user the right 
to access the file plan administration function in Records Manager. Permission 
must also be set to enable Add, View, or other actions against components in the 
file plan. When a user declares and classifies a record, the user adds the record 
object to the file plan. The record object is a file plan component.

Refer to Chapter 12, “Function Access Right”, in the IBM DB Records Manager 
Version 4.1.2 Records Administrator’s Guide, SC18-9180, for more information 
about each of the function access rights.

Table 5-5 lists function access rights and their definitions.

Notes: Remember to include Document Manager system accounts, such as:

� The account ID used by Document Manager Designer to log on to the 
libraries (DDMService). This account needs to access the Records 
Manager file plan when you want to set up the classification path for the 
class object.

� The account IDs used by the life cycle services and automation services if 
the services are set up to perform records declaration.

� Users, as we mentioned earlier, who need to view and access the 
documents after the documents are declared as records.

 

 

 

 

118 IBM DB2 Document Manager with IBM Records Manager Solution Guide



Table 5-5   Function access rights and their definitions

Function access rights Definition

Audit Management To configure individual events that are not 
audited.

Disposal Authorities To create, edit, or delete disposal 
authorities.

File Plan Design To design file plans.

File Plan Administration To add elements to a file plan, including 
the ability to add, edit, or delete individual 
file plan components.

Life Cycle Management Design To define life cycle codes, life cycle 
phases, and other life cycle management 
items.

Life Cycle Management Operations To execute life cycle management 
operations, such as disposition.

Pick List Management To create, edit, or delete pick lists.

Profile Design To create, edit, and delete data entry 
profiles (forms) for all objects, including 
file plan components and system objects.

Security Management To define permissions at a global level.

Users/Groups Management To add, edit, or delete users and groups 
along with the ability to add users to 
groups.

Record Host Management To add, edit, or delete the record-host 
identifiers that define a record host to 
Records Manager. A record host is an 
application with which the Records 
Manager is integrated and that acts as the 
repository of the records managed by the 
Records Manager.
In the records-enabled document 
management solution, the record host is 
Content Manager.

Extension Management To create, edit, and delete extensions that 
extend the functionality of the base 
Records Manager.

Reservation Management To create, update, and delete 
reservations.
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Figure 5-16 and Figure 5-17 show how we set up the function access right for 
one of the user IDs, usrConsultant, in the sample application. The user 
usrConsultant only has the File Plan Administration function access right. 
Notice that in Figure 5-17 the Is Active flag is set; otherwise, the user 
usrConsultant is considered inactive in the system and cannot log on to Records 
Manager.

Charge-Out Management To create, update, and delete charge outs.

Auto-Classify Rules Management To define auto-classification rules.

Default Management To create, edit, and delete defaults for 
different file plan component definitions.

System Configuration Management To customize the behavior of Records 
Manager.

Report Layout Manager To assign and delete report layouts.

Report Query Management To open, delete, and assign saved public 
queries to users and groups.

Field Level Security Management To determine the users who can change 
field level permissions.

Security Descriptors Management To create security descriptors.

Security Classification Management To create security classification.

Security Classification Reason 
Management

To create security classification reasons.

Security Classification Exemption 
Management

To create classification exemptions.

Security Classification Guide 
Management

To create the security classification guide.

Audit Reporting To create the audit report.

Purge Audit Entries To purge audit entries.

View All Audit Entries To view all audit entries.

Function access rights Definition 
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Figure 5-16   FAR for records declaration and classification (part 1 of 2)

Figure 5-17   FAR for records declaration and classification (part 2 of 2)

 

 

 

 

 Chapter 5. Security 121



5.2.4  Permission basics
Records Manager controls access to its file plan objects through a set of access 
rules called permissions. Records Manager uses permissions to restrict what a 
user can do to the file plan components and the file plan component definitions. 
You set the permission through the Records Manager Administrator client.

You can set permissions three ways in Records Manager:

� System wide
� Component level
� Field level

Table 5-6 briefly describes the permission settings. 

Table 5-6   Permission settings

By default, users have no permission to access any file plan component other 
than the users who are part of the Records Manager Administrators group. You 
must go through the permission setting process to grant users the appropriate 
permissions.

System wide permission setting
In system wide permission setting, Records Manager lets you set permission 
across multiple file plan components all at the same time. You do that through 
the Records Manager Administrator client Security → System Permission 
selection. For detailed instructions about how to set up system permission, refer 
to Chapter 10, “Security”, in the IBM Records Manager Records Administrator’s 
Guide, SC18-9180.

Use system wide permission when you want to set the same permissions across 
multiple file plan components for a group of users.

Permission settings Definition

System wide System wide permission setting enables you to set 
permission at the system level across multiple file 
plan components all at the same time.

Component level In component level permission setting, you set 
permission for one file plan component at a time.

Field level Field level permission setting extends security of a 
file plan component to its attribute level.
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Component level permission setting
Component level permission setting allows you to set permissions for an 
individual file plan component. You do that through the Records Manager 
Administrator client File Plan Administration selection. From there, you drill 
down to the file plan component for which you want to set permissions.

When you assign permission, you are specifying who can do what to a file plan 
component. Table 5-7 lists the permissions available to a file plan component. 
This permission list is available for both system wide and component level 
permission setting.

Table 5-7   File plan component access control selections

Note: The permissions that you set at the component level override the 
permissions that you set at the system wide permission setting. 

For example, there is a file plan component called Department. You grant a 
user Add, Update, and View permissions at the system permission level. 
Subsequently, you also set up a component level permission for Department, 
but you only grant Add and View to the user at the component level. The net 
result is the user only has Add and View permissions for Department because 
the component level permission settings take priority. The user may be 
granted more permissions under the component level and that will also 
override the system permission setting.

Permissions Description

Add To add a file plan component of a particular type.

Update To modify an existing file plan component of a particular type.
If the file plan component type is record type, users with this 
permission can modify the record’s metadata. 
Important: If the metadata is one that is mapped from the item type 
in Content Manager, you must run the permissions synchronization 
process before the changes reflect in Content Manager.

Delete To remove a file plan component of a particular type from the file plan 
itself.
Important: If the file plan component type is record type, users with 
this permission can use this command to undeclare a record.

View To see the profile of a file plan component of a particular type. 
User who cannot view a file plan component will not know of its 
existence in the file plan.

Suspend To suspend a file plan component from transitioning through its life 
cycle.
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Of all the permissions listed in Table 5-7, the minimum permissions that the 
Document Manager uses to declare and classify records are Add and View. For 
the users to see the declared records, you must grant them the Host Retrieve 
permission. The Add Link permission is only required if the users need to 
establish a link relationship during record declaration. For those users who need 
to be able to update the record’s metadata, they need the Update permission.

UnSuspend To remove a suspension from a file plan component and allow it to 
continue through its life cycle.

Move To move a file plan component from one place in the file plan to 
another.

Change 
Permissions

To alter the permissions assigned to a particular file plan component.

Reserve To reserve a file plan component for yourself.

Add Link To add a link.

Delete Link To delete a link.

Charge Out To charge out a file plan component to yourself, or to someone else.

Host Retrieve To retrieve a record to a user’s workspace on their computer when 
the file plan component represents a record stored in an adjoining 
host application. This permission is stored in Records Manager for 
information purposes only, since Records Manager cannot directly 
control whether an adjoining application allows a user to retrieve a 
document.
Important: For the records-enabled document management solution 
that uses Content Manager, Records Enabler, Records Manager, 
and Document Manager, the Host Retrieve permission enables the 
Content Manager or Document Manager users to see documents 
after they are declared as records. You must grant Host Retrieve 
permission if you want users to view the declared records. Without 
this permission, users would not be able to search or view these 
documents. For more explanation, see “Access control of a declared 
record document” on page 131.

Permissions Description 
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In the sample application, when a proposal document transitions to the Issued 
state, it gets automatically declared as a record. The proposal document is a 
Word document. Once it is in the Issued state, a PDF rendition of the Word 
document is created. We manually declare the PDF as a record. During the 
manual record declaration process, we establish a link between the PDF 
document and the original Word version of the proposal document. In order for 
users to perform the link task, the users in the sample application require the Add 
Link permission, in addition to the Add, View and Host Retrieve permissions.

Note: After a document becomes a record, a Document Manager user who 
has the Update permission set in Records Manager can modify the document 
metadata in one of two ways:

� From the Document Manager Desktop, select View Records 
Information → Actions → Edit.

� From the Records Manager Administrator client, navigate through the file 
plan to the desired record, select Actions → Edit.

After the metadata is changed, you must run the permission synchronization 
process for the change to be reflected in Content Manager if the metadata also 
exists in Content Manager.

The usual way of selecting the Modify command from the Document Manager 
Desktop to modify the metadata will not work for a document that is declared 
as a record.

Once a document becomes a record, the access permission for the record is 
controlled by Records Manager. Therefore, you can only make changes to the 
record through Records Manager.
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Figure 5-18 shows the file plan of the sample application.

Figure 5-18   Demonstration solution file plan view
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Figure 5-19 shows the selections in the Security menu. System Permissions 
and Field Level Permission selections are there, but not the component 
permissions because you set that in the File Plan Administration selection.

Figure 5-19   Security selections

If you select Security → SystemPermissions, you see the System Component 
Permission window. Figure 5-20 is an example of the System Component 
Permission setting for the sample application. We set the system wide 
permissions for all of the file plan components at the same time.

Figure 5-20   Setting system permissions for demonstration solution
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All users who perform records declaration need View permission for all 
components in the file plan hierarchy down to the component where the record 
will be classified. In the sample application, these are the Department and 
Proposal components. For the component where the record is classified, the 
user needs Add and View permissions. In the sample application, these are 
Request for Proposal, Proposal Document, and Correspondence.

Figure 5-21 shows the permission setting of the Department file plan component 
for the user ID, usrConsultant.

Figure 5-21   Permission setting for the Department component
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Figure 5-22 shows the permission setting for the Proposal component for the 
user ID, usrConsultant.

Figure 5-22   Permission setting for the Proposal component

Figure 5-23 shows the permission settings for the Correspondence file plan 
component for the user ID, usrConsultant. Notice that usrConsultant has Add, 
Add Link, and Host Retrieve in addition to View permission, because the user 
needs to add records into the Correspondence component when usrConsultant 
declares and classifies a correspondence type document. The Host Retrieve 
permission allows usrConsultant to continue to see the document after it 
becomes a record. The permission Add Link enables usrConsultant to create a 
link. usrConsultant has the same permission settings for component Proposal 
Document and Request for Proposal.
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Figure 5-23   Permission setting for the Correspondence component

Table 5-8 summarizes the component permission settings for the user 
usrConsultant in the sample application.

Table 5-8   Component permission setting for user usrConsultant

Component Permission list

Department component View

Proposal component View

Correspondence component Add, Add Link, View, and Host Retrieve
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Field level permission setting
In the field level permission setting, Records Manager extends access control to 
the field level of a file plan component. Field is also called attribute. The 
available permissions for the field level permission setting are Add and Update. 
The Add permission gives a user the right to specify a value for a field when 
adding a new file plan component. The Update permission gives a user the right 
to specify a value for a field when updating a file plan component. Records 
Manager by default gives the user Add and Update permissions to all the Fields 
in a file plan component. You restrict the Add and Update permission to the field 
by removing the permission. 

To assign or restrict field level permission, in the Records Manager Administrator 
client, go to the Security → Field Level Permissions selection. For instructions 
how to set up Field level permission, refer to Chapter 10, “Security”, in the IBM 
Records Manager Records Administrator’s Guide, SC18-9180.

We do not use field level permission in the sample application. 

5.3  Access control of a declared record document
Once an item in Document Manager is declared as a record, Records Manager 
takes over the retention and disposition of the declared record. The content and 
the associated metadata of the item remain in its back-end repository, Content 
Manager. The access permissions and the life cycle of the record are governed 
by those that are set within Records Manager. Only authorized users, such as 
the records administrators, can process or manage the life cycle of the records.

As mentioned earlier, when you record enable an item type (meaning the item 
type can now store documents that can be declared as records), Records 
Enabler automatically changes the item type’s ACL binding from the item type 
level to the item level if it is set at item type level previously. Records Enabler 

Note: Both Records Manager and Document Manager use the term life cycle, 
but life cycle means different things in Records Manager and Document 
Manager. In Document Manager, the life cycle pertains to the states an item 
must go through before it becomes a record. In Records Manager, the life 
cycle means a collection of phases through which a record must transition 
before it is discarded. 

An easy way to distinguish them is, before an item becomes a record, the 
Document Manager’s life cycle governs the item. After the item becomes a 
record, the Record Manager’s life cycle governs the item. They are not the 
same thing and they do not overlap.
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does this because the ACL is different for a document that is not a record versus 
a document that is a record. In order for documents of the same item type to 
have different ACLs, the item type must be bound to the ACL at the item level. 

Figure 5-24 shows the ACL of a document that is not yet a record. This display is 
the result of selecting the Document Manager Security command from the 
Document Manager Desktop. The ACL of a document that is not yet a record is 
based on the ACL that is assigned to the document’s item type. In this case, it is 
PublicReadACL.

Figure 5-24   The ACL of a document that is not yet a record

Figure 5-25 shows the ACL of a document that has been declared as a record. 
This ACL is generated by Records Enabler. Records Enabler generates an ACL 
for the document based on each user’s permission setting in Records Manager 
and the user’s privilege setting in Content Manager.
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Figure 5-25   The ACL of a document that has been declared as a record

Figure 5-26 shows a list of ACLs from the Content Manager system 
administration client. The ACLs generated by Records Enabler all begin with 
$ICMRME. At record declaration time, Records Enabler determines the ACL for 
the document by merging the document’s ACL in Content Manager with the 
permissions of the users in Records Manager. If it finds an existing ACL in 
Content Manager that fits the new ACL for the document, Records Enabler 
reuses the existing ACL; otherwise, Records Enabler creates a new ACL for the 
document. Similarly, Records Enabler reuses an existing privilege set in Content 
Manager if it finds one that meets the document’s access control requirement; 
otherwise, Records Enabler creates a new privilege set. 
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Figure 5-26   ACL list from the Content Manager system administration client

Figure 5-27 shows a list of the privilege sets from the Content Manager system 
administration client. The privilege sets generated by Records Enabler all begin 
with $ICMRME. 

Figure 5-27   Privilege set list from CM System Administration client
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Let us look at an example. 

Figure 5-28 shows the definition for the PublicReadACL. Prior to the record 
declaration, a document has the PublicReadACL. Users such as PETER and 
WBUSER are assigned to the privilege set, RMEUserAllPrivs, within the ACL.

Figure 5-28   PublicReadACL
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Figure 5-29 shows what a user with the RMEUserAllPrivs privilege set can do. 
The actions that are selected in RMEUserAllPrivs are the actions that users 
such as PETER and WBUSER can do to a document which has the 
PublicReadACL. 

Figure 5-29   RMEUserAllPrivs privilege set
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After a document is declared as a record, Records Manager takes over the 
access permission of the document. Based on the security setting in Records 
Manager, Records Enabler determines that the document needs a new ACL, the 
$ICMRMEAcl2073342011_2073342105 ACL. See Figure 5-30. 

Figure 5-30   Records Enabler-generated ACL

In this new ACL, PETER is assigned a different privilege set, 
$ICMRMEPS1681002806, and WBUSER is also assigned a different privilege 
set, $ICMRMEPS328886324. 

 

 

 

 

 Chapter 5. Security 137



Figure 5-31 shows Peter’s and WBUSER’s new privilege sets. PETER can 
search and read the document. WBUSER has no privilege on this document 
after the document is declared as a record. WBUSER cannot even search or 
read the document because WBUSER has not been granted the Host Retrieve 
permission in Records Manager.

Figure 5-31   Peter’s and WBUSR’s privilege sets after record declaration

Peter’s new privilege set

WBUSER’s new privilege set
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5.3.1  Impact of permission changes in Records Manager
When the permission of a host user in Records Manager changes, the change is 
not reflected in Content Manager until the permission synchronization process 
runs.

For example, WBUSER at one point does not have Host Retrieve permission in 
Records Manager. Now a record administrator grants WBUSER the Host 
Retrieve permission. This change should entitle WBUSER to see the declared 
document described for Figure 5-30. However, the user will not be able to see the 
document until the permission synchronization process runs. This process is 
responsible for synchronizing the changes in Records Manager back into 
Content Manager.

You can run permission synchronization from the Records Enabler administration 
client. There are two ways to run the process. You can schedule the permission 
synchronization process or you can run it on demand. See Figure 5-32.

Figure 5-32   Permission Synchronization panel
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For more information about how to run the permission synchronization process, 
refer to Installing and Configuring the DB2 Content Manager Records Enabler 
V8.3, GC18-7570.

5.4  Summary
When planning to incorporate security into your records-enabled document 
management system, consider these items:

� Determine users, user groups, and the privileges and privilege set each user 
should have. The users and user groups are created in Content Manager.

� If your system uses LDAP, integrate Content Manager with the LDAP system.

� If your system uses SSO, configure both Content Manager and Document 
Manager to use SSO.

� Determine the data model for your solution. What items, item types, and 
classes to create.

� Determine the ACLs to establish. This ensures proper access to the items 
and item types.

� Determine the users or user groups who can declare and classify records 
because you need to import them into Records Manager. After you import 
them into Records Manager, grant the users the proper function access rights 
and file plan component permissions.

Function access right setup reminder: In order for a user to declare and 
classify a record, the user must have the File Plan Administration access 
right. 

Permission setup reminder: In order for the user to declare and classify a 
record and be able to view and search the record, the user also must have 
Add, View, and Host Retrieve permissions of the file plan component. If a 
user only needs to search and view a declared record, the user needs the 
Host Retrieve permission.

� Determine the different roles your system requires. Who should be in what 
roles and what actions can the roles perform?

� For documents that require life cycle management, you need to map out the 
states through which the documents go. The Document Manager life cycle 
process enables you to control who can do what at each stage (state) of the 
life cycle, before the document is declared as a record. 

� Determine which Document Manager commands each user group needs in 
order to do its job. From the analysis, you can decide how many Document 
Manager Desktop templates your system needs and how to configure each 
Desktop template. 
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For example, determine which Document Manager menu commands, view 
templates, search tIBM DB2 Document Manager with IBM Records Manager 
Solution Guideemplates, application integration, actions, and dialog boxes 
the Document Manager Desktop templates should have. You can manage 
the security of your Document Manager system by the type of Document 
Manager Content Manager Desktop template you configure for each user 
group.
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Chapter 6. System configuration 
planning

In this chapter, we discuss system configuration for a Document Manager 
system with and without records management functions.

We cover the following topics:

� System component overview
� System configuration without Records Manager
� Configuration with Records Manager

6
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6.1  System component overview
A Document Manager system consists of:

� Document Manager clients
� Document Manager server and services
� Content repository

Document Manager clients include:

� Document Manager Desktop
� Document Manager Designer
� Document Manager Item Loader

The Document Manager server and services include:

� Document Manager server (also known as Document Manager Library 
Server)

� Cache manager

� Lifecycle service

� Notification service

� Print/plot service

� Rendition service

� Automation service

The Document Manager content repository we cover in this redbook is the 
Content Manager.

The requirements you gather from going through the planning and designing 
exercises help you choose the components to add to your Document Manager 
system. 

If your requirements call for records keeping capability, you need to add Records 
Manager and Content Management Records Enabler (CMRE) to your solution. 
Document Manager and Records Manager have great strength in their flexibility 
in installation and configuration. However, choosing unnecessary components 
can result in wasted resources and decreased performance. Similarly, choosing 
a poor configuration also can have a negative performance consequence.

We discuss Document Manager system configuration with and without records 
management functions, in other words, system configuration with and without 
Records Manager.

Figure 6-1 illustrates the basic system architecture for the end-to-end Document 
Manager solution with Records Manager integrated.
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Figure 6-1   Document Manager system with Records Manager integrated

6.2  System configuration without Records Manager
You can configure Document Manager’s services and components in different 
ways depending on the expected workload, business requirements, and 
available hardware. Although you can install the entire Document Manager 
system with its server and services in one machine, we recommend separating 
each service component in different machines, especially the services that are 
process-intensive, such as the rendition service and the print/plot service. 

In this section, we present three sample system configurations for a Document 
Manager solution without Records Manager:

� All in one server
� Separate Document Manager and Content Manager servers
� Separate Document Manager server and services
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6.2.1  All in one server
In this configuration (see Figure 6-2), you install everything in one server 
(machine). This is easy to install and set up. We recommend this configuration 
for the prototype only. You can also use the configuration for testing and 
development.

Figure 6-2   All in one server without Records Manager

6.2.2  Separate Document Manager and Content Manager servers
In this configuration (see Figure 6-3), we separate the Document Manager server 
and its services from the back-end content repository server (Content Manager). 

Document Manager server constantly services user requests. It is a good 
practice to separate the user processing unit (the Document Manager server) 
from the back-end content processing unit (the Content Manager server).

If you use Content Manager for purposes other than for the Document Manager 
system, this can also be a reason to install Content Manager separately on a 
server (machine) of its own.

Figure 6-3   Separate content repository from the main server

6.2.3  Separate Document Manager server and services
Rendition service is a CPU-intensive process. You may want to install the service 
in a separate machine. The print/plot service is an I/O-intensive process. 
Whenever possible, it is a good practice to separate it from the rest of the 

All in one server

Document Manager server
Document Manager services
Content Manager

Server 1

Document Manager server
Document Manager services

Server 2

Content Manager
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Document Manager server and services. The automation service is also a good 
candidate to install on its own machine.

In the configuration shown in Figure 6-4, the rendition service, the print/plot 
service, and the automation service are installed on their own machines. The rest 
of the Document Manager server and services are installed on one machine, and 
the content repository (Content Manager) is installed on its own machine.

Depending on your system requirements, you may also install the same service 
on different machines. As long as the services point to the same Document 
Manager Library Server, they process different jobs on the same system.

Figure 6-4   Separate DM server and its services

Note: Install Cache service with every machine running any other Document 
Manager service. For the configuration discussed here, you should install 
Cache service on Server 1 through 4.

If you need to install Automated Services, install the Alarm Manager also on 
that server as well as the Cache service. 
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6.3  Configuration with Records Manager
When you records-enabled a Document Manager system, you bring into the 
Document Manager system the Records Manager and the Content Manager 
Records Enabler. 

Records Manager consists of two components: Records Manager database and 
Records Manager server. The basic recommendation for deploying Records 
Manager is that, whenever possible, separate Records Manager database from 
the Records Manager server for good system performance.

In the case study, we use this recommendation and install Records Manager 
server and its database on two separate machines.

Content Manager Records Enabler (CMRE) consists of three servers, the 
Records Enabler Server, the Records Enabler Host Interface Server, and the 
Records Enabler Permissions Synchronization server. These servers may be 
distributed among the WebSphere instances within the Document Manager 
system; however, there is one application, Records Manager Extensions, that 
must be installed on the same WebSphere server as Records Manager.

In this section, similar to the previous section, we present three sample system 
configurations for a Document Manager solution with Records Manager:

� All in one server
� Separate Document Manager and Content Manager servers
� Separate Document Manager server and services

6.3.1  All in one server
In this configuration (see Figure 6-5), everything is installed on one server 
(machine). This is easy to install and set up. We recommend this configuration 
for prototype only. You can also use the configuration for testing and 
development.

Figure 6-5   All in one server with Records Manager

All in one server
Document Manager server
Document Manager services
Content Manager
Records Manager
CM Records Enabler
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6.3.2  Separate Records Manager and content repository
In this configuration (see Figure 6-6), we separate the content repository from 
the main machine. In addition, it also separates the Records Manager and 
Records Enabler from the main machine.

The logic behind this is that, whenever possible, separate the intensive user 
processing unit from the back-end repository unit. Also because the Records 
Manager engine usually reaches its hardware limit first, if the hardware resource 
is available, we recommend moving the Records Manager engine to another 
machine for better and more reliable system performance. In this configuration, 
we recommend putting Records Manager database with Content Manager, and 
Content Manager Records Enabler with the Records Manager engine.

Figure 6-6   Separate Records Manager and content repository

6.3.3  Separate Document Manager server and services
In this configuration (see Figure 6-7), you can further separate the Document 
Manager services, such as rendition service, print/plot service, and automation 
service to separate machines. 

You increase the performance of the main Document Manager system by 
moving the process-intensive and I/O-intensive services onto their own 
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Note: Install the Cache service with every machine running any other 
Document Manager service. For the configuration we discuss here, you 
should install the Cache service on Server 1 through 4.

If you need to install Automated Services, install the Alarm Manager also on 
that server as well as the Cache service. 
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machines. If the hardware resources are available, you can also consider 
separating other services to different machines or having multiple machines 
running the same services.

Figure 6-7   Hardware configuration 3 with Records Manager

Note: As these services are process-intensive, if hardware resource is 
available, we strongly recommend separating these Document Manager 
services in different machines. 
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Chapter 7. Installation and 
configuration

This chapter describes the product installations for the Document Manager 
solution integrated with Records Manager. We provide end-to-end installation 
order and configuration of all the products and their associated fix packs.

We cover the following topics:

� Solution architecture and sequence of the product installation
� Configuration of DB2 Enterprise Edition V8.2
� Configuration of WebSphere V5.1.1
� Configuration of Content Manager V8.3
� Configuration of Information Integrator for Content V8.3
� Configuration of Records Manager V4.1.1 and V4.1.2
� Configuration of CM Records Enabler V8.3
� DM installation and configuration
� Configuration of SMTP Server/e-mail
� Fix packs for various products

Although you can install some of the products on platforms other than Windows, 
we describe the Windows versions only. Any non-standard installation actions 
are documented in the product sections. Viewlets have been provided along with 
this redbook that detail the generic installations of the products.

7
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Important: We strongly recommend that you read thoroughly all product 
installation guides and Readme files before attempting to perform any product 
installation. This chapter does not reiterate the information found in the 
guides. Use this chapter as a complement to the individual product installation 
manual.
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7.1  Solution architecture
There are many ways to configure the Document Manager solution with Records 
Manager as discussed in Chapter 6, “System configuration planning” on 
page 143. One of the most common solution architectures, which we use when 
describing the end-to-end solution installation and configuration, calls for three 
servers, one for Content Manager (server 1), one for Records Manager (server 
2), and the third for Document Manager (server 3). See Figure 7-1.

Figure 7-1   Solution architecture

In our case study, we spread the product installations across multiple servers 
(machines) as in Figure 7-1 to closely simulate a production environment. 
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The solution consists of the following main IBM DB2 Enterprise Content 
Management (ECM) product stack:

� IBM DB2 Document Manager Version 8.3
� IBM Records Manager Version 4.1.2
� IBM DB2 Content Manager Enterprise Edition Version 8.3
� IBM DB2 Content Manager Records Enabler Version 8.3 

WebSphere Application Server is the application server for the Records 
Manager, Records Enabler (CMRE), and Content Manager Resource Manager 
applications. 

The IBM HTTP Server, installed with WebSphere Application Server, serves the 
Web pages for Document Manager and Records Manager. 

Content Manager is the data repository for all the documents and objects 
produced and managed by Document Manager. In our case study, we use a 
generic SMTP Server to allow simple e-mail movement, to demonstrate e-mail 
storage through Document Manager and notifications sent by e-mail. 

CMRE is the means for communication between Content Manager and Records 
Manager. We use its configuration parameters to facilitate auto declares and 
classifies, which map to Quick Declares in Document Manager. 

DB2 runtime and Information Integrator for Content are DB2 and Content 
Manager communication across the servers and clients. 

Figure 7-1, we also show several client system configurations, with various 
product clients and e-mail clients installed. In our case study, we install products, 
both for administrators and for users on separate client machines to mimic a 
production environment.

7.2  Sequence of product installation
The sequence of product installation is especially important when there are 
dependencies, but when none exists between the products we must determine 
the optimal order for installation. 

Often the product installation guides provide direction. For example, the CMRE 
installation guide suggests that, if installing Content Manager on the same server 
with the CMRE extensions, it is best to install Content Manager first. Otherwise, 
a migration step is required to move all the CMRE Extension code into the 
Content Manager working directory. 
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Although there is no strict order of installation sequence, we recommend the 
following product and fix pack installation order for the solution:

1. DB2 Enterprise Edition V8.2

a. DB2 Runtime client V8.3 on remote machines

b. Fix Pack 3 for base and runtimes

2. DB2 Net Search Extender V8.3

a. Fix Pack 2

3. WebSphere Application Server V5.1

a. Fix Pack 1

b. Cumulative plug-in fix 6

4. Content Manager for Multiplatforms V8.3

a. Windows client

5. Information Integrator for Content V8.3

6. Records Manager V4.1.1

a. Fix Pack V4.1.2

7. Content Manager Records Enabler V8.3

a. Records Manager Extensions

8. Fix Pack 1 (V8.3.1) for Content Manager

9. Fix Pack 1 (V8.3.1) for Information Integrator for Content

10.Fix Pack 1 (V4.1.2.1) for Records Manager

11.Fix Pack 1 (V8.3.1) for Windows client

12.Fix Pack 1 (V8.3.1) for CMRE

13.DB2 Document Manager V8.3

14.Fix Pack 1 (8.3.1) for Document Manager

15.SMTP server

16.Clients on remote machines

a. Content Manager fix packs for clients

Your system architecture might differ from the one we show in Figure 7-1. 
Depending on how you distribute your components across multiple machines, 
you can use our recommendation as a guideline to install various components on 
your system. 

Because this solution consists of different components and products, we strongly 
recommend that you make sure a product or a component is installed 
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successfully before moving onto the installation of the next component or product 
or performing any integration.

7.3  Configuration of DB2 Enterprise Edition V8.2
Use the product manual as a detailed guide to install DB2 Enterprise Edition (EE) 
Version 8.2.

For our case study, we use the default options for the installation most of the 
time. We installed a DB2 EE server on one server and installed DB2 runtime on 
the remote servers and clients.

Table 7-1 contains some of the DB2 EE installation options to which you need to 
pay particular attention. We also provide the sample input values we used for 
our case study environment for your reference.

Table 7-1   DB2 EE V8.2 installation options

Once you completed the installation, use the First Steps utility to install the 
sample database as a means to verify that your installation is complete and 
successful. Make sure to connect to the sample database from the DB2 runtime 
clients, and verify their installations.

Use the product manual for installation of DB2 runtime clients. 

For our case study, we use all defaults for the installation.

7.4  Configuration of WebSphere V5.1.1
Use the product manual as a detailed guide to install WebSphere Version 5.1.1.

For our case study, we use the default options for the WebSphere installation 
wherever possible. However, we specified that the IBM HTTP Server should be 
installed.

Installation option Comment/Sample input value

Installation type Typical

Domain name None

User name db2admin (same for all services)

Administration contact Defer

 

 

 

 

156 IBM DB2 Document Manager with IBM Records Manager Solution Guide



Table 7-2 contains the installation options to which you need to pay particular 
attention. We also provide the sample input values we used for our case study 
environment for your reference.

Table 7-2   WebSphere V5.1.1 installation options

Once you complete the installation, go to the First Steps utility, and execute the 
Verify Installation option to ensure that the installation of WebSphere 
completed successfully. 

The installation of Fix Pack 1 requires that you stop WebSphere and all Java 
applications. Verify, in the Windows task manager, that there are no java.exe 
programs running.

Executing the wizard twice will install all the fix packs (cumulative plug-ins are 
considered fix packs).

Installation option Comment/Sample input value

Installation type Custom

Install feature - Application Server 
samples

Unchecked

Install feature - Embedded messaging Default is checked (server and client), this 
is required for Records Manager.

Host name or IP Address This should be the fully qualified host 
name or IP address.

Run WebSphere Application Server as a 
service and Run IBM HTTP Server as a 
service.

Use the default unless you prefer to use 
the command line to start and stop the 
servers.

User ID Specify an administrator ID, we used 
“admin”.

Tip: We found that the most straightforward method of installing the fix packs 
and cumulative plug-in fixes is to first create an update directory under 
c:\program files\websphere\appserver. Then, unzip the fix packs followed 
by the cumulative plug-in fixes into that directory. This creates a complete 
directory structure under update with the fix pack files located in the 
appropriate directories. Invoke updateWizard.bat from this new directory 
structure and the system will automatically detect which fix packs are available 
on the system and install them in the correct order. 
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7.5  Configuration of Content Manager V8.3
Use the product manual as a detailed guide to install Content Manager for 
Multiplatforms Version 8.3. Use the default options for the installation wherever 
possible. 

The installation process has two options, to install Content Manager and to install 
the Content Manager Client for Windows. First choose the Content Manager 
installation. 

For Content Manager installation, we performed a custom installation for our 
case study, which specifies all the options. The custom install allows for 
automatic generation of the SSL and subsequent use of the IBM HTTP Server 
for the browser-based clients.

Table 7-3 contains some of the installation options to which you need to pay 
particular attention. We also provide the sample input values we used for our 
case study environment for your reference.

Table 7-3   Content Manager V8.3 installation options

Note: Ensure that you start WebSphere server before you begin to install the 
Content Manager products.

Installation option Comment/Sample input value

Server Database Type DB2 Universal Database™

Library server database name icmnlsdb

Library server schema name icmadmin

Library server administration ID icmadmin

Library server connection ID icmconct

Enable Unicode Checked (Unicode cannot be enabled 
after installation)

Enable text search Checked

Resource Manager database name rmdb

Resource manager database 
administrator ID

rmadmin

Application server node name Host name of the server where you 
installed WebSphere Application Server 
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During installation, the system checks for the existence of the IDs. If they do not 
exist, the system prompts you for automatic creation.

After the installation is complete, launch the Installation Verification Utility to 
verify the install. Another test of the installation is to invoke the First Steps and 
load some initial sample data.

We defer the installation of the Content Manager Windows client until after the 
Information Integrator for Content installation. This allows the use of the local.ini 
files that are installed with Information Integrator for Content. The Windows client 
installation specifies only the default values.

To verify the installation, invoke the client, add a test document to the Content 
Manager repository, and perform a search on the test document. Make sure you 
can retrieve it and view it.

7.6  Configuration of Information Integrator for Content V8.3
Use the product manual as a detailed guide to install Information Integrator for 
Content V8.3. Use default values whenever applicable.

For our case study, we use the default options for the installation of Information 
Integrator for Content. We are only interested in installing the Content Manager 
V8 connector, so the Setup Type we specify is Connector. 

Table 7-4 contains some of the installation options to which you need to pay 
particular attention. We also provide the sample input values we used for our 
case study environment for your reference.

Resource manager Web application name icmrm

Use and configure IBM HTTP Server SSL Checked

IBM HTTP Server SSL configuration We use values appropriate for our 
location.

Important: It is important to specify the Unicode option at creation time for the 
Library Server, because you cannot enable it later.

Installation option Comment/Sample input value 
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Table 7-4   Information Integrator for Content V8.3 installation options

After the installation is complete, launch the Installation Validation Utility to 
verify the installation.

7.7  Configuration of Records Manager V4.1.1
Make sure your system meets the prerequisites of Records Manager.

Prerequisites for Records Manager
Before you install Records Manager, do the following:

1. Create a non-administrator ID in Windows to use as the database schema 
owner for the Records Manager database. We created an ID called 
irmadmin.

2. Verify that the database manager (DB2) is started.

3. Verify that WebSphere is started.

4. In the WebSphere Administration Console, go to Environment → Manage 
WebSphere Variables. Scroll down and set the 
DB2Universal_JDBC_Driver_Path to the location of the JDBC™ driver in the 
DB2 installation directory. For us, it is C:Program Files\IBM\SQLLIB\java.

The installation of Records Manager is a two part process, one for the engine 
and one for the database. You can install them in any order, but we recommend 
installing the engine first followed by the database.

Installation option Comment/Sample input value

Setup Type Connector
Note, this is all you need for the solution.

Server Connection Selection Content Manager Version 8

System Configuration Files Local

Library server database name icmnlsdb

Library server schema name icmadmin

DB2 Content Manager Version 8 
connection ID

icmconct

Note: If you change the value of the DB2Universal_JDBC_Driver_Path 
variable, you must stop and then restart the WebSphere server.
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Use the product manual as a detailed guide to install Records Manager, and use 
default values whenever applicable. Let the installation do the WebSphere 
deployment and configuration automatically.

Table 7-5 contains the installation options and their values within the engine 
installation.

Table 7-5   Records Manager V4.1.1 engine installation options

For the database installation, use the automatic database creation option.

Note: You should allow the installation to do the deployment and configuration 
unless you have a specific requirement for deployment within WebSphere. 
You must have WebSphere administration knowledge to do the deployment 
yourself.

Installation option Comment/Sample input value

Cell Host name of WebSphere server 
(Server2 - Records Manager)

Node Host name of WebSphere server 
(Server2 - Records Manager)

Server Name of the Application Server defined in 
WebSphere that will contain the Records 
Manager application (server1 - Content 
Manager)

Connection Factories Authentication Leave blank

Mail Transport Host Localhost

Engine Server Name Host name of WebSphere server 
(Server2 - Records Manager)

WebService Node Name Host name of WebSphere server 
(Server2 - Records Manager)

Engine Server Name Host name of WebSphere server 
(Server2 - Records Manager)

Note: You should only use the custom database creation option if you have 
specific DB2 requirements for database creation. This option is for DBAs with 
the knowledge and authority to perform the custom installation.
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Table 7-6 contains the values for the installation options within the database 
installation.

Table 7-6   Records Manager V4.1.1 database installation options

When the installation completes, verify that you have created the database (and 
over 100 tables).

Engine configuration
After you complete the installation process, create a data source using the 
Engine Configuration Utility (Start → Programs → IBM DB2 Records Manager 
V4.1.1 → Engine Configuration).

The Connection Information panel should contain all the correct information that 
was entered in the installation dialog. If not, correct it, and select OK. Highlight 
DB2 in the Data Sources list and invoke Actions → New. 

Table 7-7 contains the values we entered for the New DB2 Data Source.

Table 7-7   Records Manager V4.1.1 engine configuration 

Installation option Comment/Sample input value

JDBC driver class path c:\program files\ibm\sqllib\java

DB2 Node/Instance Name db2

Database Name Any valid DB2 database name (irm41db)

Default Disk c

Folder for Database Containers c:\irmdata

User Name Database schema name (irmadmin)

Sys Admin User Name Database administrator name 
(db2admin)

Database File Plan Population Sample (used only for verification 
purposes)

Data source entry field Comment/Sample input value

Data Source Name Any valid DB2 name (irm41db)

Database Name irm41db

User name Database schema owner (irmadmin)

Test Connection Checked
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After processing, a new entry displays in the data source list. It is important to 
save your changes (File → Save Changes) before exiting the dialog.

In WebSphere, verify that four Records Manager JMS server queues have been 
created and started. Invoke the WebSphere administrator through Start → 
Programs → IBM WebSphere → Application Server v5.1 → Administrative 
Console. No login is required, unless security has been enabled; then 
Servers → Application Servers → Server1 → Server Components → JMS 
Servers. You should see a window similar to the one displayed in Figure 7-2.

Figure 7-2   JMS Server Queues installed by Records Manager

Log out of WebSphere and restart the WebSphere server through Start → 
Programs → IBM WebSphere → Application Server v5.1 → Stop the Server. 
Then start the server through Start → Programs → IBM WebSphere → 
Application Server v5.1 → Start the Server.

Complete the installation verification by invoking the Records Manager 
administrator through Start → Programs → IBM DB2 Records Manager 
V4.1.1 → IRM Administrator. Log on to the administrator using 
Administrator/cronos as the login name/password and invoke Batch 
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Operations from the list on the right side. If the Batch Operations panel displays, 
then verification is complete.

7.8  Configuration of Records Manager V4.1.2
The upgrade of Records Manager V4.1.1 to V4.1.2 is a process similar to the 
base V4.1.1 installation. 

In the V4.1.2 installation directory, invoke the irm412_dbupgrade.bat file, which 
upgrades the database. Next invoke the irm412_engine.bat file, which installs a 
complete engine replacement. Use the same install options you use for the base 
V4.1.1 installation. This creates a new directory during the installation, 
DB2RecordsManager412, which replaces the V4.1.1 directory. You can delete 
the old directory after the installation verification completes.

You must rebind the database packages after installation. Do this by invoking the 
Engine Configuration utility as before. This time just edit the existing data 
source, save, and exit.

Restart the WebSphere server, then verify that you can log on to the Records 
Manager Administrator.

7.8.1  Installation of Fix Pack 1

The installation of Fix Pack 1 for Records Manager follows the same process as 
the V4.1.2 base, except there is a launchpad.bat file that you can invoke to 
provide a GUI interface. Upgrade the database, upgrade the engine, and use the 
same install options as the other installations. Rebind the database packages 
using the Engine Configuration and verify the installation.

7.9  Configuration of CM Records Enabler V8.3
The intent of this section is to complement and not to replace the installation 
manual entitled, IBM DB2 Content Manager Records Enabler V8.3: Installing and 
Configuring, GC18-7570. We expect you to follow the instructions in the product 
installation manual.

Note: Perform the installation of Fix Pack 1 after you install and verify the 
entire Content Manager/Records Manager/CMRE/Document Manager stack. 
Install the fix packs to the various products in the same order as the base 
products.
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There are two separate installation programs that install the Content Manager 
Records Enabler (CMRE) features. One is the Content Manager Records 
Enabler, the other is the Records Manager Extension.

7.9.1  Before installing Content Manager Records Enabler
Here is a checklist of activities you should complete before installing the Content 
Manager Record Enabler:

1. Ensure that your system meets the hardware and software prerequisites.

2. Create an administration ID (cmreid by default). This is the Records Enabler 
connection ID used by CMRE to perform repository functions.

3. Create an administration ID (icmadmin by default).

4. Setup the following system environment variables:

– WAS_HOME

– JDBCPATH

– IBMCMROOT

5. Ensure that the IBM DB2 Information Integrator for Content Manager V8 
Connector is installed.

6. Complete the section “Tips for avoiding installation problems” under the 
section entitled “Performing pre-installation tasks for the Records Enabler 
servers” in IBM DB2 Content Manager Records Enabler V8.3: Installing and 
Configuring, GC18-7570.

Note: CMRE asks for the Content Manager administrator user ID, such as 
ICMADMIN and its password, when you add a new Library Server connection 
to the Records Enabler System. CMRE uses the ICMADMIN ID to create the 
new CMRE connection ID (CMREID) in Content Manager. CMRE does not 
save the ICMADMIN ID and it does not use the ICMADMIN ID again after 
installation.

The CMRE creates the CMREID user ID in Content Manager. CMREID is a 
Content Manager administrator. CMRE saves this user ID in its host 
configuration and uses it to configure the Content Manager host. For example, 
CMRE uses the CMREID ID to create the necessary item types, privilege sets, 
and ACLs during the installation process. The CMREID is also stored in the 
WebSphere Data Source. This user ID is used to add and remove triggers to 
the records-enabled item types. The CMREID should not be imported into 
Records Manager. It is meant to be used under the covers by the CMRE code.
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7.9.2  Before installing Records Manager Extensions
Here is a checklist of activities you should complete before installing the Records 
Manager Extensions:

1. Ensure that your system meets the hardware and software prerequisites.

2. You have installed the Records Enabler Permissions Synchronization server 
by going through the Content Manager Records Enabler installation program.

3. Ensure that you have set up the environment variable, WAS_HOME.

4. You have completed the section on “Tips for avoiding installation problems” 
under the section entitled “Performing pre-installation tasks for the Records 
Manager Extensions” in IBM DB2 Content Manager Records Enabler V8.3: 
Installing and Configuring, GC18-7570.

7.9.3  Installing Records Enabler on Windows
When you start the IBM DB2 Content Manager Records Enabler (CMRE) 
Installation Launchpad, you will be presented with two installation choices as 
shown in Figure 7-3.

Figure 7-3   Content Manager Records Enabler Installation Launchpad
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The Content Manager Records Enabler installs the following Records Enabler 
features:

� Records Enabler Server (cmresvr)
� Records Enabler Host Interface Server (rmecmhost)
� Records Enabler Permission Synchronization Server (cmrepsproc)

The Records Manager Extensions installs cmrepsnotifer.

Installing the Content Manager Records Enabler
Select the Content Manager Records Enabler radio button to install the Records 
Enabler Server, the Records Enabler Host Interface Server, and the Records 
Enabler Permission Synchronization Server. Follow the instructions in the 
installation windows. The Records Enabler installs in the IBM Content Manager 
installation directory. By default, it is C:\Program Files\IBM\db2cmv8.

Follow the instructions in the installation windows. We capture shots of those 
screens that contain important installation parameters.

Figure 7-4 shows the selection window for the Content Manager Records 
Enabler features. Choose the features you want to install. You can install all three 
features in the same server or distribute them across multiple servers. In our 
demonstration system, we install all three features into the same server.

Figure 7-4   Select the features for Content Manager Records Enabler V8.3
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Figure 7-5 shows the WebSphere Application Server deployment information 
window. Enter the WebSphere Application Server deployment information. We 
do not enable WebSphere Application Server security, so that option is left blank.

. 

Figure 7-5   WebSphere Application Server Deployment Information

Figure 7-6 and Figure 7-7 show the Records Manager information windows. 
Enter the appropriate values for your system.
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Figure 7-6   Records Manager Information part 1

Figure 7-7   Records Manager Information part 2

Figure 7-8 shows the Content Manager v8 Server Connection information 
window. Enter the appropriate values for your system.

 

 

 

 

 Chapter 7. Installation and configuration 169



Figure 7-8   Content Manager v8 Server Connection information part 1

Figure 7-9 shows the window that prompts you for the eClient information. We 
did not have eClient in our demonstration system. Accept the default values 
assigned by the installation program if you do not use eClient in your system.

Figure 7-9   Content Manager v8 Server Connection information part 2
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Figure 7-10 shows the window that prompts you to select the database 
management system on which you install the Content Manager.

Figure 7-10   Database management choice

Figure 7-11 shows the window that prompts you to enter the Records Enabler 
server name. We accept the default value.
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Figure 7-11   Records Enabler server name

Figure 7-12 shows the window that prompts you to enter the Records Manager 
Host Interface server name. We accept the default value.

Figure 7-12   Records Manager Host Interface server name
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Figure 7-13 shows the window that prompts you to enter the Records Enabler 
Permissions Synchronization server name. We accept the default value.

Figure 7-13   Records Enabler Permissions Synchronization server

Figure 7-14 shows the installation summary window. Click Next to have the 
installation program install the selected features to your system.
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Figure 7-14   Installation summary window

After the Content Manager Records Enabler installation finishes, the installation 
program returns to the Launchpad window. You can exit the Launchpad or 
choose to continue with installing the Records Manager Extension. 

Installing the Records Manager Extension
The Records Manager Extension must be installed on the Records Manager 
server. In our demonstration system, the Records Enabler and Records Manager 
share the same server. We continue with installing the Records Manager 
Extension after the Content Manager Records Enabler installation completes. 
See Figure 7-15.
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Figure 7-15   The Records Enabler installation launchpad

Figure 7-16 shows the installation destination window. Follow the 
recommendation by the CMRE installation guide, install the Information 
Integrator for Content before installing the Records Manager Extension. As a 
result, the CMRE installation program automatically detects the Content 
Manager working directory and uses that as its installation destination.
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Figure 7-16   The installation destination information window

Figure 7-17 shows the WebSphere Application Server deployment information 
window. If you choose not to enable the WebSphere Application Server security, 
leave this option blank. In our demonstration system, we leave the option blank.

Figure 7-17   WebSphere Application Server Deployment Information 
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Figure 7-18 shows the Records Manager Information window which prompts you 
to enter the Records Manager application server name. We accept the default 
value since this is where the Records Manager applications are deployed.

Figure 7-18   The Records Manager Information window

Figure 7-19 shows the installation information summary window. Click Next to 
have the installation program install the Records Manager Extension to your 
server.
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Figure 7-19   The installation summary information window

Installation verification
To verify you have installed and deployed the Records Enabler and its features 
successfully, follow the instructions in the section entitled “Verifying Records 
Enabler installation and configuration” in IBM DB2 Content Manager Records 
Enabler V8.3: Installing and Configuring, GC18-7570.

7.9.4  Records Enabler post-installation tasks
If you follow 7.2, “Sequence of product installation” on page 154, you have 
installed by this point all the software listed in items 1 to 7. We recommend that 
before continuing to install the rest of the software stacks, you configure Content 
Manager, Records Manager, and CMRE so that you can perform record 
declaration and classification using the Content Manager Window Client.

If you encounter problems with performing record declaration using Content 
Manager Window Client, it is better to discover the problem now rather than after 
you install all the software stacks. 
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Before you can use the Content Manager Window Client to declare and classify 
records, perform the following tasks:

1. Set up a file plan in Records Manager.

2. Import a Content Manager user into Records Manager and grant the user 
function access and permission to perform record declaration and 
classification. This Content Manager user should not have ItemSuperAccess 
privilege in its privilege set.

3. Create an eRecords-enabled Content Manager item type.

4. Map Content Manager attributes to Records Manager attributes.

5. Define the default classification.

Before continuing, make sure the following WebSphere Application Servers are 
started:

� icmrm
� server1
� cmresvr
� rmecmhost
� cmrepsproc

Set up a file plan in Records Manager
When we install the Records Manager, we select to install the default file plan. 
Therefore, a file plan is available for us to use. Figure 7-20 shows a view of the 
default file plan. If you do not have a file plan in the Records Manager system, 
you must create one.

Important: In our setup, we were unable to successfully import users into 
Records Manager. The embedded messaging component was not functioning 
properly. Our Records Manager server did not have a static IP address and 
the DNS returned a host name that was different from the computer name. To 
recover, we had to uninstall CMRE, Records Manager, and WebSphere 
Application Server. We assigned a static IP address to the server, set up the 
server to not use DNS, and reinstalled WebSphere Application Server, 
Records Manager, and CMRE.

Note: Use any of the CMRE-supported clients to test the declare and classify 
setup. We chose Content Manager Window Client.
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Figure 7-20   Default file plan

When you configure CMRE to do manual declaration, it asks you to provide the 
name of a Set view. If your file plan does not have a Set view, you need to create 
one. We create a Set view because the default file plan does not have a view of 
type Set. CMRE use the Set view to manage versions. We call the Set view that 
we create, CMRESET, see Figure 7-21.

Refer to Records Manager Records Administrator’s Guide, SC18-9180, for a 
detailed instruction about how to create a file plan and a Set view.

You can also follow the case study implementation from Chapter 8, “Basic 
Document Manager implementation” on page 239 to Chapter 11, “Other record 
declaration options in Document Manager solution” on page 399 to learn how to 
create them.
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.

Figure 7-21   File plan views

Set up a Content Manager user in Records Manager
You need to import a Content Manager user into Records Manager and grant the 
user function access and permission to perform record declaration and 
classification. This Content Manager user should not have the ItemSuperAccess 
privilege in its privilege set.

Refer to the Records Manager Records Administrator’s Guide, SC18-9180, for 
detailed instructions about how to import a user and grant the user function 
access and system permission.

.

Note: The instruction about how to import a host user does not mention that 
you need to select the Is Active check box. However, you must to select the 
Is Active check box; otherwise, the user cannot perform the records function.
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We created the user ID, RMETUSER. We assigned to RMETUSER the 
RMEClientAllPrivs privilege set and the RMEClientACL as its ACL. We added 
the RMETUSER and RMEClientAllPrivs pair to the PublicReadACL ACL. We 
imported the RMETUSER to Records Manager.

Create an eRecords-enabled Content Manager item type
For testing purposes, we created a simple item type in Content Manager. We call 
it CMTestItemType. Table 7-8 shows the properties of CMTestItemType.

Table 7-8   CMTestItemType properties

Steps to eRecords-enable CMTestItemType:

1. Log on to the Records Enabler Administrative Client as rmeadmin.

Tabs Properties

Definition item type classification: Document

Access Control ACL: PublicReadACL

Attributes SSName

Document Management ICMBASE:
� ACL: PublicReadACL
� Records Manager: rmdb
� Collection: CBR.CLLCT001
� Version: Never create
ICMBASETEXT:
� ACL: PublicReadACL
� Records Manager: rmdb
� Collection: CBR.CLLCT001
� Version: Never create
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2. Select the eRecord enable Item Type link.

3. Under the column Select, click the check box next to the item type you want 
to eRecords-enable.

In our system, it is CMTestItemType.

4. Under the column Record Type, click the pull-down list and select the record 
type.

In our system, it is Document.

5. Click Enable.

CMRE adds the following attributes to the item type after it eRecords-enables the 
item type:

eRecord
eRecordID
FlPlnCmpntNm (display name = Document Name)
FlPlnCmpntTtl (display name = Subject)
RMEAclOri

Map CM attributes to Records Manager attributes
After you eRecords-enable the item type, map the attributes of the Content 
Manager item type to the Records Manager record type. CMRE uses the 
attribute mapping information to know which attributes from the Content Manager 

Note: We recommend that you create a Content Manager user ID that has 
the following characteristics to use as the user ID for logging into the 
CMRE Administration Client to perform the various CMRE administrative 
tasks:

� This Content Manager user ID does not need any explicit Content 
Manager permissions.

� Assign to this user ID the privilege set NoPrivs and the ACL 
NoAccessACL.

When this user logs into the CMRE Administration Client, the CMREID 
user ID will be used under the covers to perform any necessary Content 
Manager configurations. After you create this user, you need to import it 
into Records Manager and give it the System Configuration Management 
function access. This user does not require any other Records Manager 
permissions to use the CMRE Administration Client.

In our solution, we create the Content Manager user ID, RMEADMIN, for 
this purpose.

 

 

 

 

 Chapter 7. Installation and configuration 183



item type to copy into which attributes in Records Manager when it performs 
record declaration and classification.

In our demonstration system, for CMTestItemType, we map:

� Content Manager attribute FlPlnCmpntNm to Records Manager’s Document 
record attribute Document Name.

� Content Manager attribute FlPlnCmpntTtl to Records Manager’s Document 
record attribute Document Title.

Steps to map the Content Manager attributes to Records Manager attributes:

1. Log on to the Records Enabler Administrative Client as rmeadmin.

2. Select the Attribute Mapping link.

3. Select the Record type from the drop-down list.

In our system, we select Document.

4. Select Add Mapping.

5. In the Content Manager attribute name, select the Content Manager attribute 
you want to map.

In our system, we select Document Name which is the display name of 
FlPlnCmpntNm.

6. Select Map.

7. In the Records Manager attribute name, select the Records Manager 
attribute.

8. Select Map.

9. Repeat steps 2 to 8 until you finish mapping all the attributes you want to 
map.

Define the default classification
To enable manual record declaration and classification, complete the CMRE 
manual record declaration and classification configuration.

Steps to configure the CMRE manual record declaration and classification:

1. Log on to the Records Enabler Administrative Client as rmeadmin.

2. Select the Manual Declare and Classify Configuration link.

3. On the pull-down list next to Should classification be filled in 
automatically? 

Select Yes if you want the auto-classification rules to be executed. This can 
result in a set of candidates for classification which are listed in the 
classification field on the manual declare window. If no candidates are 
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identified, there will be nothing listed in the classification field, unless a default 
classification is specified. Select No if you require the user to provide the 
classification.

In our system, we select Yes.

4. On the pull-down list next to Version View Name select the Set view name 
that you have defined.

In our system, we select CMRESET.

5. Select Save.

To enable automatic declaration and classification, complete the CMRE auto 
declare and classify configuration.

Steps to configure the CMRE auto declare and classify configuration:

1. Log on to the Records Enabler Administrative Client as rmeadmin.

2. Select the Auto Declare and Classify Configuration link.

3. Fill in the choices. In our system, Table 7-9 shows the values we use.

Table 7-9   Parameters for auto declare and classify configuration

4. Click Save.

Parameters Values

If no possible candidates Use default classification.

More than one possible candidate Use default classification.

More than one with the same highest 
weight:

Use default classification.

Default classification: //File Plan/File

Default record type Document

Polling interval 600
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Verifying record declaration using CM Windows client
After you have completed the tasks laid out above, you are now ready to verify 
record declaration using the Content Manager Window Client. 

Steps for manually declaring an item as a record:

1. Log on to Content Manager Window Client as the user you have imported into 
Records Manager.

In our system, the user is RMETUSER.

2. Use the import command to add a few records into the item type that you 
have eRecords-enabled.

In our system, the item type is CMTestItemType.

We mapped the attributes Document Name and Subject. During the import, 
we enter values for these two attributes.

3. Do a basic search to get a result list of records that you have added to the 
eRecords-enabled item type.

4. Select a record.

5. Right-click and select Declare Record.

6. The Records Manager manual declare window appears. In our system, the 
only required field is Document Name. It is pre-filled with the value from the 

Note: Polling interval means the number of seconds between checking for the 
next available item in the automatic classify queue. For example, in Document 
Manager, if you select to do Quick Declare with automation (not By Selection 
or By Properties), the system adds an entry into the automatic classify queue. 
The document does not get declared as a record right away, it gets declared 
when the process that handles the auto-classification runs. The polling interval 
determines the frequency at which the auto declare process runs. When the 
auto declare process runs, it declares and classifies the document. One way 
to know that the document is successfully declared as a record is if you see 
the padlock icon next to the document when you view it through the Document 
Manager Desktop, or if you see the document appear in the classification path 
through the Records Manager Administrative Client. If you do not see the 
expected result and the elapsed time is much longer than the value set for the 
polling interval, then you need to troubleshoot the problem by checking the 
various log files.

There are multiple indicators on the Document Manager Desktop to show that 
a document has been declared, such as the padlock icon. You must activate 
the padlock icon before it will display.
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Document Name attribute of the CMTestItemType because of the mapping 
that we set up earlier.

7. Click Finish.

If the record is declared successfully, the isRecord attribute contains the value 
yes and the RecordID attribute contains a record ID assigned by Records 
Manager.

Congratulations! You have successfully installed and configured Content 
Manager, Records Manager, and RME for records declaration and classification.

7.10  Fix pack installation 
This section covers Fix Pack 1 installation for CM V8.3, Information Integrator for 
Content V8.3, Records Manager V4.1.2, and CMRE V8.3. The installation is 
relatively straightforward. 

Server 1 (Content Manager)
Install the fix pack in the following order:

1. Follow the Content Manager V8.3 Fix Pack 1 Readme file to install Fix Pack 1 
for Content Manager V8.3.

2. Follow the Content Manager V8.3 Client for Windows Fix Pack 1 Readme file 
to install the Fix Pack 1 for the Content Manager Client for Windows.

Server 2 (Records Manager)
Install the fix pack in the following order:

1. Follow the Content Manager V8.3 Fix Pack 1 Readme file to install Fix Pack 1 
for Information Integrator for Content V8.3.

2. Follow the Records Manager V4.1.2.100 Installation Guide to install Records 
Manager V4.1.2 Fix Pack 1.

Note: When we install the Records Manager, we choose to install the default 
file plan and we use the Records Manager default file plan to perform a quick 
verification test against Content Manager, Records Manager, and RME. 
However, when we start to implement our solution, we choose to delete the 
default Records Manager file plan. In other parts of this redbook when we 
describe our solution, you see us refer to different parameter values. For 
example, for our solution, the Default classification parameter in Table 7-9 on 
page 185 is //ZXY Technologies/Default/Unclassified Proposals and not 
//File Plan/File.
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3. Follow the Content Manager Records Enabler V8.3 Fix Pack 1 Readme to 
install the CMRE V8.3 Fix Pack 1.

7.11  DM installation and configuration 
In this section, we discuss installation and configuration of Document Manager.

7.11.1  Before installation
Before installing Document Manager, make sure you install the prerequisites.

Optional software prerequisites
We recommend that you have Content Manager Windows Client installed and 
fully operational in the machine that you intend to install Document Manager for 
Content Manager Library Server and Resource Manager connection verification 
purposes.

In this case, you should install the following components:

� DB2 Runtime Client V8.2 Fix Pack 10
� Content Manager Windows Client V8.3 Fix Pack 1

To verify it is fully operational, log in as Content Manager administrator user (by 
default, it is icmadmin) and load an image into the NOINDEX Item Type, then, 
make a search of that image and open it with the default Content Manager 
viewer.

Document Manager software prerequisites
Before installing Document Manager, ensure you installed the following 
components and they run properly:

1. In order to install Document Manager, you must have a content repository 
installed in the same, or different machines, such as Content Manager V8.3 
Fix Pack 1 server.

2. For Document Manager server connection to Content Manager server, you 
must have a Information Integrator for Content V8.3 Fix Pack 1, Content 
Manager V8 Connector installed in the same machine where you install 
Document Manager.

3. For Document Manager Desktop client deployment, you must have an HTTP 
Server installed in the same, or different machine such as the IBM HTTP 
Server V6.0.

4. Document Manager must be installed in a Windows 2000 Server SP 4 or 
further or Windows 2003 Server.
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Preconfiguration in Content Manager
Before installing Document Manager, complete certain Content Manager 
configuration steps:

1. First, create a Content Manager user called DDMService using the Content 
Manager Administration Client under Authentication → Users, and assign it 
the following configuration:

– Password never expires
– SysAdminSuper Privilege Set
– SuperUser ACL

2. Within the Content Manager Administration Client, under Data Modeling → 
Attributes section, create the following attributes (Table 7-10). 

Table 7-10   Document Manager system attributes

Note: We strongly recommend you read the Document Manager product 
documentation, such as Readme files, to check for any change or additional 
prerequisite necessary before installation.

Name Display name Min Max Type

DM_Class Class 0 32 Extended Alphanumeric/ 
Variable Character

DM_State State 0 32 Extended Alphanumeric/ 
Variable Character

DM_Revision Revision 0 12 Extended Alphanumeric/ 
Variable Character

DM_Properties Properties 0 8 Extended Alphanumeric/ 
Variable Character

DM_Number Unique 
Number

0 12 Extended Alphanumeric/ 
Variable Character

DM_Date Date Date

FileName FileName 0 256 Extended Alphanumeric/ 
Variable Character

 

 

 

 

 Chapter 7. Installation and configuration 189



7.11.2  Document Manager installation
To install Document Manager, use the following steps:

1. In the Document Manager server machine, open the Windows Computer 
Management program, go to the System Tools → Users folder and 
right-click the right panel to select New User as shown in Figure 7-22.

Figure 7-22   Windows Computer Management application

2. In the new window, create a user called DDMService and be sure you use the 
same password that you used in “Preconfiguration in Content Manager” on 
page 189 and check the box next to Password never expires as shown in 
Figure 7-23. When you finish, click Create.
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Figure 7-23   Creating DDMService user

3. Back in the Windows Computer Management program, in the right pane, 
double-click DDMService user, select Member Of tab in the new window and 
click Add and add it to the Administrators user group as shown in 
Figure 7-24.

Figure 7-24   Adding DDMService user to Windows Administrators user group
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4. Now, open the Local Security Settings Windows program, and go to 
Security Settings → Local Policies → User Rights Assignment as shown 
in Figure 7-25.

Figure 7-25   Windows Local Security Settings application

5. Then, double-click in the following policies and add DDMService user to 
these policies, using Add as shown in Figure 7-26.

� Act as part of the operating system.
� Create a token object.
� Increase memory quotas for a process.
� Replace a process-level token.
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Figure 7-26   Adding DDMService user 

6. Now you can start with the Document Manager Server installation by 
double-clicking the DB2 Document Manager installation application. When 
prompted for Choose Setup Language, select the default language (English) 
as shown in Figure 7-27 and click OK.

Figure 7-27   Document Manager language selection window

7. In the next window, click Next, as shown in Figure 7-28.

Tip: In case you installed Content Manager Windows Client, use DDMService 
user to log on to it and verify you can connect, add, and open images from and 
to the Content Manager repository.
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Figure 7-28   Document Manager welcome window

8. Accept the license agreement as shown in Figure 7-29 and click Next.

Figure 7-29   Document Manager License Agreement window

9. Leave the default installation directory as shown in Figure 7-30 and click 
Next.
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Figure 7-30   Document Manager installation path window

10.In the following window, be sure to select all components to install as shown 
in Figure 7-31 and click Next.

Figure 7-31   Document Manager component selection window

11.Now click Install as shown in Figure 7-32.
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Figure 7-32   Document Manager start installation window

12.When the installation process finishes, click Finish as shown in Figure 7-33.

Figure 7-33   Document Manager finish installation window

Note: Although we selected all the Document Manager components to install, 
SOAP support, configuration, and some Additional Managers (Document 
Manager Services) are beyond the scope of this IBM Redbook.
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13.Once the Document Manager server installation process finishes, go to the 
Document Manager installation directory (for example: C:\Program Files\DB2 
Document Manager), open the file DdmCaSrv.ini in a text editor like Windows 
Notepad text editor and configure it as in Example 7-1(to achieve this, you 
can copy the section [Library_Sample CM] in the same file, and uncomment 
the lines by deleting all the semicolons).

Example 7-1   DdmCaSrv.ini file configuration

[LibraryGroups]
Group0=Default

[LibraryGroup_Default]
Library0=DMLibrary

[Library_ DMLibrary]
LibraryName= DMLibrary
LibraryType=ContentMgr
GPSLibraryMachine=KCWC09K
GPSLibrarySOAPServerURL=
AutoLogin=Yes                      <- Forced to No by Cache Service.
AllowNetworkLogin=No              <- Not used by Desktop.
Disabled=No                       <- Forced to No by Cache Service.
EnableLogging=Yes
EnableVerboseLogging=No
LibrarySystem=icmnlsdb
GPSClientCacheMachine=
GPSLibraryServerCacheMachine=
SaveLogin=No                      <- Forced to No by Cache Service.
MaxLogFileSizeInK=64
SSOCredentialsURL=

14.Now, open the Document Manager Designer shown in Figure 7-34.

Tip: The only fields you must change according to your own environment are:

� Library0: This can be any name you want.
� Library_: This is the same as Library0.
� LibraryName: The is the same as Library0.
� GPSLibraryMachine: This is the host name of the server machine.
� LibrarySystem: This is the Content Manager Library Server database 

name.
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Figure 7-34   Document Manager Designer window

15.Click Libraries and in the new window, click Add to configure a new library 
as shown in Figure 7-35.

Figure 7-35   Document Manager libraries configuration window

16.In the new window, configure the fields as shown in Figure 7-36 and when 
finished, click OK.
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Figure 7-36   Document Manager Library Configuration window

17.In the Library List Configuration window in Figure 7-37, you should see the 
values you configured and click OK to exit.

Figure 7-37   Document Manager libraries configuration window

18.Now, in the IBM DB2 Document Manager Designer window, you should see 
a new folder called your library name with other tree folders under it as shown 
in Figure 7-38.

 

 

 

 

 Chapter 7. Installation and configuration 199



Figure 7-38   Document Manager Designer window with a configured library

19.Go to Library → Global → Desktop, right-click Library Configuration and 
select Modify as shown in Figure 7-39.
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Figure 7-39   Document Manager library configuration parameters

20.In the new window, under the Properties tab, configure the following fields as 
shown in Figure 7-40.
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Figure 7-40   Library general configuration tab

21.Go to Library Checks tab and verify you have the same values as in 
Figure 7-41.
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Figure 7-41   Library checks configuration tab

22.In the System Account tab, capture the user name DDMService and its 
password as shown in Figure 7-42.

 

 

 

 

 Chapter 7. Installation and configuration 203



Figure 7-42   Library system account configuration tab

� Under the Login Security tab, verify you have everything unchecked as 
shown in Figure 7-43.
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Figure 7-43   Library login security configuration tab

23.Finally, in the Records Management tab, you do not need to enter anything 
as shown in Figure 7-44. Click OK to exit.
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Figure 7-44   Library records manager configuration tab

Important: The Library Configuration for Records Manager can appear 
disabled if you have not completed the Records Manager configuration step. 
Once it is finished, Document Manager automatically takes that configuration 
and you see it in Document Manager as shown in Figure 7-45 and 
Figure 7-46.
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Figure 7-45   Library record indicator field in properties tab

Figure 7-46   Library records manager configuration fields tab
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24.Now, open the Document Manager Service Manager application as shown in 
Figure 7-47.

Figure 7-47   DM Service Manager window

25.Double-click IBM DB2 DM Alarm Manager service and click Add as shown 
in Figure 7-48.

Figure 7-48   Alarm Manager configuration window

26.In the new window, configure the fields as shown in Figure 7-49 and click OK 
when finished.
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Figure 7-49   Alarm Manager configuration parameters window

27.You should now have the IBM DB2 DM Alarm Manager Properties window 
with the values you specified as shown in Figure 7-50. Click OK to exit this 
window.

Figure 7-50   Alarm Manager configuration window with service configured

28.Now double-click IBM DB2 DM Cache Manager service as shown in 
Figure 7-51.
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Figure 7-51   Document Manager Service Manager window

29.In the new window, click Add as shown in Figure 7-52 to configure this 
service.

Figure 7-52   Cache Manager configuration window

30.Configure the fields as shown in Figure 7-53 and click OK when finish.
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Figure 7-53   Cache Manager configuration parameters window

31.In Figure 7-54, the IBM DB2 DM Cache Manager Properties window 
displays the values you specified. Click OK to exit this window.

Figure 7-54   Cache Manager Configuration window with service configured

Note: We only show configuration steps for the Alarm Manager and Cache 
Manager services; nevertheless, the configuration for all the remaining 
services is the same as shown here and must be configured in the same way.
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7.11.3  Post-installation steps for Document Manager server
After successfully performing the installation steps of Document Manager server, 
you need to install Document Manager Fix Pack 1. In order to install the 
Document Manager Fix Pack 1, follow this steps:

1. Follow the Content Manager V8.3 Fix Pack 1 Readme file to install Fix Pack 1 
for Information Integrator for Content V8.3.

2. Verify that all Document Manager server services are stopped by opening the 
Document Manager Service Manager application and check that all services 
are in the Stopped state as shown in Figure 7-55.

Figure 7-55   Document Manager Service Manager

3. Execute the Document Manager Fix Pack 1 installation package and follow 
the installation wizard. The fix pack installation is pretty much the same as 
installing the product for the first time so you only need to accept all the 
default values.

4. After installing Fix Pack 1, verify that each Document Manager service is 
functioning correctly by executing each one with the green arrow start button 
in the Document Manager Service Manager application control panel. When 
you see any of the following messages, it means that the service is 
connecting to the library and working properly (Figure 7-56):

– Process cycle complete.
– Cache update finished.
– Number of pending requests is [0].

Note: Be sure to read the Readme Fix Pack 1.txt file of the Document 
Manager Fix Pack 1 installation package before installing it to be aware of any 
additional considerations and fixes provided by this fix pack.
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Figure 7-56   Document Manager alarm manager service

7.11.4  Separate Document Manager services to other machines
If resources are available, we recommend separating Document Manager 
services, especially the services which consume a lot of CPU and memory 
resources, such as Print/Plot and Rendition services, to other machines.

In this section, we explain how to install and configure a Document Manager 
Rendition service in a separate machine. The installation procedure for a service 
is the same as the normal Document Manager server installation. Here, we only 
point to the specific steps to install and configure the service. To separate other 
services in another machine, use the process described here, which is similar.

Installing Rendition service in a separate machine
To install the Rendition service in a separate machine, use the following steps:

1. Use the same Document Manager installation program to install the rendition 
service in a separate server.

2. When you get to the window where you select the components to install, 
select for each component, the This feature will not be available option, by 
clicking each component, except Cache Manager, Service Manager, and 
Rendition Manager, which are under the Additional Managers component. 
All these components must be selected using the option This feature will be 
installed on local hard drive while clicking the component as shown in  
Figure 7-57. After this, click Next.
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Figure 7-57   DM service components installation in a different machine

3. Click Install and when the installation procedure finishes, click Finish to exit 
the installation wizard window.

4. Now, go to Start → Programs → IBM DB2 Document Manager → Service 
Manager as shown in Figure 7-58.

Tip: You are required to install the Service Manager component. For the best 
system performance, we recommend you also install the Local Cache 
Manager (even though it is optional) so that the local service will not need to 
connect to the remote Cache Manager every time it needs a server 
configuration.

Note: After installing the Document Manager service program in the new 
machine, do not forget to install the same fix pack level that is in the Document 
Manager server system.
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Figure 7-58   Service Manager application

5. Double-click IBM DB2 DM Cache Manager service to open the cache 
manager properties window and click Add to configure a new cache manager 
service. Configure the field with the information of your Document Manager 
server as shown in Figure 7-59. After you finish, click OK to exit the 
configuration window.

Figure 7-59   Cache manager configuration

Note: The Name field is the library name you configure in the Document 
Manager server and the Library server field is the host name of the 
Document Manager server machine.
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6. Click OK to exit the configuration window and verify that the information you 
enter is the same as that shown in the properties window in Figure 7-60. Then 
click OK again to exit the DM Cache Manager Properties window.

Figure 7-60   Cache Manager Properties window

7. Verify that the cache service works correctly by starting it with the green 
triangle icon in the Service Manager tool bar. If you see a message such as 
the last one shown in Figure 7-61, the configuration is successful.

Figure 7-61   Successful service installation

8. Now, double-click IBM DB2 DM Rendition Services as shown in 
Figure 7-62.
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Figure 7-62   Service Manager application

9. Click Add to configure a new rendition service with the information shown in 
Figure 7-63. In the Name field, specify the Document Manager library name. 
In the Library server field, specify the server name where the Document 
Manager library is installed. In the Cache server field, specify the host name 
of the machine where you are installing the rendition service.

Figure 7-63   Remote rendition service configuration

Note: The Name field is the library name you configure in the Document 
Manager server, the Library server field is the host name of the Document 
Manager server machine, and the Cache server field is the host name of the 
local machine where you are installing the service.
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10.If you already have rendition queues configured in the Document Manager 
Designer, you can click Advance to open the window where you configure 
the queues you want to process in this new rendition server (Figure 7-64). By 
highlighting the queue name, select Yes (to process that queue) or No (to not 
to process that queue), and click Set to apply the changes you configure the 
queues you want to process with this service. After this finishes, click OK to 
exit the Advance window configuration.

Figure 7-64   Advance service configuration window

11.Click OK to exit the configuration window and verify that the information you 
enter is the same as shown in the properties window (Figure 7-65). Then click 
OK again to exit the DM Rendition Services Properties window.

Figure 7-65   DM Rendtion Services Properties window
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12.Verify that the rendition service works properly by starting it with the green 
triangle icon in the Service Manager tool bar. If you see the message 
Number of pending requests is [0] as in Figure 7-66, then the service is 
configured correctly.

Figure 7-66   Remote rendition service successfully configured

7.11.5  Document Manager Desktop client installation
Document Manager Desktop client is a ActiveX® control application that is 
hosted by a Microsoft Internet Explorer browser. An HTTP server is needed to 
download and access the Desktop client. Once the client is loaded, it creates a 
DCOM connection to the Document Manager server, and the HTTP server is no 
longer needed to run the desktop. 

This architecture enables a fast client deployment and eases maintenance 
procedures, because you only need to access a URL to launch the client 
application. When there is an update for the client, you only copy the new client 
files to the HTTP server virtual directory, and when the user accesses the 
Desktop client’s URL, this downloads the new files and installs them 
automatically in the client machine. In addition, this architecture uses fewer 
communication resources and reduces network traffic, because Desktop client is 
a stateless Web application. Each time the client needs to communicate with the 
server, it connects to the server.

Tip: Configuring Document Manager services in different machines helps the 
general system performance, because Document Manager server is not 
overloaded with services processing. Besides, with this configuration, you can 
specify which machine processes which services queue.
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HTTP server setup
Depending on the HTTP server you are using, you follow different procedures to 
create new virtual directories. In our case, we used IBM HTTP Server V6.0, so 
we used the following steps:

1. Go to the IBM HTTP Server installation directory, which by default is 
C:\Program Files\IBM HTTP Server, and under htdocs\en_US directory, 
create a new folder called DM.

2. Now, go to the IBM DB2 Document Manager server installation directory, 
which by default is C:\Program Files\IBM\DB2 Document Manager, and select 
and copy the following files as shown in Figure 7-67:

default.htm
ddmdsktp.htm
ddmdsktop.cab
ddminst.htm
ddmdsktp.js

Figure 7-67   Document Manager Desktop client installation files

3. Paste the files to the DM directory you create in step 1 and rename the 
default.htm file to index.html as shown in Figure 7-68:
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Figure 7-68   IBM HTTP server virtual directory

Document Manager Desktop client installation procedure
To install the Document Manager Desktop client, use the following procedure:

1. Open a Microsoft Internet Explorer window and enter the URL to the virtual 
directory you created in Step 1 of the previous section as shown in 
Figure 7-69. Remember to replace the kcwc09 server name with your HTTP 
server host name. The first time you enter this URL, the Desktop client 
installation procedure will automatically download the required files to the 
client machine and launch the installation wizard.

Note: If you are using the IBM HTTP Server or an Apache-like HTTP 
server, changing the default.htm file name to index.html enables you to 
reference the Document Manager Client URL as:

http://kcwb99n/DM 

Otherwise, enter the URL as:

http://kcwb99n/DM/default.htm
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http://kcwb99n/DM/default.htm
http://kcwb99n/DM


Figure 7-69   IBM HTTP server welcome window

2. If a Security Window prompts you as shown in Figure 7-70, just click Yes and 
continue with the Desktop client installation process.

Figure 7-70   Security warning window
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3. In the License Agreement window, accept the agreement and click Next as 
shown in Figure 7-71.

Figure 7-71   Document Manager Desktop license agreement window

4. In Choose Setup Language window, select English and click OK as shown 
in Figure 7-72.

Figure 7-72   Document Manager Desktop language selection window

5. In the welcome window, click Next as shown in Figure 7-73.
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Figure 7-73   Document Manager Desktop welcome window

6. In the Destination Folder window, accept the default installation path and 
click Next as shown in Figure 7-74.

Figure 7-74   Document Manager Desktop installation path window

Important: When installing the Desktop client in a Document Manager server, 
be sure that the installation path of the Desktop is the same as that of the 
Document Manager server installation path. If not, problems can occur in 
Document Manager operation.
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7. Now select all the components to install as shown in Figure 7-75, and click 
Next.

Figure 7-75   Document Manager Desktop components selection window

8. In the next window, click Install as shown in Figure 7-76.

Figure 7-76   Document Manager Desktop install window

9. When the installation procedure finishes, click Finish to exit the wizard as 
shown in Figure 7-77.
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Figure 7-77   Document Manager Desktop finish install window

10.Finally, you should see a window similar to the one in Figure 7-78. If you see 
this window, you have correctly installed Document Manager Desktop client in 
your client machine.

Figure 7-78   Document Manager Desktop application

7.12  Configuration of SMTP Server/e-mail
You need an SMTP server for automatic mail notification functionality of 
Document Manager. Here we used the ArGoSoft mail server that is a Freeware 
SMTP server for this goal. ArGoSoft mail server is a very lightweight SMTP 
server. 
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You can download it from:

http://www.argosoft.com/mailserver/

SMTP server installation and configuration
Use the following steps for SMTP server installation and configuration:

1. The installation of the ArGoSoft SMTP server is very straightforward and the 
only thing you do is double-click the installation program and accept the 
default installation path. Once the installation program finishes, you have to 
double-click the ArGoSoft icon on the Windows desktop to open the server 
console as shown in Figure 7-79.

Figure 7-79   ArGoSoft Mail Server control panel window

2. Press Ctrl-O keys to open the server Options window as shown in 
Figure 7-80. Within the General configuration tab, press the red button (at the 
left of the question mark button) to automatically detect the DNS server; then, 
in the white box next to Local Host, type the server host name. You must 
configure check boxes as shown in Figure 7-80.

Note: This component is only for test purposes and to enable e-mail 
notification in our environment. You can use any SMTP e-mail server for the 
same purpose.
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Figure 7-80   ArGoSoft Mail Server options general tab

3. Change to Local Domain tab and add a server domain name as shown in 
Figure 7-81 by clicking Add.

Figure 7-81   ArGoSoft Mail Server options local domain tab

Tip: If you get an error trying to discover the DNS server, be sure you have an 
IP address configured in your Windows network connection Internet Protocol 
(TCP/IP) Properties window and/or call your network administrator for the 
DNS server IP address in your network.
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4. Go to the Ports tab and change the Web Interface port to 85 as shown in 
Figure 7-82 to avoid conflicting with another Web server using port 80.

Figure 7-82   ArGoSoft Mail Server Web interface tab

5. Now, under the SMTP Authentication tab, check the box next to Enable 
SMTP Authentication and choose an SMTP User Name and an SMTP 
Password as shown in Figure 7-83.

Figure 7-83   ArGoSoft Mail Server SMTP Authentication tab

Tip: Use the following example to define your own domain name: 
YourServerHostName.YourCompany.com.
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6. Finally, under the Logging tab, do not change anything as shown in 
Figure 7-84. Click OK to exit the Options window.

Figure 7-84   ArGoSoft Mail Server Logging tab

7. The next step is to create a mail user account in the mail server. Press the 
Ctrl-U keys simultaneously to open the User Setup window as shown in 
Figure 7-85, and click the add new user icon (the one with the sheet of paper 
with the yellow star).

Figure 7-85   ArGoSoft Mail Server User Setup window

8. Create a user called dm_mail by filling the fields as shown in Figure 7-86. 
After you do this, click OK to create the new user.
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Figure 7-86   ArGoSoft Mail Server user configuration window

9. Now you should see the user you created, as shown in Figure 7-87. Click 
Close to exit User Setup window.

Figure 7-87   ArGoSoft Mail Server User Setup window

10.Back in the ArGoSoft Mail Server window, click the red square icon in the 
control panel to stop the mail server. The server log in Figure 7-88 shows that 
the corresponding servers have been stopped.
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Figure 7-88   ArGoSoft Mail Server control panel

11.To start the server again, click the green arrow icon in the control panel. 
Figure 7-89 shows the corresponding servers have been started.

Figure 7-89   ArGoSoft Mail Server control panel

12.To test the mail user we just created, connect to the following URL. 
Remember to replace kcwc09k with your own server host name.

http://kcwc09k:85
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http://kcwc09k:85


And you should see a page similar to Figure 7-90.

Figure 7-90   ArGoSoft Mail Server welcome page

13.Click Login and type the user name and password you create in step 8 as 
shown in Figure 7-91.

Figure 7-91   ArGoSoft Mail Server login window

14.After you log in successfully, click in the Compose link show in Figure 7-92.
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Figure 7-92   ArGoSoft Mail Server client page

15.In the mail compose window, fill the fields as shown in Figure 7-93, and click 
Send link.

Important: Remember to use your own domain name instead of 
kcwc09k.ibm.com. The domain name must be the same you add in step 3.

 

 

 

 

234 IBM DB2 Document Manager with IBM Records Manager Solution Guide



Figure 7-93   ArGoSoft Mail Server compose page

16.You now should see a page as in Figure 7-94. Click Msg List link to see if the 
mail has arrived.

Figure 7-94   ArGoSoft Mail Server mail sent message
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17.If you can see the mail you sent as shown in Figure 7-95, your mail server 
works properly.

Figure 7-95   ArGoSoft Mail Server client page

18.Now, you can click the mail subject to open the mail as shown in Figure 7-96.

Figure 7-96   ArGoSoft Mail Server open mail page

Finally, scroll the browser window to the right and click Log Out link to exit the 
mail client, as shown in Figure 7-97.
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Figure 7-97   ArGoSoft Mail Server logging out link

This concludes the end-to-end solution installation and configuration.

From Chapter 8, “Basic Document Manager implementation” on page 239 
through Chapter 11, “Other record declaration options in Document Manager 
solution” on page 399, we show you detailed steps of implementing a Document 
Manager solution for the case study. 
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Chapter 8. Basic Document Manager 
implementation

This chapter provides practical steps to implement a basic Document Manager 
solution, using the ZXY Technologies case study we described in Chapter 2, 
“Quick start with case study” on page 15. Also, refer to Appendix A, “Case study” 
on page 469 for the case study overview, planning, and design.

To complete the implementation of the entire solution, after you finish this 
chapter, refer to the remaining three chapters.

We cover the following topics:

� Basic implementation road map

� Basic Document Manager implementation:

– Content Manager users and group configuration

– Item type configuration

– Global Document Manager configuration:

Actions and dialogs, menus, and Desktop templates

– Proposal objects and other case study specific object configuration:
Actions and dialogs, views, CVL lists and links, searches, item numbering, 
document class, and Desktop templates

8
 

 

 

 

© Copyright IBM Corp. 2006. All rights reserved. 239



– Proposal life cycle objects configuration:
Roles, document states, and document lifecycle map 
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8.1  Basic implementation road map
In Chapter 3, “Document Manager solution design and planning” on page 47, we 
show you the basic Document Manager solution planning process, which 
consists of the following steps:

1. Identify document types.
2. Identify producers, approvers, and consumers of documents.
3. Identify document characteristics and document life cycles.
4. Define documents that should be records.

In addition, we describe the tasks you should perform to design the solution:

1. Define the users, groups, and roles.
2. Define the data model.
3. Define the life cycle processes.
4. Design the Document Manager user interface.

For records management-related planning and design, we also provide a general 
guideline, which consists of the following steps:

1. Identify corporate records.
2. Review or define records retention rules.
3. Identify how documents are organized.
4. Define the file plan.
5. Define the records’ life cycle.
6. Define the users and security.
7. Plan for records destruction.

In this section, we lay out the approach to implement a Document Manager 
solution. Figure 8-1 shows the core Document Manager objects and how they 
relate to each other as well as a guideline in the order of their creation. 

According to Figure 8-1:

� The Storage Collection (A), ACL (B), and Users/Groups (C) are to be created 
in Content Manager. 

� Attributes (1) and Item types (2) can be created in either Content Manager or 
Document Manager.

� The shared objects in Document Manager are: Classes (3), Actions and 
Dialogs (4), CVL List (4a), CVL Links (4b), New Item Templates, Property 
Modification, Roles (9), States (10), Lifecycle Map (11), and Notifications.

Note: Storage collection is beyond the scope of this redbook. We do not 
address this topic in this chapter.

 

 

 

 

 Chapter 8. Basic Document Manager implementation 241



� The objects related to the Document Manager Desktop are: View Templates 
(5), Search Templates (6), Menus (7), Application Integration and Property 
Exchange, and Desktop Templates (8).

� The blue lines show the objects that affect document access.

� The solid or dashed black lines show objects that affect the metadata.

Figure 8-1   Document Manager objects relationship diagram

In general, we recommend using the creation order, denoted by the numbers 
next to the objects, as suggested in Figure 8-1, to create various Document 
Manager objects. However, sometimes, you may need to deviate from the 
guideline.

Always create the users, groups, attributes, and item types first. Adapt the order 
in which you choose to create the other Document Manager objects to your 
situation. We recommend the strategy of configuring a little and test, configuring 
a little more and test, until you complete the entire implementation. 

By describing to you how we implemented our case study in this chapter and the 
following three chapters, we show you the practical steps that you need to do to 
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implement some of the fundamental and advanced Document Manager functions 
including records management options.

We divide our implementation into four stages:

1. Basic Document Manager configuration. 

Refer to 8.2, “Basic Document Manager implementation” on page 243 for the 
detailed documentation of the steps to configure a basic Document Manager 
system.

2. Advanced Document Manager configuration. 

Refer to Chapter 9, “Advanced Document Manager implementation” on 
page 331 for the documentation about the steps to configure some of the 
advanced Document Manager functions beyond the basic Document 
Manager objects implemented in this chapter.

3. Records enablement. 

Refer to Chapter 10, “Records Manager implementation in the Document 
Manager solution” on page 369 for the documentation about how to enable a 
Document Manager system for records.

4. Additional Records Management declaration options.

Refer to Chapter 11, “Other record declaration options in Document Manager 
solution” on page 399 for additional declaration options you can implement in 
your Document Manager solution.

8.2  Basic Document Manager implementation
In this section, we describe the step-by-step procedures you follow to implement 
a Document Manager solution with basic functionality.

We use our case study to show the detailed implementation steps. You can 
follow our steps to implement the solution for testing purposes, or use our case 
study steps as guidelines to create your own system.

These are the steps to the basic implementation:

1. 8.2.1, “Content Manager users and groups configuration” on page 244
2. 8.2.2, “Item types configuration” on page 246

Note: Before we begin with the case study implementation, you need to have 
your server already installed and configured with the base configuration. If you 
have not done that, you need to refer to Chapter 7, “Installation and 
configuration” on page 151.
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3. Global Document Manager configuration
– “Actions and dialogs” on page 254
– “Menu” on page 258
– “Desktop templates” on page 267

4. Proposal objects:
– “Create actions and dialogs” on page 271
– “Create views” on page 277
– “Create CVL lists and links” on page 279
– “Create searches” on page 281
– “Create item numbering” on page 283
– “Create Sales Proposal document class” on page 283
– “Complete Desktop template with Proposal objects” on page 285
– “Test your system: Sales Proposal class” on page 286

5. “Proposal life cycle objects” on page 286:
– “Create roles” on page 286
– “Create document states” on page 290
– “Configure document lifecycle map” on page 294

6. “Correspondence objects” on page 296
7. “Correspondence life cycle objects” on page 308
8. “RFP objects” on page 311
9. “Reference Document objects” on page 321

8.2.1  Content Manager users and groups configuration
For the ZXY Technologies solution, we create seven groups and a user for each 
group in Content Manager System Administration Client.

Create groups
Start the Content Manager System Administration Client by selecting Start → 
Programs → IBM DB2 Content Manager Enterprise Edition → System 
Administration Client and log on to the system. Perform the following steps:

1. Expand the Authentication group.

2. Right-click User Groups and select New from the context menu.

3. On the New User Group window, type grpSales as Name.

4. Select OK to save the Group.

Note: Before you begin the implementation process, check that the following 
services are running:

� ICMRM server - CM Resource Manager
� DM Cache services 
� DM Lifecycle services

 

 

 

 

244 IBM DB2 Document Manager with IBM Records Manager Solution Guide



You need to follow the same procedure to create the rest of the groups listed in 
Table 8-1.

Table 8-1   Groups

Create users
Now, we have to create a user for each group listed in Table 8-2. Follow this 
procedure:

1. Expand the Authentication group.

2. Right-click Users and select New from the context menu.

3. On the New User window, type usrSale as the user name.

4. Set the password to password.

5. Set the password expiration to Never expires.

6. Select RMEUserAllPrivs for Maximum Privilege Set.

7. Select the Assign to Group tab, and select grpSales.

8. Select the Set Defaults tab, and select RMEClientACL from the Default 
item access control list.

9. Select OK to save the User.

Table 8-2   Users

grpSales

grpMarketing

grpServices

grpManagers

grpFinancials

grpViewer

grpProjectManager

User Group

usrSale grpSales

usrMarketing grpMarketing

usrService grpServices

usrFinancial grpFinancials

usrManager grpManagers
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8.2.2  Item types configuration
The following steps comprise the tasks required to complete this exercise.

� Create Library properties.
� Define Customer Data item type.

Create library properties
You need to create the library properties we are going to use later to define the 
item types for the system. The properties you need to create are listed in 
Table 8-3.

Table 8-3   Library properties

usrProjectManager grpProjectManager

usrViewer grpViewer

User Group

Name Display name Attribute type Character 
type

Character 
length

Customer
Name

Customer
Name

Variable 
character

Extended 
alphanumeric

32

Customer 
Number

Customer 
Number

Variable 
character

Extended 
alphanumeric

32

RequestPropN
um

Request for 
Proposal 
Number

Variable 
character

Extended 
alphanumeric

32

Proposal 
Number

Proposal 
Number

Variable 
character

Extended 
alphanumeric

32

Proposal 
Subject

Proposal 
Subject

Variable 
character

Extended 
alphanumeric

32

Author Author Variable 
character

Extended 
alphanumeric

32

Potential
Rev

Potential Rev Variable 
character

Extended 
alphanumeric

N/A

CreateDate Create Date Date N/A N/A

DeliveryDate Delivery Date Date N/A N/A

eMailNumber eMail Track 
Number

Double N/A N/A
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You can create library properties using Content Manager Administration Client or 
Document Manager Designer tool. This is entirely dependent on your familiarity 
with the user interface and your personal preference. There is no difference 
which one you use to create them.

We choose to create library properties from the Document Manager Designer 
tool, and show you the steps to do so.

To launch the Document Manager Designer, click Start → Programs → IBM 
DB2 Document Manager → Designer. Log on to the system and expand the 
CorporateLibrary library you have defined. Do the following:

1. In the Designer, open Global - [Administrator] and select Library 
Properties.

2. Click the New icon in the Designer title bar, the New - Library Property. 
Configuration window opens. Complete the window input as shown in 
Figure 8-2:

a. Enter CustomerName in the Name field.

b. In the Type field, select Variable Character from the drop down list.

c. In the Display name field, type CustomerName.

d. In the Character type field, select Extended Alphanumeric from the 
drop down list.

e. In the Character length field, set Minimum to 0, and Maximum to 32.

f. Click OK to save your changes.

From From Variable 
character

Extended 
alphanumeric

64

To To Variable 
character

Extended 
alphanumeric

256

MailSubject Mail Subject Variable 
character

Extended 
alphanumeric

256

DateReceived Date Received Date N/A N/A

Name Display name Attribute type Character 
type

Character 
length
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Figure 8-2   New Library Property Configuration window

You need to follow the same procedure to create the rest of the attributes listed 
in Table 8-3 on page 246.

Define item types
For ZXY Technologies, we need to create the CustomerData item type described 
in Table 8-4. 

Table 8-4   CustomerData item type definition

Option Settings

Name CustomerData

Display Name Customer Data

Version Policy Promp to Create

Maximum total versions Unlimited

Item type classification Document

Text Search Text searchable-enabled

Item retention period Forever
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You can create an item type from Content Manager System Administration Client 
or use Document Manager Designer. The client you use depends on your 
personal preference:

� Use Content Manager System Administration Client:

If you are familiar with Content Manager System Administration Client. 

Note, if you use this client to create an item type and you need to have 
multiple classes under the item type, you must edit the item type in Document 
Manager Designer to enable the multiple class feature.

� Use Document Manager Designer: 

If you are familiar with Document Manager Designer.

In our case study, since we are familiar with Content Manager System 
Administration Client, we use it to define the item types.

To launch the Content Manager System Administration, select Start → 
Programs → IBM DB2 Content Manager Enterprise Edition → System 
Administration Client.

CustomerData item type
To create the CustomerData item type, do the following:

1. Select Data Modeling, right-click Item Types, and select New from the 
context menu. This should display the New Item Type Definition dialog.

2. Select the Definition tab, and populate the Definition page as shown in 
Figure 8-3:

a. For Name field, enter CustomerData. Make sure the Item type 
classification is set to Document.

Attributes Used All listed in Table 7-10 on page 189. 

Additional Attributes All listed in Figure 8-3 on page 246

Records-Enabled Yes

Note: Remember to start the NetSearchExtender service before you create 
an item type with text search enabled. You can use Windows Services Control 
Center to start it.

Option Settings 
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Figure 8-3   New Item Type Definition window - Definition tab

b. Select the Text Searchable check box. Click Options.

On the Text Search Options Panel, set the parameter as listed in Table 8-5.

Table 8-5   Text search configuration

Parameter Value

Format Text

CCSID 850

Language code EN_US

Index Directory C:\idx (be sure to create the directory 
before you save)

Working Directory C:\idx (be sure to create the directory 
before you save)

User Defined Function ICMFetchFilter

User defined function schema ICMADMIN
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3. Click the Access Control tab and on the Access Control page, select 
RMEClientACL. Make sure the Access control list checking is set to Item 
type level.

4. Click the Attributes tab, and locate in the left column all the attributes defined 
in Table 8-4 on page 248 as Attributes Used and Additional Attributes. 

Add each one as Selected attributes for the root component as shown in 
Figure 8-4.

Figure 8-4   New Item Type Definition window - Attributes tab

5. Click the Document Management tab and add the following parts to the item 
type:

– ICMBase (Storing the imported documents, files, and images)

Changes before Update 0

Update every Five minutes

Commit Count 0

Parameter Value 
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– ICMBaseText (Storing documents for text search) 

Follow this procedure for each one:

a. Click Add. 

b. Select Part type ICMBase.

c. Set the Access control list to RMEClientACL.

d. Set the New version policy to Prompt to create. 

e. Take the defaults for Access Control List, Resource Manager, and 
Collection. 

f. Select APPLY to add the Part Type. 

6. Select OK to save the item type.

Once we create the item type in Content Manager, then we modify it in 
Document Manager:

1. Go to Document Manager Designer: Select Start → Programs → IBM DB2 
Document Manager → Designer.

2. In the Designer, open Global - [Administrator], select Desktop, then 
expand Item Type, and select the CustomerData item type we added. 

3. Click Modify in the menu. This should open the Modify - Item Type 
Configuration window. Select the Desktop tab and check the Allow multiple 
class definitions as shown in Figure 8-5.
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Figure 8-5   Modify Item Type Configuration window

4. Select OK to save the item type.

Now, if you log on to Content Manager Administrator client, you see that a 
Compound Attribute is added as shown in Figure 8-6.
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Figure 8-6   Document Manager compound attribute

8.2.3  Global Document Manager configuration - Actions and dialogs
In this section, we describe how to create actions and dialog objects in the global 
Document Manager configuration. The global objects are generic ones you can 
reuse for other implementations. They are only related through general desktop 
appearance.

Launch Document Manager Designer. If you are not there, click Start → 
Programs → IBM DB2 Document Manager → Designer.

For the case study, we configure the defaults for actions and dialogs with specific 
options. 

The following steps comprise the tasks required to complete this exercise:

1. Configure DM - Checkin action
2. Configure DM - Checkout action
3. Configure DM - Copy action
4. Configure DM - Modify action
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5. Configure DM - View action
6. Configure DM - Version History action

In the Designer, open Global - [Administrator], open Desktop, and then click 
Actions and Dialogs to select it. 

Configure DM - Checkin action
Select DM - Checkin action and click the Modify icon in the Designer title bar.

1. Click the Options tab, configure the Options page with the options listed in 
Table 8-6.

Table 8-6   Checkin action options

2. Click OK to save the changes.

Configure DM - Checkout action
Select DM - Checkin action and click the Modify icon in the Designer title bar.

Note: These defaults are assigned automatically to all the classes in the 
system. If you need to have a different functionality for a class, then you 
create and associate a different action and dialog object with it.

Options Values

Add related files that are not in library Yes

Copy master item’s profile to new related 
files

Yes

Delete copy of related files on checkin of 
master item

Yes

Scan for new related file attachments Both library and local system

Display checkin options dialog Yes

Show [checkin] option on options dialog Yes

Show [cancel checkout] option on options 
dialog

Yes

Show [leave local] option on options 
dialog

Yes

Show [update library] option on options 
dialog

Yes
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1. Click the Options tab, configure the Options page with the options listed in 
Table 8-7.

Table 8-7   Checkout action options

2. Click OK to save the changes.

Configure DM - Copy action
Select DM - Copy action and click the Modify icon in the Designer title bar.

1. Click the Options tab, configure the Options page with the options listed in 
Table 8-8.

Table 8-8   Copy action options

2. Click OK to save the changes.

Configure DM - Modify action
Select DM - Modify action and click the Modify icon in the Designer title bar.

1. Click the Dialog tab and on the Dialog page: 

a. Select Display dialog to user.

b. Set the Width to 300.

c. Set the Height to 300.

2. Click the Top Section tab, and add a Property:

a. Click Add - this presents a dialog that enables you to add a property.

b. Select Edit for the field Type from the drop-down list.

c. Select Title from the Property field drop-down list. 

d. Leave String for the Data Type.

Options Values

Resolve related files Copy or Checkout cpdoc components

Display related file selection dialog Yes

Display markups selection dialog Yes

Options Values

Resolve related files Copy or Checkout cpdoc components

Display related file selection dialog Yes

Display markups selection dialog Yes
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e. Change Color to red.

f. Click OK to close the window.

3. Click the Options tab. Configure the Options page with the options listed in 
Table 8-9.

Table 8-9   Modify action options

4. Click OK to save the changes.

Configure DM - View action
Select DM - View action and click the Modify icon in the Designer title bar.

1. Click the Options tab. Configure the Options page with the options listed in 
Table 8-10.

Table 8-10   View action options

2. Click OK to save the changes.

Configure DM - Version History action
Select DM - Version History action and click the Modify icon in the Designer 
title bar.

1. After selecting the Dialog tab, and on the Dialog page: 

a. Select Display dialog to user.

b. Set the Width to 500.

c. Set the Height to 300.

Options Values

Refresh Yes

Options Values

Resolve related files Copy or Checkout cpdoc components

Display related files selection dialog Yes

Create unique temporary directory Yes

Allow users to create markups during view 
session

Yes

Copy item’s profile to new markups Yes

Display markup selection dialog Yes
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2. Click the Bottom Section tab. Add the properties listed in Table 8-11.

Table 8-11   Version history action properties

3. Select the Options tab. Configure the options as listed in Table 8-12.

Table 8-12   Version history action options

4. Click OK to save the changes.

8.2.4  Global Document Manager configuration - Menu
In this section, we explain how to create Menu objects in the global Document 
Manager configuration. The global objects are generic. You can reuse them for 
other implementations. They are only related through the general desktop 
appearance.

We need to create seven menus to use in the solution. We assign these menus 
later to each Desktop Template. Users have access to the menus according to 
the appropriate roles they have in the system.

The following steps comprise the tasks required to complete this exercise:

1. “Create About menu” on page 259

Type Properties Data type Disabled

Edit Title String Disabled

Edit FileName String Disabled

Edit Version ID String Disabled

Options Values

Enable [View] command Yes

Enable [Copy] command Yes

Enable [Property Modify] command Yes

Enable [Report] command Yes

Enable [Quick Declare Record] command Yes

Enable [Manually Declare Record] 
command

Yes

Enable [View Records Mgmt Info] 
command

Yes
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2. “Create DoubleClick menu” on page 260
3. “Create Library menu” on page 261
4. “Create RecordsMenu menu” on page 262
5. “Create RightMouse menu” on page 263
6. “Create TopToolbar menu” on page 264
7. “Create TopToolbarViewers menu” on page 265
8. “Create Main menu” on page 266

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Menus.

Create About menu
Click the New icon in the Designer title bar and do the following:

1. In the Name field, type About.

2. Click the Properties tab. Complete the page as shown in Figure 8-7:

a. Select About IBM DB2 Document Manager from the command 
drop-down list.

b. Leave Label and Valid Objects as defaults.

c. Click Add.
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Figure 8-7   About menu

3. Click OK to save the changes.

Create DoubleClick menu
Click the New icon in the Designer title bar and do the following:

1. In the Name field, type DoubleClick.

2. Select the Properties tab. Complete the page as shown in Figure 8-8:

a. Select View from the command drop-down list.

b. Leave Label and Valid Objects as defaults.

c. Click Add.
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Figure 8-8   DoubleClick menu

3. Click OK to save the changes.

Create Library menu
Click the New icon in the Designer title bar and do the following:

1. In the Name field, type Library.

2. Select the Properties tab. Complete the page as shown in Figure 8-9:

a. Select Log in from the command drop-down list.

b. Leave Label and Valid Objects as defaults.

c. Click Add.

d. Repeat the process for the rest of the commands listed.
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Figure 8-9   Library menu

3. Click OK to save the changes.

Create RecordsMenu menu
Click the New icon in the Designer title bar and do the following:

1. In the Name field, type RecordsMenu.

2. Select the Properties tab. Complete the page as shown in Figure 8-10:

a. Select Manually declare record from the command drop-down list.

b. Leave Label and Valid Objects as defaults.

c. Click Add.

d. Repeat the process for the rest of the commands listed.
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Figure 8-10   RecordsMenu menu

3. Click OK to save the changes.

Create RightMouse menu
Click the New icon in the Designer title bar.

1. In the Name field, type RightMouse.

2. Select the Properties tab. Complete the page as shown in Figure 8-11:

a. Select View from the command drop-down list.

b. Leave Label and Valid Objects as defaults.

c. Click Add.

d. Repeat the process for the rest of the commands listed. 

e. To add Records Menu menu, be sure you select the Sub-Menu radio 
button to get the menu list.
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Figure 8-11   RightClick menu

3. Click OK to save the changes.

Create TopToolbar menu
Click the New icon in the Designer title bar and do the following:

1. In the Name field, type TopToolbar.

2. Select the Properties tab. Complete the page as shown in Figure 8-12:

a. Select Add document from the command drop-down list.

b. Leave Label and Valid Objects as defaults.

c. Click Add.

d. Repeat the process for the rest of the commands listed. 

 

 

 

 

264 IBM DB2 Document Manager with IBM Records Manager Solution Guide



Figure 8-12   Toptoolbar menu

3. Click OK to save the changes.

Create TopToolbarViewers menu
Click the New icon in the Designer title bar and do the following:

1. In the Name field, type TopToolbarViewers.

2. Select the Properties tab. Complete the page as shown in Figure 8-13:

a. Select Search from command drop-down list.

b. Leave Label and Valid Objects as defaults.

c. Click Add.

d. Repeat the process for the rest of the commands listed. 
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Figure 8-13   ToptoolbarViewer menu

3. Click OK to save the changes.

Create Main menu
Click the New icon in the Designer title bar and do the following:

1. In the Name field, type Main.

2. Click the Properties Tab. Populate the Properties page as shown in 
Figure 8-14.

The Main menu uses a variety of the previous menus as submenus. Be sure 
to select the Submenu option when adding each one.

 

 

 

 

266 IBM DB2 Document Manager with IBM Records Manager Solution Guide



Figure 8-14   Main menu

3. Click OK to save the changes.

8.2.5  Global Document Manager configuration - Desktop templates
In this section, we describe how to create Desktop template objects in the global 
Document Manager configuration. The global objects are generic ones and can 
be reused for other implementations. They are only related through general 
desktop appearance.

For the solution, we need to create two different Desktop templates. Each 
template allows access to different system functionality depending on the user 
roles:

� Content Producers Template: Template for users who create, revise, and 
approve documents

� Viewers Template: Template for users who only search and see document

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Desktop template to select it.
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Create Content Producers Template
Click the Add icon in the Designer title bar and do the following:

1. Set Name to Content Producers Template.

2. Open the Menu Interface tab, and complete the Menu Interface page as 
shown in Figure 8-15.

Figure 8-15   Desktop Template Configuration window - Menu Interface tab

3. Complete the View Templates page. Select Default view from the left list 
and click Add.

4. Complete the Search Templates page. Select Default from the left list and 
click Add.

5. Complete the User Desktop Options page. Select the four checkboxes.

6. Complete the Item Delivery page as shown in Figure 8-16.
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Figure 8-16   Desktop Template Configuration window - Item Delivery tab

7. Complete the Messaging page. Uncheck the Display desktop messaging 
windows option.

8. Click OK to save the template.

9. Expand the Content Producers Template. Select groups. Click the Add icon 
in the Designer title bar and select the followings groups:

– grpSales
– grpMarketing
– grpServices
– grpFinancial
– grpManager

Create Viewers Template
Click the Add icon in the Designer title bar and do the following:

1. Set Name to Viewers Template.

2. Click the Menu Interface tab and complete the Menu Interface page. Set 
top to TopToolbarViewer.
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3. Complete the View Templates page. Select Default view from the left list 
and click Add.

4. Complete the Search Templates page. Select Default from the left list and 
click Add.

5. Complete the User Desktop Options page. Select the fourth check box.

6. Complete the Messaging page. Uncheck the Display desktop messaging 
windows option.

7. Click OK to save the template.

8. Expand Viewers Template. Select groups. Click the Add icon in the Designer 
title bar and select the following groups:

– grpViewers

Test your system: Document Manager menus and templates
Now you can log on to Document Manager Desktop and test the following 
functions:

� Log on with ursViewer and navigate the desktop. Check menus and toolbars.

� Log on with ursManager and navigate the desktop to find out the differences 
between the usrViewer desktop and the usrManager desktop.

8.2.6  Proposal objects
ZXY Technologies has three departments that use proposals and need a 
different life cycle for each one. For this reason, we create three classes:

� Sales Proposals
� Services Proposals
� Marketing Proposals

All three classes have almost the same configuration. The main difference is the 
groups that use each one. 

Here we describe only the Sales Proposals object. The views, search, and item 
numbering creations are common to all proposals. You have to repeat the 
procedure for the rest of the objects. 

The following steps comprise the tasks required to complete this exercise:

1. “Create actions and dialogs” on page 271

Note: If you cannot see the changes in your system, check if the DM Cache 
server is up and running. You can try stopping the DM Cache, restarting the 
DM Cache, and logging in again in the Document Manager Desktop.

 

 

 

 

270 IBM DB2 Document Manager with IBM Records Manager Solution Guide



2. “Create views” on page 277
3. “Create CVL lists and links” on page 279
4. “Create searches” on page 281
5. “Create item numbering” on page 283
6. “Create Sales Proposal document class” on page 283

Create actions and dialogs
ZXY Technologies needs Add, Modify, Checkin, and Revise dialogs. The Add 
dialog box is displayed to the user when the user tries to add a new Sales 
Proposal document in the system. The Modify dialog box is displayed to the user 
when the user tries to modify an existing Sales Proposal document in the 
system.

The following steps comprise the tasks required to complete this exercise:

1. “Create Sales Proposal - Add dialog” on page 271
2. “Create Sales Proposal - Modify dialog” on page 274
3. “Create Proposal Checkin dialog” on page 275
4. “Create Proposal - Revise dialog” on page 276

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Actions and Dialogs to select it.

Create Sales Proposal - Add dialog
Click the New icon in the Designer title bar. The New - Action and Dialog 
Configuration windows open. Perform the following steps:

1. Set the Name to Sales Proposal - Add.

2. Click the Dialog tab. On the Dialog page: 

a. Select Display dialog to user.
b. Set the Width to 700.
c. Set the Height to 600.

3. Click the Top Section tab and populate the Top Section page as shown in 
Figure 8-17.
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Figure 8-17   Sales Proposal - Add Dialog Configuration window - Top Section

4. Click the Bottom Section tab to populate the Bottom Section page as 
shown in Figure 8-18.

Note: Be sure to assign Create Date control type to Date or Time. This 
will display a calendar to easily assign the date.
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Figure 8-18   Sales Proposal - Add Dialog Configuration window - Bottom Section

5. Click the Options tab and configure the Options page with the options listed 
in Table 8-13.

Table 8-13   Sales Proposal - Add action options

Note: Be sure to assign the Delivery Date control type to Date or Time. 
This will display a calendar to easily assign the date.

Option Value

Content index Yes

Content index - Display Dialog Option Yes

Keep local copy Yes

Keep local copy - Display Dialog Option Yes

Add to folder - Display Dialog Option Yes

Apply unique item numbering Yes

Promp to check out after add Yes
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6. Click Preview. This should display a preview of the dialog. You can change 
the windows’ Width and Height if you want to modify their dimensions.

7. Click OK to save the changes.

8. Under Sales Proposal - Add, expand Group. Click the New icon in the 
Designer title bar. Add the group:

– grpSales

Create Sales Proposal - Modify dialog
Click the New icon in the Designer title bar. The New - Action and Dialog 
Configuration window opens. Perform the following steps:

1. Set the Name to Sales Proposal - Modify.

2. Click the Dialog tab and on the Dialog page: 

a. Select Display dialog to user.

b. Set the Width to 700.

c. Set the Height to 450.

3. Click on the Top Section tab and populate the Top Section page as shown 
in Figure 8-19.

Figure 8-19   Sales Proposal - Modify Dialog Configuration window - Top Section
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4. Click on the Bottom Section tab and populate the Bottom Section page as 
shown in Figure 8-20.

Figure 8-20   Sales Proposal - Modify Dialog Configuration window

5. Click on the Options tab and Configure the Options page. Set Refresh 
desktop to Yes.

6. Click OK to save the changes.

7. Under Sales Proposal - Add, expand Group. Click the New icon in the 
Designer title bar. Add the groups:

– grpSales
– grpFinancials
– grpManagers

Create Proposal Checkin dialog
Select Checkin action and click the Copy icon in the Designer title bar. Perform 
the following steps:

1. Set name to Proposal Checkin.

2. Click the Options tab and configure the Options page.

a. Set Process Transition command to Yes.
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3. Click OK to save the changes.

4. Under Sales Proposal - Add, expand Group. Click the New icon in the 
Designer title bar. Add the groups:

– grpSales
– grpFinancials
– grpManagers

Create Proposal - Revise dialog
Click the New icon in the Designer title bar. Perform the following steps:

1. Set the Name to Proposal - Revise.

2. Click the Top Section tab and populate the Top Section page as shown in 
Figure 8-21.

Figure 8-21   Proposal - Revise Dialog Configuration window

3. Click the Options tab and configure the Options page with the options listed 
in Table 8-14.
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Table 8-14   Proposal - Revise action options

4. Click OK to save the changes.

Create views
We need to create a view to display all the Proposal properties to the user. We 
need to add all the properties we associated with the CustomerData item type 
related with Proposals.

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Views to select it. 

Create Proposal View
Click the New icon in the Designer title bar. The New View Configuration window 
opens. Perform the following steps:

1. Select General tab. On the General page: 

Enter Proposal View in the Name field.

2. Select Display tab. On the Select page:

There is a list in the left panel of the Library Properties for the system. 
Select the properties as shown in Figure 8-22 and add them to the Selected 
Properties panel on the right of the dialog.

Options Values

Apply secondary revision numbering Yes

Revise single children of same or 
non-controlled class

Yes

Copy single children profile information Yes

Copy item markups to new revision Yes
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Figure 8-22   Proposal View Configuration window

3. Click Advanced. Select the Display Settings tab:

a. Select Display background highlighting.

b. Select Display Item of Record image.

4. Click Advanced. Select the Display Filters tab:

a. Select Class from the Property drop-down list.

b. Select Not equal from the Operator drop-down list.

c. Enter Correspondence in the Value field.

d. Click Add to save the selection.

e. Select Class from the Property drop-down list.

f. Select Not equal from the Operator drop-down list.

g. Enter RFP in the Value field.

h. Click Add to save the selection.

5. Click OK to save your changes.
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Create CVL lists and links
You need to create in the design a CVL List and a CVL Link to use for the 
Proposal Search. This list will display a predefined option list in the search dialog 
box for the user.

The following steps comprise the tasks required to complete this exercise.

1. “Create Proposals CVL list” on page 279
2. “Create Proposals Link” on page 280

In the Designer, open Global - [Administrator] as before, open Desktop, and 
open CVLs. 

Create Proposals CVL list
Select Lists and click the New icon in the Designer title bar. The New - CVL 
Configuration window should open. Perform the following steps:

1. In the Name field, type Proposals.

2. In the Type pick-list, select Standard.

3. Add the values as shown in Figure 8-23:

– Sales Proposal
– Service Proposal
– Marketing Proposal
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Figure 8-23   Proposals CVL Configuration window

4. Click OK to save your changes.

Create Proposals Link
Select Links and click the New icon in the Designer title bar. The New - CVL 
Configuration window should open. Perform the following steps:

1. In the Name field, type Proposals Link.

2. In the Property drop-down list, select Class.

3. In the CVL name drop-down list, select Proposal.

It should look like Figure 8-24.
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Figure 8-24   Proposals Link Configuration window

4. Click OK to save your changes.

Create searches
For the ZXY Technologies proposal, we define an unique Proposal Search that 
the three departments share. You only create this object once.

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Searches to select it.

Create Proposal search
Click the New icon in the Designer title bar. The New Search Configuration 
window should open. Perform the following steps:

1. Click the Properties tab and complete the Properties page section:

a. In the Name field, type Proposal.

b. Select the Save Search, Clear Search, and Load Search options.

2. Select the Properties tab:

a. Add the properties listed in Table 8-15.
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Table 8-15   Proposal search properties

Figure 8-25 shows an example of Search Configuration window.

Figure 8-25   Search Configuration window

3. Click the Library tab and Complete the Library page.

Property Control Type Default Operator

Class Drop Down Equal

Customer Name Edit Contains

Customer Number Edit Contains

Proposal Number Edit Contains

Request for Proposal 
Number

Edit Ignore

Create Date Date Ignore

Delivery Date Date Ignore

Potential Revenue Edit Ignore

Author Edit Ignore
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a. Click Add. Select CustomerData item type from the list.

4. Preview the dialog and then close it.

5. Click OK to post the search configuration to the repository.

6. Add CVL Link: It will populate the Class drop-down list with the three kinds of 
Proposal Documents.

a. Select the Proposal Link you created in previous step.

b. Drag it over CVL Link under Proposal Search.

If you preview again, now the Search looks like Figure 8-26.

Figure 8-26   Proposal Search window

Create item numbering
For the ZXY Technologies proposal, we define a unique Proposal Number that is 
shared by the three departments. You only create this object once.

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Item Numbering to select it.

Create Proposal Number item numbering
Click the New icon in the Designer title bar. The New - Item Numbering 
Configuration window should open. Perform the following steps:

1. In the Name field, type Proposal Number.

2. Click the Numbering tab and Complete the Numbering page:

a. Select Numeric from the Numbering scheme drop-down list.

b. Select 5- 0000x from the Format drop-down list.

3. You do not have to complete the Lock Info tab. This is only for information 
about which number is the last one created and who created it.

4. Click OK to save the changes.

Create Sales Proposal document class
You need to create the Sales Proposal controlled class. 
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In the Designer, open Global - [Administrator] as before, open Desktop, open 
Item Type, and open CustomerData item type. Select Classes and click the 
New icon in the Designer title bar.

Create Sales Proposal controlled class
Perform the following steps:

1. Populate the top section of the window:

a. In the Name field, type Sales Proposal.

b. In the Type pick-list, select Controlled.

2. Click the Triggers tab and complete the Triggers page as shown in 
Figure 8-27.

Figure 8-27   Sales Proposal Class Configuration window 

3. Click the Properties tab and complete the Properties page:

a. Select Proposal Number from the Property drop-down list.

b. Select the Require entry check box.

c. Click Add.

d. Select Revision from the Property drop-down list.
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e. Select the Revision Property check box.

f. Click Add.

4. Click the Numbering tab and complete the Numbering page:

a. Select Proposal Number from the Property drop-down list.

b. Select Proposal Number from the Numbering Configuration drop-down 
list.

5. Click the Revisioning tab and complete the Revisioning page:

a. Select Numeric from the primary Numeric scheme drop-down list.

b. Select Alpha from the secondary Numeric scheme drop-down list.

6. Click OK to save your entries to the system.

Associate actions and dialogs
Expand the Sales Proposal class. You will see the folder Actions and Dialogs. 
Perform the following steps:

1. Go to Desktop → Actions and Dialogs, and select Sales Proposal - Add 
dialog.

2. Drag it to the Actions and Dialogs folder under Sales Proposal class.

3. Repeat the procedure for Sales Proposal - Modify dialog and Proposal - 
Revision dialog.

It should look like Figure 8-28.

Figure 8-28   Sales Proposal class actions and dialogs

Complete Desktop template with Proposal objects
You need to configure the Default Template with the Views and Search you have 
just created for Sales Proposal class. 

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Desktop template to select it. You need to modify the templates 
defined. 
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Follow these steps:

1. Select Content Producers Template. Click the Modify icon in the Designer 
title bar. 

2. Select the View Template Tab. 

a. Add Proposal View and Detailed Proposal View to the right list.

3. Select Search Template Tab. 

b. Add Proposal search to the right list.

4. Click OK to save your entries to the system.

5. Apply the same changes to Admin Template and Viewers Template.

Test your system: Sales Proposal class
Now you can log on to the Document Manager Desktop as usrSale and test the 
following Sales Proposal class functionality:

� Add documents, using Item Numbering for Proposal Number.
� Search documents, using a CVL list for class selection.
� Use different Views for the search return.
� Open and Modify documents.

8.2.7  Proposal life cycle objects
You have created all the Sales Proposal-related objects. Now you have to create 
all the life cycle-related objects and define the life cycle for the class.

The following steps comprise the tasks required to complete this exercise.

1. “Create roles” on page 286
2. “Create document states” on page 290
3. “Configure document lifecycle map” on page 294

Create roles
For the ZXY Technologies, we create four roles to use in the Sales Proposal. 
These roles are shared between the three Proposal Documents. You need to do 
this only once. Each role represents which right has a group of users over a state 
of the document. Once you create the roles, we will assign the roles to the 
corresponding states.

Note: If you cannot see the changes in your system, please check if the DM 
Cache server is up and running. You can try stopping the DM Cache server, 
restarting the DM Cache server, and logging in again in the Document 
Manager Desktop.
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The following steps comprise the tasks required to complete this exercise.

1. “Create Creators role” on page 287
2. “Create Reviewers role” on page 288
3. “Create Approvers role” on page 288
4. “Create Creators role” on page 287

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Roles to select it. 

Create Creators role
To create the Creator role, do the following:

1. In the Name field, type Creators.

2. In the General panel, set the option as shown in Figure 8-29:

Figure 8-29   Creators Role Configuration window

3. Click OK to save your entries to the system.

4. Expand the role, select Groups, and add the following:

– grpSales
– grpConsultants
– grpMarketing

 

 

 

 

 Chapter 8. Basic Document Manager implementation 287



Create Reviewers role
To create the Reviewers role, do the following:

1. In the Name field, type Reviewers.

2. In the General panel, set the option as shown in Figure 8-30.

Figure 8-30   Reviewers Role Configuration window

3. Click OK to save your entries to the system.

4. Expand the role, select Groups, and add the following:

– grpFinancials
– grpManagers

Create Approvers role
To create the Approvers role, do the following:

1. In the Name field, type Approvers.

2. In the General panel, set the option as shown in Figure 8-31.
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Figure 8-31   Approvers Role Configuration window

3. Click OK to save your entries to the system.

4. Expand the role, select Groups, and add the following:

– grpManagers

Create Viewers role
To create the Viewers role, do the following:

1. In the Name field, type Viewers.

2. In the General panel, set the option as shown in Figure 8-32.
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Figure 8-32   Viewers Role Configuration window

3. Click OK to save your entries to the system.

4. Expand the role, select Groups, and add the following:

– grpViewers
– grpSales
– grpMarketing
– grpServices
– grpManager
– grpFinancials

Create document states
For the ZXY Technologies Proposal classes, we create five states. Each state 
represents a step inside a class life cycle. You configure the states’ functionality 
and associated roles.

The following steps comprise the tasks required to complete this exercise:

1. “Create Draft state” on page 291
2. “Create Review state” on page 291
3. “Create Approval state” on page 292
4. “Create Superceded state” on page 292
5. “Create Orphaned state” on page 292

 

 

 

 

290 IBM DB2 Document Manager with IBM Records Manager Solution Guide



6. “Create Issued state” on page 293
7. “Create PDF state” on page 293
8. “Associate Sales Proposal states with the class” on page 293

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click States to select it. Click the New icon in the Designer title bar.

Create Draft state
To create the Draft state, do the following:

1. Populate the top section of the window.

a. In the Name field, type Draft.

b. Select Active from the drop-down list associated with the Type field.

c. Leave unchecked all of the actions on the Actions tab.

2. Select Security tab. Check the following two options:

– Items can be added as this state.
– New revisions can be created as this state.

3. Click OK to save your entries to the system.

Note that a new folder named Draft is created beneath the States folder.

4. Expand Draft. You will see the folder Roles.

Go to Desktop → Roles, and drag the following roles to the Roles folder 
under Draft state:

– Creators
– Viewers

Create Review state
To create the Review state, do the following:

1. Populate the top section of the window.

a. In the Name field, type Review.

b. Select Active from the drop-down list associated with the Type field.

c. Leave unchecked all of the actions on the Actions tab and Security tab.

2. Click OK to save your entries to the system.

3. Expand Review. You will see the folder Roles.

Go to Desktop → Roles, and drag the following roles to the Roles folder 
under Review state:

– Reviewers
– Viewers

 

 

 

 

 Chapter 8. Basic Document Manager implementation 291



Create Approval state
To create the Approval state, do the following:

1. Populate the top section of the window.

a. In the Name field, type Approval.

b. Select Active from the drop-down list associated with the Type field.

c. Leave unchecked all of the actions on the Actions tab and Security tab.

2. Click OK to save your entries to the system.

3. Expand Approval. You will see the folder Roles.

Go to Desktop → Roles, and drag the following roles to the Roles folder 
under Approval state:

– Approvers
– Viewers

Create Superceded state
To create the Superceded state, do the following:

1. Populate the top section of the window.

a. In the Name field, type Superceded.

b. Select Inactive from the drop-down list associated with the Type field.

c. Leave unchecked all of the actions on the Actions tab and Security tab.

2. Click OK to save your entries to the system.

3. Expand Superceded. You will see the folder Roles.

Go to Desktop → Roles, and drag the following roles to the Roles folder 
under Superceded state:

– Viewers

Create Orphaned state
To create the Orphaned state, do the following:

1. Populate the top section of the window.

a. In the Name field, type Orphaned.

b. Select Inactive from the drop-down list associated with the Type field.

c. Leave unchecked all of the actions on the Actions tab and Security tab.

2. Click OK to save your entries to the system.

3. Expand Orphaned. You will see the folder Roles.
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Go to Desktop → Roles, and drag the following roles to the Roles folder 
under Orphaned state:

– Viewers

Create Issued state
To create the Issued state, do the following:

1. Populate the top section of the window.

a. In the Name field, type Issued.

b. Select Issued from the drop-down list associated with the Type field.

2. Select Transition tab.

a. Check the option Transition previous revision in state to and select 
Superceded from the drop-down list.

3. Leave unchecked all of the actions on Security tab.

4. Click OK to save your entries to the system.

5. Expand Issued. You will see the folder Roles.

Go to Desktop → Roles, and drag the following roles to the Roles folder 
under Issued state:

– Viewers

Create PDF state
To create the PDF state, do the following:

1. Populate the top section of the window.

a. In the Name field, type PDF.

b. Select Inactive from the drop-down list associated with the Type field.

c. Leave unchecked all of the actions on the Actions tab and Security tab.

2. Click OK to save your entries to the system.

3. Expand PDF. You will see the folder Roles.

Go to Desktop → Roles, and drag the following roles to the Roles folder 
under Issued state:

– Viewers

Associate Sales Proposal states with the class
Expand the Sales Proposal class. You will see the folder States. Do the 
following:

1. Go to Desktop → States, and select Draft state.
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2. Drag it to the States folder under the Sales Proposal class. 

3. Repeat the procedure for the other Sales Proposal states.

It should looks like Figure 8-33:

Figure 8-33   Sales Proposal states

4. Expand Draft state, expand Roles, expand Creators, and expand Groups.

5. Leave only grpSales in the list. Delete grpMarketing and grpServices. It 
should look like Figure 8-34:

Figure 8-34   Sales Proposal class roles configuration

Configure document lifecycle map
You have associated all the states with the class. Now you configure the life 
cycle with the correct order through which a document passes.

In the Designer, open Global - [Administrator] as before, open Desktop, open 
Item Type, open CustomerData, open Sales Proposal, and then click 
Lifecycle Map to select it. Perform the following steps:

1. Click the Modify icon in the Designer title bar.
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2. You have to move the object like Figure 8-35 but without the arrows. We will 
add them later.

Figure 8-35   Sales Proposal Lifecycle Map window

3. Select the Draft state, right-click, and select Add route. An arrow will appear 
from Draft as origin and you have to click over Review to mark the 
destination. The New - Item Lifecycle Route windows open.

a. Select the Participants tab.

b. Assign the Creators role to the Assigned list in the right.

c. Click Apply to save the changes. Click Done to close the windows.

4. Select the Review state, right-click and select Add route. An arrow will 
appear from Review as origin and you have to click over Approve to mark 
the destination. The New - Item Lifecycle Route windows open.

a. Select Participants tab.

b. Assign Reviewers role to the Assigned list in the right.

c. Click Apply to save the changes. Click Done to close the window.

5. Select Review state, right-click, and select Add route. An arrow will appear 
from Review as origin and you have to click over Draft to mark the 
destination. The New - Item Lifecycle Route window opens.
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a. Select Graphics tab. Select Color to Red.

a. Select Participants tab.

b. Assign Reviewers role to the Assigned list in the right.

c. Click Apply to save the changes. Click Done to close the window.

6. Select Approve state, right-click and select Add route. An arrow will appear 
from Approve as origin and you have to click over Approve to mark the 
destination. The New - Item Lifecycle Route window opens.

a. Select Participants tab.

b. Assign Approvers role to the Assigned list in the right.

c. Click Apply to save the changes. Click Done to close the window.

7. Select Graphic tab. Change Current state text color to Red.

8. Click Apply to save the changes. Click Done to close the window.

Test your system: Sales Proposal life cycle
Now you can log on to the Document Manager Desktop as usrSale and test the 
following Sales Proposal class functionality:

� Add documents.
� Route the documents through the life cycle.

8.2.8  Correspondence objects
In this section, we describe the Correspondence objects’ design and the 
procedures to create them.

The following steps comprise the tasks required to complete this exercise:

1. “Create actions and dialogs” on page 297
2. “Create views” on page 301
3. “Create CVL lists and links” on page 302
4. “Create searches” on page 303
5. “Create item numbering” on page 305
6. “Create correspondence document class” on page 305

Note: If you cannot see the changes in your system, please check if the DM 
Cache server is up and running. You can try stopping the DM Cache server, 
restarting DM Cache server, and logging in again in the Document Manager 
Desktop.

Note: The DM Lifecycle service must be up and running to route a document 
through the life cycle.
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Create actions and dialogs
ZXY Technologies needs the Add Correspondence and Modify Correspondence 
dialogs. The Add dialog box will be displayed to the user when the user tries to 
add a new Correspondence document in the system. The Modify dialog box will 
be displayed to the user when the user tries to modify an existing 
Correspondence document in the system.

The following steps comprise the tasks required to complete this exercise.

1. “Create Correspondence - Add dialog” on page 297
2. “Create Correspondence - Modify dialog” on page 300

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Actions and Dialogs to select it.

Create Correspondence - Add dialog
Click the New icon in the Designer title bar. The New - Action and Dialog 
Configuration window opens. Perform the following steps:

1. Set the Name to Correspondence - Add.

1. In the Dialog tab, complete on the Dialog page: 

a. Select the Display dialog to user option.

b. Set the Width to 700.

c. Set the Height to 500.

2. Click the Top Section tab and populate the Top Section page as shown in 
Figure 8-36.
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Figure 8-36   Correspondence: Top Section of Add Dialog Configuration 

3. Click the Bottom Section tab and populate the Bottom Section page as 
shown in Figure 8-37.
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Figure 8-37   Correspondence: Bottom Section of Add Dialog Configuration

4. Click the Options tab and configure the Options page with the options listed 
in Table 8-16:

Table 8-16   Correspondence - Add action options

5. Click Preview. This displays a preview of the dialog. You can change the 
window’s Width and Height option if you want to modify the dimensions.

6. Click OK to save the changes.

Option Value

Content index Yes

Content index - Display Dialog Option Yes

Keep local copy Yes

Keep local copy - Display Dialog Option Yes

Add to folder - Display Dialog Option Yes

Apply unique item numbering Yes
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7. Under Correspondence - Add, expand Group. Click the New icon in the 
Designer title bar. Add the groups:

– grpSales
– grpServices
– grpMarketing

Create Correspondence - Modify dialog
Click the New icon in the Designer title bar. The New - Action and Dialog 
Configuration window opens. Perform the following steps:

1. Set the Name to Correspondence - Modify.

2. In the Dialog tab, on the Dialog page: 

a. Select the Display dialog to user option.

b. Set the Width to 700.

c. Set the Height to 450.

3. Click the Top Section tab and populate the Top Section page as shown in 
Figure 8-38. Attributes eMailTrackNumber and Proposal Number must be 
Disabled.

Figure 8-38   Correspondence: Top Section of Modify Dialog Configuration 
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4. Click the Options tab and configure the Options page. Set Refresh desktop 
to yes.

5. Click OK to save the changes.

6. Under Correspondence - Modify, expand Group. Click the New icon in the 
Designer title bar. Add the groups:

– grpSales
– grpServices
– grpMarketing

Create views
For ZXY Technologies, you create only one view that shows all the 
Correspondence properties to the user.

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Views to select it. 

Create Correspondence View
Click the Add icon in the Designer title bar. The New View Configuration window 
opens. Perform the following steps:

1. Click the General tab and on the General page:

a. Enter Correspondence View in the Name field.

2. Click the Display tab and on the Display page: 

In the left panel is a list of the Library Properties for the system. Select the 
properties as shown in Figure 8-39 and add them to the Selected Properties 
panel on the right of the dialog.
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Figure 8-39   Correspondence View Configuration window 

3. Click Advanced. Select Display Filters tab.

a. Select Class from the Property drop-down list.

b. Select Equal from the Operator drop-down list.

c. Enter Correspondence in the Value field.

d. Click Add to save the selection.

4. Click OK to save your changes.

Create CVL lists and links
You must create in the design a CVL list and a CVL link to use for the 
Correspondence Search. This list displays a predefined option list in the search 
dialog box for the user.

The following steps comprise the tasks required to complete this exercise.

1. “Create Correspondence CVL list” on page 303
2. “Create Correspondence Link” on page 303

In the Designer, open Global - [Administrator] as before, open Desktop, and 
open CVLs. 
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Create Correspondence CVL list
Select Lists and click the New icon in the Designer title bar. The New - CVL 
Configuration window opens. Perform the following steps:

1. In the Name field, type Correspondence.

2. In the Type pick-list, select Standard.

3. Add the value:

– Correspondence

4. Click OK to save your changes.

Create Correspondence Link
Select Links and click the New icon in the Designer title bar. The New - CVL 
Configuration window opens. Perform the following steps:

1. In the Name field, type Correspondence Link.

2. Set Property drop-down list to Class.

3. Set CVL name drop-down list to Correspondence.

4. Set Default Value drop-down list to Correspondence.

5. Click OK to save your changes.

Create searches
In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Searches to select it.

Create Correspondence search
Click the New icon in the Designer title bar. The New Search Configuration 
window opens. Perform the following steps:

1. Click the Properties tab and complete the Properties page:

a. In the Name field, type Correspondence.

b. Check the Save Search, Clear Search, and Load Search options.

2. Complete the Properties page.

a. Add the properties listed in Table 8-17.

Table 8-17   Correspondence search properties

Property Control Type Default Operator

Class Dropdown Equal

Customer Name Edit Contains
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It should look like Figure 8-40.

Figure 8-40   Correspondence Search Configuration window 

3. Click the Library tab and complete the Library page:

a. Click Add. Select CustomerData item type from the list.

4. Preview the dialog and then close it.

5. Click OK to post the search configuration to the repository.

Customer Number Edit Contains

eMail Track Number Edit Equal

Request for Proposal 
Number

Edit Ignore

From Edit Ignore

To Edit Ignore

Mail Subject Edit Ignore

Dated Received Date Ignore

Property Control Type Default Operator 

 

 

 

304 IBM DB2 Document Manager with IBM Records Manager Solution Guide



6. Add CVL Link: It will populate the Class drop-down list.

a. Select the Correspondence Link you created in previous step.

b. Drag it over CVL Link under Correspondence Search.

Create item numbering
For the ZXY Technologies proposal, we define a unique e-mail Track Number for 
follow-up correspondence documents.

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Item Numbering to select it.

Create Correspondence Track Number
Click the New icon in the Designer title bar. The New - Item Numbering 
Configuration window opens. Perform the following steps:

1. In the Name field, type Correspondence Track Number.

2. Click the Numbering tab and complete the Numbering page.

a. Select Numeric from the Numbering scheme drop-down list.

b. Select 6 - 00000x from the Format drop-down list.

3. You do not have to complete the Lock Info tab page. This is only for 
information about which number is the last one created and who created it.

4. Click OK to save the changes.

Create correspondence document class
Next create the Correspondence controlled class. 

In the Designer, open Global - [Administrator] as before, open Desktop, open 
Item Type, and open the CustomerData item type. Select Classes and click the 
New icon in the Designer title bar.

Create Correspondence controlled class
Perform the following steps:

1. Populate the top section of the window:

a. In the Name field, type Correspondence.

b. In the Type pick-list, select Controlled.

2. Click the Triggers tab and complete the Triggers page as shown in 
Figure 8-41.
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Figure 8-41   Correspondence Class Configuration window 

3. Click the Properties tab and complete the Properties page:

a. Select eMail Track Number from the Property drop-down list 

b. Select the Require entry check box

c. Click Add

4. Click the Numbering tab and complete the Numbering page:

a. Select eMail Track Number from the Property drop-down list 

b. Select Correspondence Track Number from the Numbering 
Configuration drop-down list 

5. Click OK to save your entries to the system

Associate actions and dialogs
Expand the Correspondence class. You will see the folder Actions and Dialogs. 
Perform the following steps:

1. Go to Desktop → Actions and Dialogs, and select Correspondence - Add 
dialog.

2. Drag it to the folder under Correspondence class.
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3. Repeat the procedure for Correspondence - Modify dialog.

It should look like Figure 8-42:

Figure 8-42   Correspondence class actions and dialogs

Complete Desktop template with Correspondence objects
Configure the Default Template with the View and Search you have just created 
for Correspondence class.

In the Designer, open Global - [Administrator] as before, open Desktop, and 
then click Desktop template to select it. You need to modify the templates you 
have defined. Perform the following steps:

1. Select Content Producers Template. Click the Modify icon in the Designer 
title bar. 

2. Select the View Template Tab. 

Add Correspondence View to the right list.

3. Select Search Template Tab. 

Add Correspondence search to the right list.

4. Click OK to save your entries to the system.

5. Apply the same changes to Admin Template and Viewers Template.

Test your system: Correspondence class
Now you can log on to the Document Manager Desktop as usrSale and test the 
following Correspondence class functionality:

� Add documents, using Item Numbering for eMail Track Number.
� Search documents.
� Use Views for the search return.
� Open and Modify documents.

Note: If you cannot see the changes in your system, check if the DM Cache 
server is up and running. You can try stopping the DM Cache server, 
restarting the DM Cache server, and logging in again in the Document 
Manager Desktop.
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8.2.9  Correspondence life cycle objects
You have created all the Correspondence-related objects. Now you have to 
create all the life cycle-related objects and define the life cycle for the class.

The following steps comprise the tasks required to complete this exercise.

1. “Create document states” on page 308
2. “Configure document lifecycle map” on page 309

Create document states
For the ZXY Technologies Correspondence class, we create two states. Each 
state represents a step inside a class life cycle. You will configure the states’ 
functionality and associated roles.

The following steps comprise the tasks required to complete this exercise.

1. “Create Incoming state” on page 308
2. “Create Outgoing state” on page 308
3. “Associate Correspondence states with the class” on page 309

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click States to select it. Click the New icon in the Designer title bar.

Create Incoming state
To create the Incoming state, do the following:

1. Populate the top section of the window.

a. In the Name field, type Incoming.

b. Select Issued from the drop-down list associated with the Type field.

2. Select Security tab. Check the following option:

– Items can be added as this state.

3. Click OK to save your entries to the system.

4. Expand Incoming. You will see the folder Roles.

Go to Desktop → Roles and drag the following roles to the Roles folder 
under Incoming state:

– Creators
– Viewers

Create Outgoing state
To create the Outgoing state, do the following:

1. Populate the top section of the window.
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a. In the Name field, type Outgoing.

b. Select Issued from the drop-down list associated with the Type field.

2. Select Security tab. Check the following option:

– Items can be added as this state.

3. Click OK to save your entries to the system.

4. Expand Outgoing. You will see the folder Roles.

Go to Desktop → Roles and drag the following roles to the Roles folder 
under Outgoing state:

– Creators
– Viewers

Associate Correspondence states with the class
Expand the Correspondence class. You will see the folder States. Do the 
following:

1. Go to Desktop → States and select Incoming state.

2. Drag it to the States folder under Correspondence class.

3. Repeat the procedure for Outgoing state.

It should look like Figure 8-43:

Figure 8-43   Correspondence states

Configure document lifecycle map
You have associated all the states with the class, now you have to configure the 
life cycle with the correct order through which a new document passes.

In the Designer, open Global - [Administrator] as before, open the Desktop, 
open the Item Type, open CustomerData, open Correspondence, and then 
click Lifecycle Map to select it. Do the following steps:

1. Click the Modify icon in the Designer title bar. Figure 8-44 displays.
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Figure 8-44   Correspondence Lifecycle Map window

2. Select Graphic tab. Change Current state text color to Blue.

3. Click Apply to save the changes. Click Done to close the window.

Test your system: Correspondence life cycle
Now you can log on to Document Manager Desktop as usrSale and test the 
following Correspondence class functionality:

� Add documents.
� Route the documents through the life cycle.

Note: If you cannot see the changes in your system, check if the DM Cache 
server is up and running. You can try stopping the DM Cache server, 
restarting the DM Cache server, and logging in again in the Document 
Manager Desktop.

Note: You need the DM Lifecycle service up and running to route a document 
through the life cycle.
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8.2.10  RFP objects
In this section, we describe the RFP (Request for Proposal) objects design and 
the procedures to create them.

The following steps comprise the tasks required to complete this exercise.

1. “Create actions and dialogs” on page 311
2. “Create views” on page 315
3. “Create CVL lists and links” on page 316
4. “Create searches” on page 317
5. “Create RFP document class” on page 319

Create actions and dialogs
ZXY Technologies needs an Add RFP dialog and a Modify RFP dialog. The Add 
dialog box will be displayed to the user when the user tries to add a new RFP 
document in the system, and the Modify dialog box will be displayed to the user 
when the user tries to modify an existing RFP document.

The following steps comprise the tasks required to complete this exercise.

1. “Create RFP - Add dialog” on page 311
2. “Create RFP - Modify dialog” on page 314

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Actions and Dialogs to select it.

Create RFP - Add dialog
Click the New icon in the Designer title bar. The New - Action and Dialog 
Configuration window opens. Perform the following steps:

1. Set the Name to RFP - Add.

2. In the Dialog tab, on the Dialog page: 

a. Select the Display dialog to user option.

b. Set the Width to 700.

c. Set the Height to 500.

3. Click the Top Section tab and populate the Top Section page as shown in 
Figure 8-45.
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Figure 8-45   RFP - Add Dialog Configuration window - Top Section tab

4. Click the Bottom Section tab and Populate the Bottom Section page as 
shown in Figure 8-46:
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Figure 8-46   RFP - Add Dialog Configuration window - Bottom Section tab

5. Click the Options tab and configure the Options page with the options listed 
in Table 8-18.

Table 8-18   RFP - Add action options

6. Click Preview. This displays a preview of the dialog. You can change the 
window’s Width and Height option if you want to modify the dimensions.

7. Click OK to save the changes.

Option Value

Content index Yes

Content index - Display Dialog Option Yes

Keep local copy Yes

Keep local copy - Display Dialog Option Yes

Add to folder - Display Dialog Option Yes

Apply unique item numbering Yes
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8. Under RFP - Add, expand Group. Click the New icon in the Designer title 
bar. Add the groups:

– grpSales
– grpServices
– grpMarketing

Create RFP - Modify dialog
Click the New icon in the Designer title bar. The New - Action and Dialog 
Configuration window opens. Do the following steps:

1. Set the Name to RFP - Modify.

2. In the Dialog tab, on the Dialog page:

a. Select the Display dialog to user option.

b. Set the Width to 700.

c. Set the Height to 400.

3. Click the Top Section tab and populate the Top Section page as shown in 
Figure 8-47. Attributes eMailTrackNumber and Proposal Number must be 
Disabled.

Figure 8-47   RFP - Modify Dialog Configuration window
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4. Click the Options tab and populate the Options page. Set Refresh desktop 
to yes.

5. Click OK to save the changes.

6. Under RFP - Modify, expand Group. Click the New icon in the Designer title 
bar. Add the groups:

– grpSales
– grpServices
– grpMarketing

Create views
For ZXY Technologies, you only create only one view that shows all the RFP 
properties to the user.

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Views to select it. 

Create RFP View
Click the Add icon in the Designer title bar. The New View Configuration window 
opens. Perform the following steps:

1. Select the General tab. On the General page:

a. Enter RFP View in the Name field.

2. Select the Display tab. On the Display page: 

In the left panel is a list of the Library Properties for the system. Select the 
properties as shown in Figure 8-48 and add them to the Selected Properties 
panel on the right side of the dialog:
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Figure 8-48   RFP View Configuration window

3. Click OK to save your changes.

Create CVL lists and links
Create in the design a CVL List and a CVL Link to use for the RFP Search. This 
list displays a predefined option list in the search dialog box to the user.

The following steps comprise the tasks required to complete this exercise.

1. “Create RFP CVL list” on page 316
2. “Create RFP Link” on page 317

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and open Cvls. 

Create RFP CVL list
Select Lists and click the New icon in the Designer title bar. The New - CVL 
Configuration window opens. Perform the following steps:

1. In the Name field, type RFP.

2. In the Type pick-list, select Standard.
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3. Add the value:

– RFP

4. Click OK to save your changes.

Create RFP Link
Select Links and click the New icon in the Designer title bar. The New - CVL 
Configuration window opens. Perform the following steps:

1. In the Name field, type RFP Link.

2. Set Property drop-down list to Class.

3. Set CVL name drop-down list to RFP.

4. Set Default Value drop-down list to RFP.

5. Click OK to save your changes.

Create searches
In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Searches to select it.

Create RFP search
Click the New icon in the Designer title bar. The New Search Configuration 
window opens. Perform the following steps:

1. Click the Properties tab and complete the Properties page:

a. In the Name field, type RFP.

b. Check the Save Search, Clear Search, and Load Search options.

2. Complete the Properties page:

a. Add the properties listed in Table 8-19.

Table 8-19   RFP search properties

Property Control Type Default Operator

Class Dropdown Equal

Customer Name Edit Contains

Customer Number Edit Contains

Proposal Number Edit Contains

eMail Track Number Edit Ignore

Request for Proposal 
Number

Edit Ignore
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It looks like Figure 8-49:

Figure 8-49   RFP Search Configuration window 

3. Click the Library tab and complete the Library page:

a. Click Add. Select the CustomerData item type from the list.

4. Preview the dialog, and then close it.

5. Click OK to post the search configuration to the repository.

6. Add CVL Link: It will populate the Class drop-down list.

a. Select the RFP Link you have created in the previous step.

b. Drag it over CVL Link under RFP Search.

Date Received Date Ignore

Property Control Type Default Operator 
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Create RFP document class
You need to create the RFP controlled class. Follow these steps:

In the Designer, open Global - [Administrator] as before, open the Desktop, 
open Item Type, open the CustomerData item type. Select Classes and click 
the New icon in the Designer title bar.

Create RFP controlled class
To create the RFP controlled class, do the following:

1. Populate the top section of the window.

a. In the Name field, type RFP.

b. In the Type pick-list, select Controlled.

2. Click the Triggers tab and complete the Triggers page as shown in 
Figure 8-50:

Figure 8-50   RFP Class Configuration window 

3. Click the Properties tab and complete the Properties page:

a. Select eMail Track Number from the Property drop-down list.

b. Select the Require entry check box.
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c. Click Add.

4. Click the Numbering tab and complete the Numbering page:

a. Select eMail Track Number from the Property drop-down list.

b. Select Correspondence Track Number from the Numbering 
Configuration drop-down list.

5. Click the Records Management tab and complete the Records 
Management page.

You must leave the default options. Once you save the class you can return 
here and change the Records Management quick declare options. 

6. Click OK to save your entries to the system.

Associate actions and dialogs
Expand the RFP class. You will see the folder Actions and Dialogs. Do the 
following:

1. Go to Desktop → Actions and Dialogs and select RFP- Add dialog.

2. Drag it to the folder under RFP class.

3. Repeat the procedure for RFP - Modify dialog.

Complete Desktop template with RFP objects
You need to configure the Default Template with the View and Search you have 
just created for RFP class.

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Desktop template to select it. You need to modify the defined 
templates. Follow these steps:

1. Select Content Producers Template. Click the Modify icon in the Designer 
title bar. 

2. Select the View Template Tab. 

a. Add RFP View to the right list.

3. Select Search Template Tab. 

b. Add RFP Search to the right list.

4. Click OK to save your entries to the system.

5. Apply the same changes to Admin Template and Viewers Template.

Associate RFP states with the class
Expand the RFP class. You will see the folder States. Do the following steps:

1. Go to Desktop → States and select Incoming state.
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2. Drag it to the States folder under RFP class.

Test your system: RFP class
Now you can log on to Document Manager Desktop as usrSale and test the 
following RFP class functionality:

� Add documents, using Item Numbering for eMail Track Number.
� Search documents.
� Use Views for the search return.
� Open and Modify documents.

8.2.11  Reference Document objects
In this section, we describe the design of the Reference Document objects and 
the procedures to create them.

The following steps comprise the tasks required to complete this exercise.

1. “Create actions and dialogs” on page 321
2. “Create views” on page 324
3. “Create CVL lists and links” on page 326
4. “Create searches” on page 327
5. “Create Reference Documents class” on page 328

Create actions and dialogs
ZXY Technologies needs an Add and Modify Reference Documents dialog. The 
Add dialog box will be displayed to the user when the user tries to add a new 
Reference Document in the system, and the Modify dialog box will be displayed 
to the user when the user tries to modify an existing Reference Document in the 
system.

The following steps comprise the tasks required to complete this exercise.

1. “Create Reference Document - Add dialog” on page 322
2. “Create Reference Document - Modify dialog” on page 323

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Actions and Dialogs to select it.

Note: If you cannot see the changes in your system, check if the DM Cache 
server is up and running. You can try stopping the DM Cache server, 
restarting the DM Cache server, and logging in again in the Document 
Manager Desktop.
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Create Reference Document - Add dialog
Click the New icon in the Designer title bar. The New - Action and Dialog 
Configuration window opens. Do the following steps:

1. Set the Name to Reference Documents - Add.

1. Click the Dialog tab, and on the Dialog page: 

a. Select the Display dialog to user option.

b. Set the Width to 500.

c. Set the Height to 300.

2. Click the Top Section tab and populate the Top Section page as shown in 
Figure 8-51:

Figure 8-51   Reference Document - Add Dialog Configuration window

3. Click the Options tab and configure the Options page with the options listed 
in Table 8-20.
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Table 8-20   Reference Document - Add action options

4. Click Preview. This should display a preview of the dialog. You can change 
the window’s Width and Height if you want to modify the dimensions.

5. Click OK to save the changes.

6. Under Reference Document - Add, expand Group. Click the New icon in 
the Designer title bar. Add the groups:

– grpSales
– grpServices
– grpMarketing
– grpManager
– grpFinancial

Create Reference Document - Modify dialog
Click the New icon in the Designer title bar. The New - Action and Dialog 
Configuration window opens. Do the following steps:

1. Set the Name to Reference Document - Modify.

2. In the Dialog tab, on the Dialog page: 

a. Select the Display dialog to user option.

b. Set the Width to 500.

c. Set the Height to 300.

3. Click on the Top Section tab, and populate the Top Section page as shown 
in Figure 8-52. 

Option Value

Content index Yes

Content index - Display Dialog Option Yes

Keep local copy Yes

Keep local copy - Display Dialog Option Yes

Add to folder - Display Dialog Option Yes

 

 

 

 

 Chapter 8. Basic Document Manager implementation 323



Figure 8-52   Reference Document - Modify Dialog Configuration window

4. Click the Options tab and configure the Options page. Set Refresh desktop 
to yes.

5. Click OK to save the changes.

6. Under Reference Documents - Modify, expand Group. Click the New icon 
in the Designer title bar. Add the groups:

– grpSales
– grpServices
– grpMarketing
– grpManager
– grpFinancial

Create views
For ZXY Technologies, you only create one view that shows all the Reference 
Document properties to the user.

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Views to select it. 
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Create Reference Documents View
Click the Add icon in the Designer title bar. The New View Configuration window 
opens. Do the following steps:

1. Select the General tab, and on the General page: 

a. Enter Reference Documents View in the Name field.

2. Select the Display tab, and on the Display page: 

In the left panel is a list of the Library Properties for the system. Select the 
properties as shown in Figure 8-53, and add them to the Selected 
Properties panel on the right of the dialog:

Figure 8-53   Reference Documents View Configuration window

3. Click Advanced and configure the window as shown in Figure 8-54.
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Figure 8-54   Advanced View Configuration window

4. Click OK to save your changes.

Create CVL lists and links
In the design, you create a CVL List and a CVL Link to use for the Reference 
Documents Search. This list displays a predefined option list in the search dialog 
box for the user.

The following steps comprise the tasks required to complete this exercise.

1. “Create Reference Documents CVL list” on page 326
2. “Create Reference Documents Link” on page 327

In the Designer, open Global - [Administrator] as before, open the Desktop, 
open CVLs. 

Create Reference Documents CVL list
Select Lists and click the New icon in the Designer title bar. The New - CVL 
Configuration window opens. Do the following steps:

1. In the Name field, type Reference Documents.

2. In the Type pick-list, select Standard.

3. Add the value:
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– Reference Documents

4. Click OK to save your changes.

Create Reference Documents Link
Select Links and click the New icon in the Designer title bar. The New - CVL 
Configuration window opens. Do the following steps:

1. In the Name field, type Reference Documents Link.

2. Set Property drop-down list to Class.

3. Set CVL name drop-down list to Reference Documents.

4. Set Default Value drop-down list to Reference Documents.

5. Click OK to save your changes.

Create searches
In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Searches to select it.

Create Reference Document search
Click the New icon in the Designer title bar. The New Search Configuration 
window opens. Do the following steps:

1. Click the Properties tab and complete the Properties page.

a. In the Name field, type Reference Document.

b. Check the Save Search, Clear Search, and Load Search options.

2. Click the Properties tab and complete the Properties page:

a. Add the properties listed in Table 8-21:

Table 8-21   RFP search properties

3. Click the Library tab and complete the Library page:

a. Click Add. Select CustomerData item type from the list.

4. Preview the dialog and then close it.

5. Click OK to post the search configuration to the repository.

Property Control Type Default Operator

Class Dropdown Equal

Proposal Number Edit Contains

Proposal Subject Edit Contains
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6. Add CVL Link: It will populate the Class drop-down list.

a. Select the Reference Documents Link you have created in the previous 
step.

b. Drag it over CVL Link under Reference Documents Search.

Create Reference Documents class
Next you need to create the Reference Documents static class. Follow these 
steps:

In the Designer, open Global - [Administrator] as before, open the Desktop, 
open Item Type, and open CustomerData item type. Select Classes and click 
the New icon in the Designer title bar.

Create Reference Documents controlled class
To create the Reference Documents controlled class, do the following steps:

1. Populate the top section of the window

a. In the Name field, type Reference Documents.

b. In the Type pick-list, select Static.

2. Click OK to save your changes to the system.

Associate actions and dialogs
Expand the Reference Documents class. You will see the folder Actions and 
Dialogs. Do the following steps:

1. Go to Desktop → Actions and Dialogs and select Reference Documents - 
Add dialog.

2. Drag it to the folder under Reference Documents class.

3. Repeat the procedure for Reference Documents - Modify dialog.

Complete Desktop with Reference Documents objects
You need to configure the Default Template with the View and Search you have 
just created for Reference Documents class.

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Desktop template to select it. You need to modify the defined 
templates. Follow these steps:

1. Select Content Producers Template. Click the Modify icon in the Designer 
title bar. 

2. Select the View Template tab, and on the View Template page: 

a. Add Reference Documents View to the right list.

 

 

 

 

328 IBM DB2 Document Manager with IBM Records Manager Solution Guide



3. Select the Search Template tab, and on the Search Template page: 

b. Add Reference Documents search to the right list.

4. Click OK to save your entries to the system.

5. Apply the same changes to Admin Template and Viewers Template.

Test your system: Reference Documents class
Now you can log on to Document Manager Desktop as usrSale and test the 
following Reference Documents class functionality:

� Add documents
� Search documents

Note: If you cannot see the changes in your system, check if the DM Cache 
server is up and running. You can try stopping the DM Cache server, 
restarting the DM Cache server, and logging in again in the Document 
Manager Desktop.
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Chapter 9. Advanced Document 
Manager implementation

This chapter provides advanced Document Manager implementation for the ZXY 
Technologies case study solution.

Before you start this chapter, complete the basic implementation of the solution 
in “Basic Document Manager implementation” on page 239. Several components 
we reference here were created in that chapter. To complete the implementation 
of the entire solution, you also need to refer to the remaining two chapters after 
this chapter.

We cover the following advanced topics:

� Property exchanges and application integration
� Notification
� Rendition
� Dynamic search folders
� Document template

9
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9.1  Property exchanges
The Document Manager property exchange feature enables the exchange of file 
property values with the content repository. The file property values are the file 
properties of applications, such as Microsoft Office, engineering applications, 
and Lotus Notes. This feature allows the system to read or write property 
information from or to documents into the property fields within the system. The 
update occurs during the checkout and checkin actions from an integrated 
application (for example, Microsoft Word).

In this section, we show you how to configure a property exchange for Microsoft 
Word to exchange the Title attribute with Document Manager, and for Lotus 
Notes to exchange e-mail attributes, such as subject, from, and to, with 
Document Manager.

The following steps comprise the tasks required to complete this exercise:

1. “Create Microsoft Word property exchanges” on page 332
2. “Create Lotus Notes Property Exchanges” on page 333
3. Complete “Application Integration” on page 334

For all these steps, you use Document Manager Designer. To get to Document 
Designer, click Start → Programs → IBM DB2 Document Manager → 
Designer.

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Property Exchanges to select it.

9.1.1  Create Microsoft Word property exchanges
Click the New icon in the Designer title bar. Do the following:

1. In the Name field, type MS Word.

2. Set Type to MS Word, XP, 2003.

3. Set Update Mode to Automatic.

4. Populate the bottom section as shown in Figure 9-1.
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Figure 9-1   Microsoft Word property exchanges

a. Complete both Property boxes in one of these ways:

i. Type the value %Title[1,2056]%.

or

i. Click Select on the right side of Library.

ii. Select Title.

iii. Enter 256 for End Character.

iv. Click OK.

b. Set Create and Refresh fields to Yes.

c. Click Add.

5. Click OK to save the changes.

9.1.2  Create Lotus Notes Property Exchanges
Click the New icon in the Designer title bar. Do the following steps:

1. In the Name field, type Lotus Notes.
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2. Set Type to Lotus Notes.

3. Set Update Mode to Automatic.

4. Use the same techniques we discussed earlier in step 4 on page 332, 
populate the bottom section as shown in Figure 9-2.

Figure 9-2   Lotus Notes property exchanges

5. Click OK to save the changes.

9.2  Application Integration
When Document Manager integrates with an application, this means you can 
add the Document Manager commands into the application’s menu. You can 
perform document management activities within the application. For example, 
through the application integration object, you can insert Document Manager 
commands, such as Add Items, Checkout, and Checkin into Microsoft Word’s 
menu. The user, who is editing a Word document, can then perform the 
Document Manager’s Add Item command from the Word application and directly 
add the document to the Document Manager system without leaving the Word 
application. 
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ZXY Technologies employees are used to work with Microsoft Word and Lotus 
Notes to create and manage their documents. Application Integration allows 
users to upload and modify documents in Document Manager directly from 
Microsoft Word or Lotus Notes.

The Application Integration objects you need to create are listed in Table 9-1.

Table 9-1   Application integration

The following steps comprise the tasks required to complete this exercise:

1. “Create a Microsoft Word menu and submenu” on page 335
2. “Create Microsoft Word Integration” on page 337
3. “Create Lotus Notes Integration” on page 337
4. “Modify Desktop Template with Application Integration” on page 339

For all these steps, use Document Manager Designer. To get to Document 
Manager Designer, click Start → Programs → IBM DB2 Document 
Manager → Designer.

9.2.1  Create a Microsoft Word menu and submenu
In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Menus to select it. 

Create Microsoft Word menu
Do the following steps:

1. Click the New icon in the Designer title bar.

2. In the Name field, type MS Word Menu.

3. Select the Properties tab and complete the Properties page as shown in 
Figure 9-3.

Name Type Details

MS Word Integration MS Word Standard integration,
includes the Microsoft 
Word Property Exchange.

Lotus Notes Integration Lotus Notes Standard integration for 
saving messages.
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Figure 9-3   Microsoft Word Menu

4. Click OK to save the changes.

Create Microsoft Word Sub Menu
Do the following steps:

1. Click the New icon in the Designer title bar.

2. In the Name field, type MS Word Sub Menu.

3. Select Properties tab:

a. Select Sub Menu option.

b. Set Menu to the MS Word Menu you have just created.

c. Set Label to Document Manager.

d. Click Add.

4. Click OK to save the changes.
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9.2.2  Create Microsoft Word Integration
In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Application Integration to select it. Click the New icon in the 
Designer title bar. Use the following steps:

1. In the Name field, type MS Word Integration.

2. Set Type to MS Word 2000, XP, 2003.

3. Select Menu tab:

a. Set Menu type to Active.

b. Set Label to Document Manager.

c. Set Menu to MS Word Sub Menu.

d. Set Mode to Append.

e. Click Add.

4. Click OK to save the changes.

5. Expand MS Word Integration. Select the MS Word Property Exchange you 
have created before and drag it over Property Exchange under MS Word 
Integration. It should look like Figure 9-4.

Figure 9-4   Microsoft Word integration and property exchanges

9.2.3  Create Lotus Notes Integration
In the Designer, open Global - [Administrator] as before, ope the Desktop, and 
then click Application Integration to select it. Click the New icon in the 
Designer title bar. Use the following steps:

1. In the Name field, type Lotus Notes Integration.

2. Set Type to Lotus Notes.

3. Click the Menu tab and populate the Menu page as shown in Figure 9-5.
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Figure 9-5   Lotus Notes integration menu tab window

4. Click the Save Options tab and populate the Save Options page as shown 
in Figure 9-6:

a. Set Item Type to Message.

b. Set Naming to Specified and type %Subject%.

c. Set Item format to Notes document.

d. Check both Do not allow saving... and Display add dialog options.

e. Complete Form name with Memo|Reply.
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Figure 9-6   Lotus Notes integration save options tab window

5. Click the Attach Options tab and populate the Attach Options page:

Select the Prompt option button.

6. Click OK to save the changes.

7. Expand Lotus Notes Integration. Select the Lotus Notes Property 
Exchange you have created before and drag it over Property Exchange 
under Lotus Notes Integration. It should look like Figure 9-7.

Figure 9-7   Lotus Notes integration and property exchanges

9.2.4  Modify Desktop Template with Application Integration
In the Designer, open Global - [Administrator] as before, open the Desktop, 
and open the Desktop template. Use the following steps:

1. Select Content Producer Template and click the Modify icon in the 
Designer title bar.
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2. Select the Application Integration tab and complete the Application 
Integration page:

a. Select MS Word 2000, XP, and 2003 from the drop-down list Application.

b. Click Add.

c. Select Lotus Notes from the drop-down list Application.

d. Click Add.

3. Click OK to save the changes.

9.3  Notification
ZXY Technologies needs to accelerate the approval process. They want to send 
an automatic e-mail notice to Managers and Financial people when they have a 
new document to review.

The following steps comprise the tasks required to complete this exercise:

1. “Create mail notification” on page 340
2. “Create Mail Notification ProjectManager” on page 342
3. “Configure the Draft state for notification” on page 343
4. “Configure Review state for notification” on page 343

For all these steps you need to use Document Manager Designer. To get there if 
you are not there, click Start → Programs → IBM DB2 Document Manager → 
Designer.

In the Designer, open Global - [Administrator] as before, and click 
Notifications to select it. 

9.3.1  Create mail notification 
Click the New icon in the Designer title bar. Use the following steps:

1. In the Name field, type Mail Notification.

2. Set the Type field to MAPI E-mail.

3. Complete the Message tab with the Mail Subject and Body as shown in 
Figure 9-8. 

Note: Be sure the file DdmSmtp.ini under the Document Manager path has a 
valid eMail Profile. That profile is the one used to send the notifications.
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The variable %Proposal Number% inside the body will be converted to the 
Document Proposal Number the notification is sending. You need to check 
the Process Property option for that to happen.

Figure 9-8   Mail notification message tab window

4. Click the Recipients tab and complete the Recipients page. Add a 
Recipient:

a. Set Select from Specified.

b. Set Specified to usrManager@kcwb99n.almaden.ibm.com or the Manager 
e-mail address.

c. Set Address to None.

d. Click Add.

e. Repeat the previous step to add usrFinancial@kcwb99n.almaden.ibm.com 
or the Financial e-mail address.

5. Complete Application tab:

Set Email application to DdmSmtp.exe.

6. Click OK to save your entries to the system.
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9.3.2  Create Mail Notification ProjectManager
Click the New icon in the Designer title bar. Use the following steps:

1. In the Name field, type Mail Notification ProjectManager.

2. Set Type field to MAPI Email.

3. Click the Message tab and complete the Message page with the Mail Subject 
and Body as shown in Figure 9-9. 

Figure 9-9   Mail Notification ProjectManager message tab window

4. Click the Recipients tab and complete the Recipients page. Add a 
Recipient:

a. Set Select from Specified.

b. Set Specified to ursProjectManager@kcwb99n.almaden.ibm.com or the 
Project Manager e-mail address.

c. Set Address to None.

d. Click Add.

5. Click the Application tab and complete the Application page:

Set Email application to DdmSmtp.exe.

6. Click OK to save your entries to the system.
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9.3.3  Configure the Draft state for notification
For your solution, you can configure the notification for any state in your 
document life cycle. For our case study, we need to assign the ProjectManager 
mail notification created earlier with the Draft state. Once configured, all the 
documents that enter the Draft state will send a notification to the manager. 

In the Designer, open Global - [Administrator] as before, open the Desktop, 
open States and select Draft state from the tree. Use the following steps:

1. Expand Draft. You will see the folder Notifications.

2. Go to Global - [Administrator], Notification and drag Mail Notification 
ProjectManager under Draft state. It should look like Figure 9-10.

Figure 9-10   Draft state notification

9.3.4  Configure Review state for notification
Now, we need to assign the other mail notification created with the Review state. 
Once configured, all the documents that enter the review state will send a 
notification to the Financial people.

In the Designer, open Global - [Administrator] as before, open the Desktop, 
open States and select Review state from the tree. Use the following steps:

1. Expand Review. You will see the folder Notifications.

2. Go to Global - [Administrator], Notification and drag Mail Notification under 
Review state. It should look like Figure 9-11:

Figure 9-11   Review state notification
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9.3.5  Test notification
Now you can log on to Document Manager Desktop and test the following 
functionality:

� Log in the Desktop with ursViewer.
� Add a Sales Proposal document. It starts the life cycle in Draft state. In that 

state, the Notification services will run and an e-mail will be sent to the sales 
people.

� Route the document until the Review state, in that state a new notification is 
sent to the manager.

9.4  Rendition
ZXY Technologies’ employees work with Microsoft Word and Microsoft Excel for 
Proposal creation, but they want to send a PDF document to the customers. We 
configure the automatic rendition to run when the document arrives at the Issued 
state.

The following steps comprise the tasks required to complete this exercise:

1. “Create rendition output destination (PDF Sales Destination)” on page 345
2. “Create rendition object (Sales Rendition)” on page 345
3. “Associate rendition object with output destination” on page 348
4. “Configure Issued state for rendition” on page 348

For all these steps, you use Document Manager Designer. If you are not there, 
click Start → Programs → IBM DB2 Document Manager → Designer.

In the Designer, open Global - [Administrator] as before, and click Rendition 
to select it. 

Note: Before you begin, check that the following services are running:

� ICMRM server - CM Resource Manager
� DM Cache services 
� DM Lifecycle services
� DM Notification services

Note: You need an Acrobat Distiller license to use the render capability to 
create new PDF files. 
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9.4.1  Create rendition output destination (PDF Sales Destination)
Select Destinations and click the New icon in the Designer title bar. Follow these 
steps:

1. Populate top section:

a. For the Name field, type PDF Sales Destination.

b. Set Type to Library.

2. Populate bottom section:

Populate the values as shown in Figure 9-12.

Figure 9-12   PDF sales destination window

3. Click OK to save your entries to the system.

9.4.2  Create rendition object (Sales Rendition)
Select Renditions and click the New icon in the Designer title bar. Follow these 
steps:

 

 

 

 

 Chapter 9. Advanced Document Manager implementation 345



1. Populate top section:

a. In the Name field, enter Sales Rendition.

b. Set Type to PDF.

c. Set Status to Active - Client Selectable.

2. Populate the General page under the General tab like Figure 9-13.

Figure 9-13   Rendition configuration general tab

3. Click the Options tab. In the Options page, click the Printing tab. Populate 
the Printing page like Figure 9-14.

 

 

 

 

346 IBM DB2 Document Manager with IBM Records Manager Solution Guide



Figure 9-14   Rendition configuration printing tab

4. Click the PDF Generation tab and populate the PDF Generation page like 
Figure 9-15.
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Figure 9-15   Rendition configuration PDF generation tab

5. Click OK to save your entries to the system.

9.4.3  Associate rendition object with output destination
You need to associate the rendition output destination, PDF Destination, with the 
rendition you have just created, Sales Rendition. Follow these steps:

1. Select PDF Sales Destination.

2. Drag it under Sales Rendition. It should look like Figure 9-16.

Figure 9-16   Sales rendition with PDF Sales destination

9.4.4  Configure Issued state for rendition
We need to configure the Issued state with the Rendition process we have 
already created. Once configured, all the documents that enter the Issued state 
will activate the rendition process and a new PDF file will be created.
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In the Designer, open Global - [Administrator] as before, open the Desktop, 
open States, select Issued state and click the Modify icon in the Designer title 
bar. Follow these steps:

1. Select Actions tab and on the Actions page:

a. Check the option Submit renditions request.

b. Click Renditions:

i. Select Sales Rendition from the list.

ii. Click OK to close the window.

2. Click OK to save the changes.

9.4.5  Test rendition
Now you can log on to the Document Manager Desktop and test the following 
functionality:

� Log in Desktop with ursViewer.
� Add a Sales Proposal document. Route the document until the Issued state. 

In that state, the rendition services run and a new PDF file appears in the 
PDF state.

9.5  Dynamic search folders
Dynamic search folders are components that allow users to run a stored search 
by only clicking the dynamic search folder Name. These folders are displayed to 
the users in the Document Manager Desktop client’s left panel. You can see 
some examples in Figure 9-17.

Note: Before you begin, check that the following services are running:

� ICMRM server - CM Resource Manager
� DM Cache services 
� DM Lifecycle services
� DM Rendition services
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Figure 9-17   Dynamic search folder examples

In this example, when users click Correspondence folder, Document Manager 
will run a stored search that looks for all the correspondence documents. The 
result will be shown in the right panel.

The following steps comprise the tasks required to complete this exercise:

1. “Create dynamic search folder item type (LibraryObjects)” on page 350
2. “Create dynamic search folder class object (Saved Searches)” on page 352
3. “Create Saved Searches dynamic search folder” on page 356
4. “Create Sales Proposal dynamic search folder” on page 358

9.5.1  Create dynamic search folder item type (LibraryObjects)
All the searches that the user needs to store will be stored in the LibraryObjects 
item type, inside the Saved Searches Stateless Class.

You need to follow the same procedures you follow to create the CustomerData 
item type (“Basic Document Manager implementation” on page 239, 
CustomerData item type) to create the second item type named LibraryObjects 
with the characteristics listed in Table 9-2.

Table 9-2   LibraryObjects item type definition

Option Settings

Name LibraryObjects

Display Name LibraryObjects

Version Policy Promp to Create

Maximum total versions Unlimited

Item type classification Document
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You need to use Content Manager System Administration Client to define it. If 
you are not there, click Start → Programs → IBM DB2 Content Manager 
Enterprise Edition → System administration client.

Select Data Modeling, right-click Item Types, and select New from the context 
menu. This displays the New Item Type Definition dialog.

The Attribute tab looks like Figure 9-18.

Figure 9-18   LibraryObjects item type attributes tab window

Text Search Text searchable enabled

Item retention period Forever

Attributes Used All listed in Table 7-10, “Before 
installation” on page 188

Records Enabled No

Option Settings 
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9.5.2  Create dynamic search folder class object (Saved Searches)
In a previous section, we created a LibraryObject item type. Now we have to 
define a Saved Search Class to store all the predefined searches the users need 
to look for.

To do this, create the following:

� “Views” on page 352
� “Searches” on page 353
� “Action and dialog object (Saved Search - add)” on page 355
� “Stateless class (Saved Searches)” on page 355
� “Associate dialogs: Add and Modify” on page 355

Views
The view you create here is used to display the Saved Search Class documents.

You need to use Document Manager Designer to create a View. If you are not 
there, click Start → Programs → IBM DB2 Document Manager → Designer.

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Views to select it. 

Create Default view
Click the Add icon in the Designer title bar. Follow these steps:

1. In the Name field, type Default.

2. Populate the Display tab.

In the left panel is a list of the Library Properties for the system. Select the 
properties as shown in Figure 9-19 and add them to the Selected Properties 
panel on the right side of the dialog.
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Figure 9-19   Default View display tab

3. Click OK to save your changes.

Searches
The search you create here is used to look for Saved Search Class documents.

You use Document Manager Designer to create a View. If you are not there, click 
Start → Programs → IBM DB2 Document Manager → Designer.

In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Searches to select it.

Create General Document Search
Click the New icon in the Designer title bar. Follow these steps:

1. In the Name field, type Default.

2. Click the Properties tab and complete the Properties page.

a. Add first property:

i. Click Add - This presents a dialog that enables you to add the 
searchable document properties to the search dialog you are building.

ii. Select Edit for the field Type from the drop-down list.
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iii. Select Title from the Property field drop-down list.

iv. Select Contains for the Default Operator from the drop-down list.

v. Click OK, which adds the command to the menu.

b. Repeat the previous step to add the properties listed in Table 9-3.

Table 9-3   Default search properties

It should look like Figure 9-20.

Figure 9-20   Default search property window

3. Preview the dialog and then close it.

4. Click OK to post the search configuration to the repository.

Property Control Type Default Operator

Title Edit Contains

Class Edit Contains

State Edit Contains

Filename Edit Contains
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Action and dialog object (Saved Search - add)
In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Actions and Dialogs to select it. Click the Add icon in the 
Designer title bar. Follow these steps:

1. In the Name field, type Saved Search - Add.

2. In the Dialog tab: 

a. Select the Display dialog to user option.

3. Populate the Top Section tab. Add a Property:

Add the Title property. Leave String for the Data Type and Change Color to 
red.

4. Click Preview. This should display a preview of the dialog box.

5. Leave all the options in the Options tab on the Options page with the value 
No.

6. Click Preview. This should display a preview of the dialog. You can change 
the windows’ Width and Height options if you want to modify the dimensions.

7. Click OK to save the changes.

8. Under Saved Search - Add, expand Group. Click the New icon in the 
Designer title bar. Add the groups:

– grpSales
– grpServices
– grpMarketing
– grpViewer
– grpManagers
– grpFinancial

Stateless class (Saved Searches)
In the Designer, open Global - [Administrator] as before, open the Desktop, 
open Item Type, open the LibraryObjects item type. Select Classes and click 
the New icon in the Designer title bar. Follow these steps:

1. Populate the top section of the window.

a. In the Name field, type Saved Searches.

b. In the Type pick-list, select Stateless.

2. Click OK to save the changes.

Associate dialogs: Add and Modify
Expand the Saved Searches Class. You will see the folder Actions and 
Dialogs. Follow these steps:
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1. Go to Desktop, Actions and Dialogs and select Saved Search- Add dialog.

2. Drag it to the Actions and Dialogs folder under Saved Searches Class.

It should look like Figure 9-21.

Figure 9-21   Saved searches action window

9.5.3  Create Saved Searches dynamic search folder

You can create folders and dynamic search folders from the Document Manager 
Desktop client.

To create a dynamic search folder, you need to create a power search and save 
it. The dynamic search folder will reference that saved search. Follow these 
instructions:

1. Click the Power Search icon in the top toolbar.

2. Click on the General tab and populate the General page as shown in 
Figure 9-22.

Figure 9-22   Power search configuration window
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3. Click on the Library tab and populate the Library page: 

a. Uncheck Search all item types.

b. Click Add and select LibraryObject item type. Click Apply.

4. Click Save. A new dialog box will display.

5. Select Saved Search and set Title to Saved Searches as shown in 
Figure 9-23.

Figure 9-23   Save search add dialog box

6. Click Apply to save the search.

7. Click Folder submenu, Folder Administration menu. 

8. Select Corporate Library and click the New icon.

9. Create the Saved Searches dynamic folder as shown in Figure 9-24.
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Figure 9-24   Draft dynamic folder configuration

10.Click Apply and Done to save the changes.

9.5.4  Create Sales Proposal dynamic search folder
ZYX Technologies need a dynamic search folder for each proposal state, so 
users can quickly access the document in life cycle.

You can create a dynamic search folder from the Document Manager Desktop 
client. Follow these instructions:

1. Click the Power Search icon in top toolbar.

2. Click on the General tab and populate the General page as shown in 
Figure 9-25.
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Figure 9-25   Power search configuration window

3. Click on the Library tab and populate the Library page:

a. Uncheck Search all item types.

b. Click Add and select CustomerData item type. Click Apply.

4. Click Save. A new dialog box displays.

5. Select Saved Search and set Title to Sales Proposal Draft state as shown 
in Figure 9-26.

Figure 9-26   Save search add dialog box

6. Click Apply to save the search.
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7. Repeat the process to create saved searches for Review, Approval, Issued, 
and PDF states.

Then, you need to create the dynamic search folders configuration window that 
looks like Figure 9-27:

Figure 9-27   Dynamic search folders configuration window

1. Click Folder submenu, Folder Administration menu. 

2. Select Corporate Library and click the New icon.

3. Create the Sales Proposal standard folder as shown in Figure 9-28.
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Figure 9-28   Sales proposal standard folder configuration

4. Click Apply and Done to save the changes.

5. Select Sales Proposal folder you have just created and click the New icon.

6. Create Draft dynamic folder as shown in Figure 9-29.
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Figure 9-29   Draft dynamic folder configuration

7. Click Apply and Done to save the changes.

8. Select Draft dynamic search folder you have just created. Click the Modify 
icon.

9. Click the Security tab and populate the Security page as shown in 
Figure 9-30.
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Figure 9-30   Dynamic search folder security

10.Click Apply and Done to save the changes.

11.Repeat the process to create dynamic folders for Review, Approval, Issued, 
and PDF saved searches.

9.6  Document template
Document templates are used to store documents that users use to create new 
documents.

For our solution, we need to define a new Sales Proposal document template. 
When salespeople need to create new proposals, they do not need to create 
them from scratch. They can select to create proposals from the template, which 
contains the basic structure for a new proposal document.

To store templates, we need to create a Document Template Class. We will use 
the same LibraryObject item type created to store Saved Searches. 
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The following steps comprise the tasks required to complete this exercise:

1. “Document template objects” on page 364
2. “Add a new document in the Document Template class” on page 365
3. “Create a new item template (Sales Proposal)” on page 366
4. “Modify Main menu to add Template Sub Menu” on page 366

For all these steps you need to use Document Manager Designer. If you are not 
there, click Start → Programs → IBM DB2 Document Manager → Designer.

9.6.1  Document template objects
In a previous section, we created a LibraryObject item type. Now we have to 
define a Document Template Class to store all the documents the users need to 
use as a template.

You need to perform the following tasks:

1. “Create action and dialog (Document Template - add action)” on page 364
2. “Create the stateless class (Document Template)” on page 365
3. “Associate action and dialogs: Add and Modify” on page 365

Create action and dialog (Document Template - add action)
In the Designer, open Global - [Administrator] as before, open the Desktop, 
and then click Actions and Dialogs to select it. Click the Add icon in the 
Designer title bar. Follow these steps:

1. In the Name field, type Document Template - Add.

2. In the Dialog tab: 

Select the Display dialog to user option.

3. Click the Top Section tab and populate the Top Section page. Add a 
Property:

Add the Title property. Leave String for the Data Type and Change Color to 
red.

4. Click Preview. This should display a preview of the dialog box.

5. Leave all the options in the Options tab on the Options page with the value 
No.

Note: If you have not created the LibraryObjects item type, follow the 
instructions in 9.5.1, “Create dynamic search folder item type (LibraryObjects)” 
on page 350.
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6. Click Preview. This should display a preview of the dialog. You can change 
the windows’ Width and Height options if you want to modify the dimensions.

7. Click OK to save the changes.

8. Under Document Template - Add, expand Group. Click the New icon in the 
Designer title bar. Add the groups:

– grpSales
– grpServices
– grpMarketing
– grpViewer
– grpManagers
– grpFinancial

Create the stateless class (Document Template)
In the Designer, open Global - [Administrator] as before, open the Desktop, 
open Item Type, open the LibraryObjects item type. Select Classes and click 
the New icon in the Designer title bar. Follow these steps:

1. Populate the top section of the window:

a. In the Name field, type Document Template.

b. In the Type pick-list, select Stateless.

2. Click OK to save the changes.

Associate action and dialogs: Add and Modify
Expand the Document Template Class. You will see the folder Actions and 
Dialogs. Follow these steps:

1. Go to Desktop, Actions and Dialogs and select Document Template - Add 
dialog.

2. Drag it to the Actions and Dialogs folder under Document Template Class.

9.6.2  Add a new document in the Document Template class
You need to upload in Document Manager the document you will associate as a 
template. Follow this instructions:

1. Log on to Document Manager Desktop as usrSale.

2. Click Add Document.

3. Select the document that you will use as a template from the file system.

4. Click Open.

5. Select Document Template for class.
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6. Enter the document name you want to identify the document.

7. Click Apply.

9.6.3  Create a new item template (Sales Proposal)
In the Designer, open Global - [Administrator], open the Desktop, and then 
click New Item template to select it. Click the Add icon in the Designer title bar. 
The New Item template window opens. Follow these steps:

1. Configure the Item Template as shown in Figure 9-31.

Figure 9-31   Item template window

2. Click OK to save the changes.

9.6.4  Modify Main menu to add Template Sub Menu
You need to modify the Main menu to add the Template sub menu on it. Follow 
these steps:

1. You need to create a new menu call Template. In the Designer, open Global 
- [Administrator], open Desktop, and then click Menus to select it. Click the 
New icon in the Designer title bar.

2. Configure the menu as shown in Figure 9-32.
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Figure 9-32   Template Menu

To assign Doc ID, you need to click Browse and search the document you 
want to assign to the sales template. This should be the one you upload in 
9.6.2, “Add a new document in the Document Template class” on page 365.

3. Click OK to save the changes.

4. Add Template menu as a sub menu of Main menu:

In the Designer, open Global - [Administrator] as before, open the 
Desktop, and then click Menu to select it. Select Main menu and click the 
Modify icon in the Designer title bar. Add the Template menu created before 
as Sub Menu.

5. Click OK to save the changes.

This concludes the implementation of the Document Manager system. For the 
next two chapters, we cover how to add Records Manager functions and options 
into the system.

Note: You need to log on to the Document Manager Desktop first. Click 
the Browse button.
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Chapter 10. Records Manager 
implementation in the 
Document Manager solution

This chapter provides practical steps to implement Records Manager functions 
for a Document Manager (DM) solution, using the ZXY Technologies case study. 
We describe how to create a file plan from scratch, associating security and 
classification rules. We show you how to enable an item type for record 
declaration and how it is integrated with Document Manager.

We cover the following topics:

� Records Manager configuration.

Create view and components, add relationship properties, auto classify rules, 
import users, and assign system component permission.

� Enable item types for records declaration.

Create attribute mapping.

� Configure DM classes for records declaration.

Quick automatic declaration, and by selection declaration.

10
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10.1  Records Manager configuration
Before adding any Records Manager functions to a Document Manager solution, 
configure Records Manager.

For ZXY Technologies, create and configure a file plan that will hold all the 
company documents related to proposals. 

The following steps comprise the tasks required to complete this exercise:

1. “Views” on page 370
2. “Components” on page 372
3. “Add relationship properties” on page 373
4. “Building the file plan” on page 376
5. “Auto classify rules” on page 379
6. “Import users” on page 381
7. “Assign system components permissions” on page 382

For all these steps, use Records Manager Administrator client. If you are not 
there, click Start → Programs → IBM DB2 Records Manager → 
Administrator. Log in as Administrator.

10.1.1  Views
For our solution, we create three kinds of views:

� The first view is a hierarchical view used to organize the ZXY Technologies’ 
file plan for documents related to proposals.

� The second view is used to create links between documents inside the file 
plan. We use this view to create links between the original Microsoft Word 
documents and the PDF created in the rendition process.

Note: Before you begin with the case study implementation, you must have 
your server already installed and configured with the base configuration. If you 
have not done that, refer to “Installation and configuration” on page 151.

Note: Before beginning, check that the following services are running:

� Records Manager server
� Records Manager Enabler server
� ICMRM server - CM Resource Manager
� DM Cache services 
� DM Lifecycle services
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� The last view is used to create a set of related documents. We use this to put 
together several versions of the same document.

Depending on how you want to set up your Records Manager configuration, you 
may not need to create all three views; but at the minimum, you must create a 
hierarchical view for your system.

From the Records Manager Administrator client, select File Plan Design, and 
then click Views. You need to create the views shown in Figure 10-1.

Figure 10-1   Records Manager Views configuration window

We create the following three views:

� ZXY Technologies
� Proposal to PDF 
� Proposal Version 

ZXY Technologies 
This view defines the hierarchy between the components in the file plan. You 
have to create ZXY Technologies view now and later add the relationships. 
Follow these instructions:

1. Click Add in the documents pane.
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2. Set View Name to ZXY Technologies.
3. Set View Type to Hierarchical.
4. Click Save. Click Close.

Proposal to PDF 
This view defines a cross reference link between two components inside the file 
plan. Follow these instructions:

1. Click Add in the documents pane.
2. Set View Name to Proposal to PDF.
3. Set View Type to Link.
4. Click Save. Click Close.

Proposal Version 
This view defines a set that associates different proposal versions with each 
other. Follow these instructions:

1. Click Add in the documents pane.
2. Set View Name to Proposal Version.
3. Set View Type to Set.
4. Click Save. Click Close.

10.1.2  Components
You need to create each component that will be part of the file plan. These 
components are the documents and all the folders inside the hierarchy.

In the Records Manager administrator client, select File Plan Design, and then 
click Components. You need to create the components shown in Figure 10-2. 

Figure 10-2   Records Manager Components configuration window

To create it, follow these instructions:

1. Click Add in the component panel.
2. Set Component Definition Name to Department.
3. Set Component Definition Type to Component.
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4. Set Primary View ID to ZXY Technologies.
5. Click Save. Click Close.

Repeat the same procedure for the rest of the components. Be sure to select 
component or records in Component Definition Type option according to 
Figure 10-2.

10.1.3  Add relationship properties
Now that you have defined all the components of your file plan, you need to 
associate all to create the hierarchy you need.

In the Records Manager administrator client, select File Plan Design, and then 
click Views. You need to edit the ZXY Technologies views to add the hierarchy 
relationships. 

Configure ZXY Technologies view:

1. Select the View/Relationship Properties icon next to ZXY Technologies 
view.

2. Configure the relationships as shown in Figure 10-3.
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Figure 10-3   ZYX Technologies relationships

Configure Proposal to PDF view:

1. Select the View/Relationship Properties icon next to Proposal to PDF 
view.

2. Configure the relationships as shown in Figure 10-4.
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Figure 10-4   Proposal to PDF relationships

Configure Proposal Version view:

1. Select the View/Relationship Properties icon next to Proposal Version 
view.

2. Configure the relationships as shown in Figure 10-5.

 

 

 

 

 Chapter 10. Records Manager implementation in the Document Manager solution 375



Figure 10-5   Proposal version relationships

10.1.4  Building the file plan
After the view, the file plan component definitions, and the relationships that form 
the hierarchy, have been built, build the file plan by creating instances of the file 
plan component definitions. When you add instances of the file plan component 
definition, for example, Departments, you must provide values for the attributes 
defined in the component definition. After you build the file plan, you can 
navigate through its hierarchies and add, edit, or delete any file plan component.

Create the following file plan component instances:

View ZXY Technologies

Department Sales, Services, and Marketing

In the Records Manager administrator client, select File Plan Administration.

Add a new instance of Department, Sales, to the file plan:

1. Select the Add icon next to ZXY Technologies view.

2. Set Department Name to Sales.

3. Set Department Code to 00001.

4. Set Department Title to Sales Department for ZXY Technologies (see 
Figure 10-6).
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5. Click Save. Click Close.

Figure 10-6   Add a new instance of Department, Sales, to the file plan

Add a new instance of Department, Services, to the file plan:

1. Select the Add icon next to ZXY Technologies view.
2. Set Department Name to Services.
3. Set Department Code to 00002.
4. Set Department Title to Services Department for ZXY Technologies. 
5. Click Save. Click Close.

Add a new instance of Department, Marketing, to the file plan:

1. Select the Add icon next to ZXY Technologies view.
2. Set Department Name to Marketing.
3. Set Department Code to 00003.
4. Set Department Title to Marketing Department for ZXY Technologies. 
5. Click Save. Click Close.

Once you have added the three instances, from the Records Manager 
administrator client, File Plan Administration, click the ZXY Technologies link. 
You should see the created file plan as shown in Figure 10-7.
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Figure 10-7   Instances of Departments in the file plan for the case study

For this case study, new instances of Proposals under various Departments are 
created when a new proposal is in the system. At this point, you do not need to 
create any of them. 

If you do need to create new proposals to the file plan, you can use the following 
steps as reference:

From the Records Manager administrator client, select File Plan Administration, 
click ZXY Technologies link, and do the following:

1. Select Actions link next to Sales (or Services or Marketing).
2. Select Add Proposal link.
3. Enter the appropriate information.
4. Click Save. Click Close.

Figure 10-8 shows the file plan for the case study for your reference.
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Figure 10-8   File plan for the case study

Once the file plan is created down to the Record Containers (Proposals), you can 
create records in the file plan through the Declare and Classify processes.

10.1.5  Auto classify rules
The Records Manager administrator needs to create new rules to associate 
records with the Proposal component. These are the rules that decide the 
destination inside the file plan of all the documents declared with Automatic 
Quick Declare in Document Manager.

For example:

1. Proposal number 00071 is created inside Document Manager and a 
notification e-mail is sent to a project manager. 

2. The project manager logs into Record Manager and creates a Proposal 
component named Proposal00071.

3. He also create an Auto classify rule that associates new documents with 
proposal number 00071 to the Proposal00071 component.
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For each proposal component, a project manager needs to create the rules listed 
in Figure 10-9.

Figure 10-9   Auto classify window

In the Records Manager administrator client, select Tools, and then click Auto 
Classify. Use the configuration shown in Figure 10-10 to create the proposal, 
correspondence, and RFP rules.
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Figure 10-10   Auto Classify example window

10.1.6  Import users
In the Records Manager administrator client, select Security, and then click 
Users. You need to import all the users who will have the right to declare, 
classify, link, and view records.

Note: If this is a production environment, we might create an application 
dialog to combine and simplify the processes of creating a new proposal 
container and its associated auto classify rule. This requires the use of the 
Records Manager APIs. Or alternatively, create a logic extension in the 
Records Manager engine to automatically create an auto classify rule when 
you add a new proposal container.
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For ZXY Technologies, we need to import the users listed in Figure 10-11. Be 
sure to select ICMNLSDB Host Filter.

Figure 10-11   Import users window

Once users are imported from Content Manager to Records Manager, select the 
View/Edit properties icon next to each user and do the following:

1. Select File Plan Administration.
2. Select Is Active.
3. Click Save. Click Cancel to close the windows.

10.1.7  Assign system components permissions
In our solution, we have given ICMADMIN administrative right in Records 
Manager. This means ICMADMIN is a member of the Local Administrator group. 
When you grant system permissions to the users imported from Content 
Manager, ICMNLSDB, do not include ICMADMIN since it already has all the 
permissions assigned.

Table 10-1 describes the available permissions.

Table 10-1   File plan component access control selections

Permissions Description

Add To add a file plan component of a particular type.
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In the Records Manager administrator client, select Security, and then click 
System permissions. Select all the objects and click Permissions. Do the 
following:

Update To modify an existing file plan component of a particular type.
If the file plan component type is record type, users with this 
permission can modify the record’s metadata. 

Delete To remove a file plan component of a particular type from the file 
plan. If the file plan component type is record type, users with this 
permission can undeclare a record.

View To see the profile of a file plan component of a particular type. 
Users who cannot view a file plan component will not know of its 
existence in the file plan.

Suspend To suspend a file plan component from transitioning through life 
cycle.

Unsuspend To remove a suspension from a file plan component and allow it to 
continue through its life cycle.

Move To move a file plan component from one place to another.

Change 
Permissions

To alter the permissions assigned to a particular file plan component.

Reserve To reserve a file plan component for yourself.

Add Link To add a link.

Delete Link To delete a link.

Charge Out To charge out a file plan component to yourself, or to someone else.

Host Retrieve To retrieve a record to a user’s workspace on their computer when 
the file plan component represents a record stored in an adjoining 
host application. This permission is stored in Records Manager for 
information purposes only, since Records Manager cannot directly 
control whether an adjoining application allows a user to retrieve a 
document.
Important: For the Document Manager solution with Records 
Manager and Content Manager, the Host Retrieve permission 
enables the Content Manager or Document Manager users to see 
documents after they are declared as records. You must grant Host 
Retrieve permission if you want users to view the declared records. 
Without this permission, users would not be able to search or view 
these documents. For more explanation, see “Access control of a 
declared record document” on page 131.

Permissions Description 
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1. Select ICMNLSDB from Host.

2. Click Go. The Access list will display.

3. Configure Department: 

a. Leave ICMADMIN rights.

b. Give the rest of the users View rights.

4. Configure Proposal:

a. Leave ICMADMIN rights.

b. Give usrProjectManager Add, Update, Add Link, and View rights.

c. Give the rest of the users View rights.

5. Configure Proposal Document:

a. Leave ICMADMIN rights.

b. Give usrConsultant, usrMarketing, and usrSale Add, Add Link, View, 
and Host retrieve rights.

c. Give usrProjectManager Add, Update, Add Link, View, and Host retrieve 
rights.

d. Give the rest of the users View and Host retrieve rights.

6. Configure Correspondence:

a. Leave ICMADMIN rights.

b. Give usrConsultant, usrMarketing, and usrSale Add, Add Link, View, 
and Host retrieve rights.

c. Give usrProjectManager Add, Update, Add Link, View, and Host retrieve 
rights.

d. Give the rest of the users View and Host retrieve rights.

7. Configure Request for Proposal:

a. Leave ICMADMIN rights.

b. Give usrConsultant, usrMarketing, and usrSale Add, Add Link, View, 
and Host retrieve rights.

c. Give usrProjectManager Add, Update, Add Link, View, and Host retrieve 
rights.

d. Give the rest of the users View and Host retrieve rights.
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10.2  Enable item types for records declaration
For the item type that stores documents in your solution, if you need to declare 
these documents to be records later, you must enable the item type for records 
declaration.

For the ZXY Technologies, we need to enable CustomerData item type for 
records declaration. 

The following steps comprise the tasks required to complete this exercise:

1. “Enable CustomerData item type” on page 385
2. “Attribute mapping” on page 386

For all these steps, you need to use the IBM DB2 Content Manager Records 
Enabler administration client. If you are not there, click Start → Programs → 
IBM DB2 Content Manager Records Enabler → Administration Client.

10.2.1  Enable CustomerData item type
To enable CustomerData item type, do the following:

1. Select eRecord enable Item Type from the left panel. A list of Content 
Manager Item Types should display.

2. Select CustomerData Item Type from the list.

3. Select Proposal Document from the Record type pick-list.

4. Click Enable at the top. After that, It should look like Figure 10-12.
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Figure 10-12   eRecord enable Item Type window

10.2.2  Attribute mapping
You need to map the attributes for each file plan you define. The ZXY 
Technologies design is listed in Table 10-2.

Table 10-2   Records Manager Enabler attributes mapping

Follow these steps to configure the file plan mapping attributes:

1. Select Attribute Mapping from the left panel. 

File Plan IRM Attribute CM Attribute

Proposal Document Document Name Proposal Subject

Proposal Document Proposal Number Proposal Number

Request for Proposal Document Name Mail Subject

Request for Proposal Proposal Number Proposal Number

Correspondence Document Name Mail Subject

Correspondence Proposal Number Proposal Number
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2. Select Proposal Document from the Record type pick-list and click Add 
Mapping.

3. You need to configure your mapping attributes from Table 10-2 as shown in 
Figure 10-13.

Figure 10-13   Attribute mapping window

4. Repeat the two previous steps for Correspondence and Request For 
Proposal File Plans. Use the mapping attributes in Table 10-2 on page 386.

10.3  Configure DM classes for records declaration
You need to configure the Document Manager classes you have created in the 
previous chapter to allow records declaration.

The following steps comprise the tasks required to complete this exercise:

1. “Configure document classes for records declaration” on page 388
2. “Configure Correspondence class for records declaration” on page 391
3. “Configure Reference Documents class for record declaration” on page 394
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For all these steps, you need to use Document Manager Designer client. If you 
are not there, click Start → Programs → IBM DB2 Document Manager → 
Designer.

10.3.1  Configure document classes for records declaration
For document classes that will store declared documents, you need to enable 
these document classes for records declaration.

For ZXY Technologies, you need to modify the Sales, Marketing, and Services 
Proposal classes you have already defined to enable them for records 
declaration. We show you how to configure the Sales Proposal. You need to 
repeat the same procedure for the other proposal classes.

ZXY Technologies requires that all the Proposal documents be automatically 
declared when they transition to the Issued state. This means there is no user 
intervention during the record classification step.

The auto classify rules are already defined on “Auto classify rules” on page 379; 
therefore, the proposal documents will be properly classified during the 
declaration step.

For this exercise, you need to:

� Configure Sales Proposal class.
� Configure the Issued state.

Configure Sales Proposal class
In the Designer, open Global - [Administrator], open the Desktop, open Item 
Type, open CustomerData item type, open Classes, select Sales Proposal 
class and click the Modify icon in the Designer title bar. Do the following:

1. Select the Records Management tab and on the Records Management 
page as shown in Figure 10-14:

a. Be sure Quick Declare desktop classification is set to Auto. 
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Figure 10-14   Sales proposal records manager tab window

2. Click OK to save the changes.

Configure the Issued state
In the Designer, open Global - [Administrator] as before, open the Desktop, 
open States, select Issued state, and click the Modify icon in the Designer title 
bar. Do the following:

1. Click the Library tab and complete the Library page as shown in 
Figure 10-14:

a. Select Declare Item of record.
a. Select Use Class Settings.
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Figure 10-15   Issued state library tab window

2. Click OK to save the changes.

Test your system: Records declaration
Now you can log on to Document Manager Desktop and test the following 
functionality with Sales Proposal class:

1. Log on to the Desktop with usrSale.

2. Add a new Sales Proposal document.

3. Transition the document through the entire life cycle and check if it becomes 
automatically declared when it arrives at the Issued state.

Note: Before beginning, check that the following services are running:

� Records Manager Server
� Records Manager Enabler Server
� ICMRM server - CM Resource Manager
� DM Cache services 
� DM Lifecycle services
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10.3.2  Configure Correspondence class for records declaration
You need to modify the Correspondence class you have already defined to allow 
records declaration.

ZXY Technologies requires that all the Correspondence documents be 
automatically declared when they transition to the Incoming or Outgoing states. 
That means there is no user intervention during the record classification step.

The auto classify rules are already defined on “Auto classify rules” on page 379; 
therefore, the correspondence documents will be properly classified during the 
declaration step.

For this exercise, you need:

� Configure Correspondence Class.
� Configure Incoming and Outgoing State.

Configure Correspondence Class
In the Designer, open Global - [Administrator], open the Desktop, open Item 
Type, open CustomerData item type, open Classes, select Correspondence 
class and click the Modify icon in the Designer title bar. Do the following:

1. Click the Records Management tab and complete the Records 
Management page as shown in Figure 10-16:

a. Be sure Quick Declare desktop classification is set to Auto. 
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Figure 10-16   Correspondence records manager tab window

2. Click OK to save the changes.

Configure Incoming and Outgoing State
In the Designer, open Global - [Administrator] as before, open the Desktop, 
open States, select Incoming state and click the Modify icon in the Designer 
title bar. Do the following:

1. Click the Library tab and complete the Library page as shown in 
Figure 10-17:

a. Select Declare Item of record.
a. Select Use Class Settings.
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Figure 10-17   Incoming state library tab window

2. Click OK to save the changes.

3. Follow Step 1 and Step 2 to modify the Outgoing state.

Test your system: Records declaration
Now you can log on to Document Manager Desktop and test the following 
functionality with Correspondence class:

1. Log on to the Desktop with usrSale.

2. Add a new Correspondence document and associate it with Incoming or 
Outgoing State. Check if it becomes automatically declared once loaded.

Note: Before beginning, check that the following services are running:

� Records Manager Server
� Records Manager Enabler Server
� ICMRM server - CM Resource Manager
� DM Cache services 
� DM Lifecycle services
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10.3.3  Configure Reference Documents class for record declaration
You need to modify the Reference Documents classes you have already defined 
to allow record declaration.

Since ZXY Technologies does not need all the Reference Documents to be 
automatically declared, users will decide if each document needs to be declared. 
When users declare documents as records, the users will select from a 
predefined list of file plan destinations. We show you how to configure by 
selection declaration.

Configure Reference Documents Class
In the Designer, open Global - [Administrator], open Desktop, open Item 
Type, open CustomerData item type, open Classes, select Reference 
Documents class and click the Modify icon in the Designer title bar. Do the 
following:

1. Select the Records Management tab and complete the Records 
Management page: 

a. Set Quick Declare desktop classification to Selection. 

b. Click Classifications. The Records Management Selection List window 
opens. Here you need to create the list of possible file plan destinations. 
We are going to add only one possible destination as an example. Follow 
these instructions:

i. Click Add. A new window with the file plan navigation opens.

ii. Select from the tree Unclassified Proposals and set Proposal 
Document in the Records Type drop box as shown in Figure 10-18.
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Figure 10-18   Records management classification window

i. Click Apply. Then, click OK.

c. Select from the Related items declared list, the following entries:

• Children
• Peers
• OLE

d. The class configuration should look like Figure 10-19.
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Figure 10-19   Reference documents records manager tab window

2. Click OK to save the changes.

Test your system: Records declaration
Now you can log on to Document Manager Desktop and test the following 
functionality with Reference Documents class:

1. Log on to Desktop with usrSale.

2. Create a new Reference Document.

3. Search for it, right-click, and select by Selection Quick Declare.

4. Create a new Reference Document with a compound document. Search 
for them and select the father. Right-click and select by Selection Quick 
Declare. Both father and children must be automatically declared. Inside 
Records Manager file plan both documents are created as one record.
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Important: Before beginning, check that the following services are running:

� Records Manager server
� Records Manager Enabler server
� ICMRM server - CM Resource Manager
� DM Cache services 
� DM Lifecycle services
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Chapter 11. Other record declaration 
options in Document 
Manager solution

This chapter provides alternative Records Manager implementation options for 
the ZXY Technologies case study solution. Utilizing the file plan created in 
“Advanced Document Manager implementation” on page 331, we show you 
different Document Manager and Records Manager integrations that you can use 
to meet your customers’ needs.

We cover the following topics:

� Different ways to create a record
� Automatic quick declare
� By Selection quick declare
� By properties quick declare
� Automation services declaration
� Manual declare (Profile, Defaults configuration)
� Create a Records Manager link
� Create a Records Manager set

11
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11.1  Different ways to create a record
For ZXY Technologies, we used automatic quick declare that activates during 
transitions between states, and by selection quick declare that activates 
manually from the desktop menu.

There are other ways to configure how a document becomes a record. Here we 
describe alternative configurations, so you can select the best for your needs.

You can create a Record in the following ways:

� During transitions between States: By clicking the Library tab inside the state 
and completing the Library page, you can select Use Class Settings or Use 
Specific Classification.

If you select the first option, the records process uses the configuration in the 
Record Manager tab, Quick Declare Desktop Classification option inside 
the class.

� In the Add dialog box: In the Options tab inside Add dialog, the option 
Process Declare command allow you to select a Manual declare or Quick 
declare command. We show you how to configure the Add dialog box in “By 
properties quick declare” on page 402. 

� Automation Services Declaration: You can configure an automation 
process job to select a document without record declaration and declare it 
automatically. To read more, go to “Automation services declaration” on 
page 407.

� From the Desktop menu: The user can select a document inside the desktop, 
click Right Click and select Records submenu. Both Manual declare or 
Quick declare commands are in Records submenu. You can see the pop-up 
menu in Figure 11-1.

Note: We show you how to configure each record option. If you want to read 
an introduction about each one, refer to “Records Manager options in 
Document Manager” on page 77.
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Figure 11-1   Records Manager pop-up menu

� Declare a version history record: Users can declare a previous version 
document. To do that, users need to select the document. Right-click and 
select Version History. You can see the menu in Figure 11-1.

Version history windows open. User can select the version they want to 
declare, right-click, and select the Records Menu submenu. You can see it in 
Figure 11-2.

Figure 11-2   Version history declaration
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11.2  Automatic quick declare
Automatic declaration uses the rules you define in Records Manager to 
automatically classify the documents during declaration.

For our solution, we use quick auto declare functionality to do record declaration 
for the Proposal, Correspondence, and Request for proposal documents. These 
documents are automatically declared as records when they transition to the 
Issued, Incoming, or Outgoing states.

Refer to “Configure document classes for records declaration” on page 388 to 
learn more about automatic declaration.

11.3  By Selection quick declare
By selection declaration uses a list of predefined classification paths in the 
Document Manager Class to display the available destinations inside the file plan 
to the user. 

For ZYX Technologies Reference Documents class, we use quick selection 
declare functionality, so users can select a document, right-click, and select 
Quick Declare to create a record.

Refer to “Configure Reference Documents class for record declaration” on 
page 394 to learn more about it.

11.4  By properties quick declare
By properties quick declare option uses the Document Manager Class properties 
to specify the classification path where the document is to be declared. 

We use the Sales Proposal in our solution to show you one way of using this 
method to declare and classify.

The following steps comprise the tasks required to complete this exercise.

1. “Create Document Manager properties” on page 403
2. “Add the properties to your item type” on page 403
3. “Create CVL list and links” on page 404
4. “Modify your Add dialog box” on page 406
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For all these steps, you need to use Document Manager Designer. If you are not 
there, click Start → Programs → IBM DB2 Document Manager → Designer.

11.4.1  Create Document Manager properties
We need to create two properties:

� File Plan Location: Holds the classification path
� Records Type: Holds the records classification, such as Proposal 

Documents, Correspondence, or Request for Proposal.

In the Designer, open Global - [Administrator] and select Library Properties. 
Click the New icon in the Designer title bar - the New - Library Property 
Configuration window opens. Create the Properties listed in Table 11-1.

For instructions about how to create the library properties, refer to “Create library 
properties” on page 246. 

Table 11-1   Quick declare library properties

11.4.2  Add the properties to your item type
In the Designer, open Global - [Administrator], select Desktop, then expand 
Item Type, and select CustomerData Item Type. Click the Modify icon in the 
Designer title bar. Do the following:

1. Add the properties listed in Table 11-1 to CustomerData Item Type.

2. Click OK to save the changes.

Note: Before you begin, check that the following services are running:

� Records Manager Server
� Records Manager Enabler Server
� ICMRM server - CM Resource Manager
� DM Cache services 
� DM Lifecycle services

Name Display name Attribute type Character 
type

Character 
length

FilePlanLocation File Plan 
Location

Variable 
character

Extended 
alphanumeric

100

RecordType Record Type Variable 
character

Extended 
alphanumeric

32
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11.4.3  Create CVL list and links
In the Designer, open Global - [Administrator] as before, open Desktop, open 
Cvls. Click the New icon in the Designer title bar. Do the following:

� Create RecordType CVL List.
� Create File Plan locations CVL List.
� Create Record Type CVL Link.
� Create Classification Locations CVL Link.

Create RecordType CVL List
To create RecordType CVL list, use the following steps:

1. Select Lists and click the New icon in the Designer title bar. The New - CVL 
Configuration window opens.

2. In the Name field, type RecordType.

3. In the Type pick-list, select Standard.

4. Add the values: 

– Proposal Document
– Request for Proposal
– Correspondence

5. Click OK to save your changes.

Create File Plan locations CVL List.
To create file plan locations CVL list, use the following steps:

1. Select Lists and click the New icon in the Designer title bar. The New - CVL 
Configuration window opens.

2. In the Name field, type File Plan locations.

3. In the Type pick-list, select Standard.

4. You need to add all the destinations inside the file plan. For example:

– //ZXY Technologies/Default/UnclassifiedProposal
– //ZXY Technologies/Sales/Proposal00071

5. Click OK to save your changes.

Create Record Type CVL Link
To create RecordType CVL link, follow these steps:

1. Select Links and click the New icon in the Designer title bar. The New - CVL 
Configuration window opens.

2. In the Name field, type Record Types.
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3. Set Property drop-down list to RecordType.

4. Set CVL name drop-down list to RecordType.

5. Set Default Value drop-down list to Proposal Document.

6. Click OK to save your changes.

Create Classification Locations CVL Link
To create Classification Locations CVL link, follow these steps:

1. Select Links and click the New icon in the Designer title bar. The New - CVL 
Configuration window opens.

2. In the Name field, type Classification Locations.

3. Configure the rest of options as shown in Figure 11-3.

Figure 11-3   File plan location link

4. Click OK to save your changes.
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11.4.4  Modify your Add dialog box
You need to add the properties in Table 11-1 on page 403 to your add dialog box. 
Since we are using Sales Proposal class, you need to select the Sales Proposal 
- Add dialog box. 

In the Designer, open Global - [Administrator], open Desktop, open Actions 
and Dialogs. Do the following:

1. Expand Sales Proposal - Add dialog box.

2. Under your add dialog box, expand CVL Links. Drag and drop from Cvls:

– Classification Locations CVL Link
– Create Record Type CVL Link

3. Select again your add dialog box and click the Modify icon in the Designer 
title bar. 

4. Select Options tab:

Select Process Declare command and select Quick declare command 
options. It should look like Figure 11-4.

Figure 11-4   Add dialog box options tab

5. Click OK to save the changes.

Now when a user adds a new document, the window in Figure 11-5 opens. You 
can see that the first two attributes are related to the CVL link. So, when you 
import the document, it will be declared inside the file plan selected.
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Figure 11-5   By select quick declaration

11.5  Automation services declaration
Document Manager can be configured to execute an automatic job that searches 
the system to find documents that meet certain criteria. When the documents are 
found, a predefined action can be automatically performed. This action can be to 
declare the documents using the Quick Declare functions. 

The following steps comprise the tasks required to complete this exercise and 
create all the objects shown in Figure 11-6:

1. “Create rules” on page 408
2. “Create rule set” on page 409
3. “Create action” on page 410
4. “Create alarm” on page 410
5. “Create Job” on page 410
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Figure 11-6   Automation services declaration

For all these steps, you need to use Document Manager Designer. If you are not 
there, click Start → Programs → IBM DB2 Document Manager → Designer.

11.5.1  Create rules
In the Designer, open Global - [Administrator] as before, open Process, open 
Rules. In this example, we create two rules.

Create Reference Documents Rule rule: 

1. Click the New icon from design toolbar.

2. Set Name to Reference Documents Rule.

3. Set Property to Class.

4. Set Operator to Equal (==).

5. Set Value to Reference Documents.

Note: Before beginning, check that the following services are running:

� Records Manager Server
� Records Manager Enabler Server
� ICMRM server - CM Resource Manager
� DM Cache services 
� DM Lifecycle services
� DM Alarm service
� DM Automation service

Note: Rules are case sensitive. Be sure to write your rule values in the correct 
tense. 
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6. Click OK.

Create Reference Documents not declared rule:

1. Click the New icon from design toolbar.

2. Set Name to Reference Documents not declared.

3. Set Property to isRecord.

4. Set Operator to Not equal (!=).

5. Set Value to Yes.

6. Click OK.

11.5.2  Create rule set
In the Designer, open Global - [Administrator] as before, open Process, open 
Rule Sets. Do the following:

1. Click the New icon from the design toolbar.

2. Set Name to Declare Reference Documents.

3. Add the two previous rules as shown in Figure 11-7.

Figure 11-7   Rule Set definition
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4. Click OK.

11.5.3  Create action
In the Designer, open Global - [Administrator] as before, open Process, open 
Actions. Do the following:

1. Click the New icon from design toolbar.

2. Set Name to Declare Reference Documents.

3. Set Type to Quick Declare Record.

4. Set Action to Use class settings.

5. Click OK.

11.5.4  Create alarm
In the Designer, open Global - [Administrator] as before, open Process, open 
Alarms. Do the following:

1. Click the New icon from design toolbar.

2. Set Name to Start Reference Documents Declare.

3. Set Frequency to Periodically and set an hour to test it.

4. Click OK.

11.5.5  Create Job
In the Designer, open Global - [Administrator] as before, open Process, open 
Jobs. Do the following:

1. Click the New icon from design toolbar.

2. Set Name to Declare Reference Documents.

3. Check Item Bases option.

4. Click the Detail tab and populate the Detail page as shown in Figure 11-8:

a. Select Rule Set option.

b. Select Declare Reference Documents rule set you have just created.

c. Select Action option.

d. Select Declare Reference Documents action you have just created.

e. Set Alarm to Start Reference Documents Declare.
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Figure 11-8   Job configuration window

5. Click OK.

6. Select the job you have just created. Expand Privileges. Expand Groups.

7. Add grpManager, Admin, and grpSales.

11.6  Manual declare
Document Manager provides you the option to manually declare a record. This 
method allows for complete control of the process by a sophisticated user. This 
process requires the user to know the precise location in the file plan where the 
document should be classified and it allows for the entry of values for all the 
metadata attributes for the record. A manual declaration in Document Manager is 
performed by selecting the Manual Declare command on a menu or having it 
started by the option in a dialog. 

To enable a user to do manual declaration from the Document Manager menu, 
you need to configure the user’s Document Manager Desktop template to have 
the Manual Declare command. For our solution, we added the Manual Declare 
command to the right mouse menu. Figure 2-28 on page 42 shows you an 
example of Manual Declare from the pop-up menu through the right mouse click.
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You can configure the following type of dialog to enable manual declaration: Add, 
Checkin, and Version History.

To configure the Add dialog for manual declaration:

1. From the Designer tool, select an Add Action and Dialog.
2. Select the Options tab.
3. Set Process Declare command option to yes.
4. Select OK.

To configure the Checkin dialog for manual declaration:

1. From the Designer tool, select a Checkin Action and Dialog.
2. Select the Options tab.
3. Set Process Declare command option to yes.
4. Select OK.

To configure the Version dialog for manual declaration:

1. From the Designer tool, select a Version History Action and Dialog.
2. Select the Options tab.
3. Set the Enable [Manually Declare Record] command (right mouse) option 

to yes.
4. Select OK.

Records Manager has some options that you can configure to help in the manual 
declaration process. They are:

� Profiles: are used to filter the attributes that users need to fill when users 
manually declare a record. 

� Defaults: are used to automatically fill the default values in the add record 
form displayed to the user when the user tries to declare a record.

In this section, we show you step by step how to configure the Defaults and 
Profiles options in Records Manager. You need to use Records Manager 
Administrator client to do the configuration. If you are not there, click Start → 
Programs → IBM DB2 Records Manager → Administrator. Log in as 
Administrator.

Note: Before beginning, check that the following services are running:

� Records Manager Server
� Records Manager Enabler Server
� ICMRM server - CM Resource Manager
� DM Cache services 
� DM Lifecycle services
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11.6.1  Profile configuration
Select File Plan Design, and then click Profiles. You need to create the profiles 
shown in Figure 11-9. Each profile has the filter that will be used to show the user 
the add record form. If you do not define a Profile, the add record form will have 
several attributes users do not need to see.

Figure 11-9   Records Manager Profiles configuration

To create Add Correspondence:

1. Click Add in profile panel.

2. Select Correspondence from Component Definition drop-down list. Click 
OK.

3. Set Name to Add Correspondence.

4. Set Caption to Create a correspondence record.

5. Configure Selected Fields list as shown in Figure 11-10:
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Figure 11-10   Add Correspondence profile

6. Click Save. Click Cancel to close the windows.

To create Add Proposal Container:

1. Click Add in profile panel.

2. Select Proposal from Component Definition drop-down list. Click OK.

3. Set Name to Add Proposal Container.

4. Set Caption to Create a proposal container.

5. Configure Selected Fields list as shown in Figure 11-11.

Figure 11-11   Add Proposal container profile

6. Click Save. Click Cancel to close the windows.

To create Add Proposal Document:

1. Click Add in profile panel.

2. Select Proposal Document from Component Definition drop-down list. 
Click OK.

3. Set Name to Add Proposal Document.

4. Set Caption to Create a proposal record.

5. Configure Selected Fields list as shown in Figure 11-12.
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Figure 11-12   Add Proposal document profile

6. Click Save. Click Cancel to close the windows.

To create Add Request for Proposal:

1. Click Add in profile panel.

2. Select Request for Proposal from Component Definition drop-down list. 
Click OK.

3. Set Name to Add Request for Proposal.

4. Set Caption to Create a request for proposal record.

5. Configure Selected Fields list as shown in Figure 11-13.

Figure 11-13   Add Request for proposal profile

6. Click Save. Click Cancel to close the windows.

Assign user’s rights to each profile:

1. Click the User icon next to each profile.

2. Use Add Correspondence configuration example in Figure 11-14 to configure 
the four profiles.
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Figure 11-14   Profile security window

11.6.2  Default configuration
From the Records Manager Administrator client, select File Plan Design, and 
then click Default. You need to create the defaults shown in Figure 11-15. 

When you declare a record, you complete two required attributes:

� Name: the document name
� Proposal Number: the proposal number

The default we create here automatically fills the two required attributes with a 
default value for each record component in the system. 

Note: Users need to change these values when they manually declare a 
record.
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Figure 11-15   Records Manager Default configuration

To create Add Correspondence Name here default:

1. Click Add in default panel.

2. Set Name to Add Correspondence Name here.

3. Set Proposal Number to 00000.

4. Click Save. Click Cancel to close the windows.

To create Add Proposal Name here default:

1. Click Add in default panel.

2. Set Name to Add Proposal Name here.

3. Set Proposal Number to 00000.

4. Click Save. Click Cancel to close the windows.

To create Add Request for proposal Name here default:

1. Click Add in default panel.

2. Set Name to Add Request for proposal Name here.

3. Set Proposal Number to 00000.

4. Click Save. Click Cancel to close the windows.
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11.7  Create a Records Manager link
You can create a link between two records. For example, in our solution we 
create a link between the PDF file and the original Microsoft Word document.

To create a set, follow these instructions:

1. Log on to Document Manager Desktop client as usrSale.

2. Search for one PDF file or another child document you need to link to the 
father. 

3. Select it. Right-click and select Manually Declare record option from the 
pop-up menu.

4. A Records Manager form opens. At the bottom, check Add Record 
Relationship as shown in Figure 11-16.

Figure 11-16   Add a Records Manager link

5. Click Finish.

6. A new window with the link list opens as shown in Figure 11-17.

Note: Users who perform this task need the Add Link permission in Records 
Manager. You can add this via the Records Manager Administrator client.
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Figure 11-17   Link list window

7. Click Add Link. The new link window opens. 

8. Select Link to and click Browse. Find your father document and select it. It 
should look like Figure 11-18.
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Figure 11-18   New Link definition window

9. Click Save to save your new link.

If you access the record and look for the links, it should look like Figure 11-19.
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Figure 11-19   Links list

11.8  Create a Records Manager set
You can create a set between several records for administration purposes. For 
example, for our solution we want to create a set between all the versions of the 
same document that are already declared as a record.

For this example, we created a Reference Document. We did multiple checkouts 
and checkins to generate multiple versions. We subsequently declared the 
document as a record and then used the Version History dialog box to declare all 
previous versions as records as well. In Records Manager, each version is a 
separate record. Now we want to establish a set relationship between all these 
versions of the same document.

To create a set between these versions, follow these instructions:

1. Log on to Document Manager Desktop client as usrSale.
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2. Search for the Reference Document you have use to declare version history.

3. Right-click and select Version History from pop-up menu. 

4. To create the set, select the oldest version. Right-click and select View 
Records Management Information.

5. The File Plan Report window opens as shown in Figure 11-20.

Figure 11-20   File Plan report window

6. Click Action in the right. Click Set. The Set list window opens.

7. You need to add all the records you want in the set. In Figure 11-21, we show 
you a set example with a different document version.

Note: If your versions are not yet declared as record, you can select 
right-click, select Records Menu, select Manually Declare Record to 
declare it.
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Figure 11-21   Set list window

8. Click Add to set and the Set Add window opens. 

9. Complete File Plan Component with your version 1 document. You can click 
Browse to find it inside the file plan.

10.Select Add to. You can see an example in Figure 11-22.

11.Click Save to add the document in the set.

12.Repeat the procedure to add the rest of the document you want inside the set.
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Figure 11-22   Add a document to a set
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Chapter 12. System deployment

In the previous chapters, we show you how to install, configure, and implement a 
Document Manager solution with Records Manager from end-to-end. This 
chapter provides guidance about how to deploy the system. We focus on the 
steps you need to take to move your configuration from a development or testing 
system to a production system.

We cover the following topics:

� Deployment overview
� Exporting system configuration steps
� Importing system configuration steps
� System verification

12
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12.1  Deployment overview
When deploying a Document Manager solution from a testing or development 
environment to a production environment, you need to plan ahead for hardware 
and software installation and configuration, and the available time and resource 
available to perform the deployment. In this chapter, we focus only on the 
deployment of the Document Manager system from the application’s point of 
view.

Deployment step overview
The general steps for Document Manager system deployment are:

1. Export system configuration from the development system:

a. Export Content Manager configuration.
b. Export Document Manager configuration.
c. Export Records Manager configuration.

2. Import system configuration into the production system:

a. Import Content Manager configuration.
b. Import Document Manager configuration.
c. Import Records Manager configuration.

Deployment methods
There are two main methods to deploy the Document Manager configuration 
from one library to another:

� Use drag and drop.
� Use export/import processes.

Both techniques require similar procedures. The order of which objects are 
dragged and dropped, or exported and imported are the same. Behind the 
scenes, Document Manager uses export and import processes when you 
perform a drag and drop action. With drag and drop, you need to have both 
systems up and running and set up at the Document Manager Desktop. You 
move information from one system directly to another system. Using the export 
and import utilities, you can separate the import and export tasks and perform 
the tasks at different times. The data resulting from the export process can be 
used as a backup for the system. We recommend using the export and import 
processes to deploy your system whenever possible.

Data exporting and importing order
Exporting objects does not need to be done in a specific order. To import 
Document Manager or Records Manager objects, you must follow a specific 
object order. In the case of Document Manager, library configuration consists of 
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several objects that are interdependent among them. Some objects must be 
created first in order to create other objects that use the previous objects. Moving 
the configuration from one library to another library must be done in a specific 
order to be successful. This also applies for the Records Manager importing 
procedure.

Content Manager export and import order
For Content Manager, we recommend the following export and import order:

1. User groups
2. Users

Document Manager configuration export and import order
For Document Manager configuration, we recommend the following export and 
import order:

1. Library Attributes
2. Item Types
3. Classes (states, actions and dialogs, roles, CVL, life cycle, item numbering, 

new item templates, and property modification)
4. Actions and dialogs 
5. Desktop templates (menus, views, searches, property exchanges, and 

application integration)
6. Library configuration

Records Manager configuration export and import order
For Records Manager, we recommend the following export and import order:

1. Pick lists and Pick list Entries 
2. Security Descriptors 
3. Security Levels 
4. Security Classification Exemptions 
5. Security Classification Reasons 
6. Security Classification Guides 
7. Views 
8. Component Definitions and Component Attribute Definitions 
9. Component Definition Relationships 
10.Disposal Authorities 
11.Life Cycle Phases 
12.Record Hosts 
13.Groups 
14.Users 

Note: In steps 3 and 5, you must select the option Include all linked 
subcomponents for each listed object in order to export the object 
dependencies specified in parentheses.
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15.Life Cycle Codes 
16.Suspensions 
17.Profiles 
18.Defaults 
19.System Configuration 
20.File Plan Components and Relationships 
21.Reservations and Charge Outs 

12.1.1  Pre-deployment considerations
Before performing the deployment, outline all the activities that need to take 
place and plan ahead.

Determine how much disk space you need to do export and import. Make sure 
you allocate enough space before starting the deployment.

Determine the time you need to perform export and import and system validation 
afterwards. The file exporting process is fast and can be done earlier. We 
recommend you import the data in advance and practice importing before you 
actually perform system deployment. The general importing process is relatively 
fast also. The post importing steps are the steps that can take more time 
depending on how complex your system is. 

Plan ahead which type of manual work you need to do post-file import. This is 
because some design elements or custom information must be recreated 
manually in the production system. For example, even though the Document 
Manager Designer configuration can be exported from a development system 
and imported into a production system, some objects such as Document 
Manager dynamic search folders cannot be moved over. It is necessary to 
recreate all the folder structure again in the production environment and reassign 
the users and groups into the security tab on the folder properties using the 
folder administration utility. 

Make sure you have a validation and test plan. Allocate enough time to perform 
system validation and testing according to the plan. 

12.2  Exporting system configuration steps
Following are the suggested steps to export the complete system configuration 
from the development environment:

1. Export Content Manager users and groups configuration
2. Export Document Manager system configuration
3. Export Records Manager system configuration

 

 

 

 

428 IBM DB2 Document Manager with IBM Records Manager Solution Guide



12.2.1  Export Content Manager users and group configuration
To export Content Manager users and groups, use the following steps:

1. Open the Content Manager System Administration Client. Go to 
Authorizations → User Groups and from the right pane, highlight the 
groups shown in Figure 12-1.

Figure 12-1   Content Manager user groups window

2. Right-click any selected group and select Export to XML as shown in 
Figure 12-2.

Note: Assure that you have a clean working Document Manager system 
enabled for Records Manager fully installed and configured in the production 
environment before you attempt these steps. Refer to “Installation and 
configuration” on page 151 for end-to-end solution installation and 
configuration, including system validation.
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Figure 12-2   Selecting user groups to export

3. In the new window, specify the Destination directory where you want to 
save the user groups’ export file by using Browse, and the export File name 
as shown in Figure 12-3. Then click OK to start the export process.

Figure 12-3   Export path and file name for user groups
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4. When the export process finishes, click OK to close the export window as 
shown in Figure 12-4.

Figure 12-4   User groups export completed window

5. Now go to Authentication → Users and highlight the users shown in 
Figure 12-5.

Figure 12-5   Content Manager user window

6. Right-click any selected user and select Export to XML as shown in 
Figure 12-6.
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Figure 12-6   Selecting users to export

7. In the new window, specify the Destination directory where you want to 
save the users’ export file by using Browse, and the export File name as 
shown in Figure 12-7. Then click OK to start the export process.
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Figure 12-7   Export path and file name for users

8. When the export process finishes, click OK to close the export window as 
shown in Figure 12-8.

Figure 12-8   Users export completed window

Note: In this section, we only show exporting users and user groups because 
we do not define any new Content Manager ACL. If you create new ACLs for 
your system, you must also export all the Authorization objects you created. 
These can include privileges, privilege groups, privilege sets, and access 
control lists.
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12.2.2  Export Document Manager system configuration
To export the Document Manager system configuration, do the following:

1. Open the Document Manager Designer. Highlight the library icon and click 
Export in the Designer tool bar as shown in Figure 12-9.

Figure 12-9   Document Manager Designer window

2. In the Export Library Configuration windows, uncheck the Include all linked 
sub-components for each listed object box and click Browse to specify a 
path and file name for the library attributes export file as shown in 
Figure 12-10.
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Figure 12-10   Export library configuration window for library attributes

3. Now click Objects and in the Select Objects window, choose Library 
Property in the Type select box as shown in Figure 12-11. Be sure to select 
all the attributes used for your system. Table 12-1 lists these attributes.

For your convenience, we have also prepared a set of data files exported 
from the case study system. You can download them from the Web and 
import them using the procedures provided in this chapter.

To download the materials, refer to Appendix B, “Additional material” on 
page 487.

Table 12-1   Attributes used in Document Manager Item Types

Authors CustomerEMail FileName ProposalSubject To

DM_Class DM_Date MailSubject ReqPropNum DM_Number

CreateDate DateReceived PotentialRev DM_Revision

CustomerName DeliveryDate DM_Properties DM_State

CustomerNumber eMailNumber ProposalNumber Title
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Figure 12-11   Library attributes selection window

4. Click Add after you select them all and verify all the attributes are shown as in 
Figure 12-12.

Tip: As you probably might have more library properties, or objects, defined in 
your development system, when exporting, be sure to select only the ones 
used for your application that you want to export so you do not import 
unnecessary objects into your production system.
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Figure 12-12   Library attributes to export

5. Click Process and verify that the status of all the attributes change from Not 
Processed to Exported as shown in Figure 12-13. After that, verify that the 
file specified in Export data file was created.
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Figure 12-13   Exported library attributes

6. Select all the attributes exported and click Delete to clear the Configuration 
Objects grid. 

7. Repeat the export steps for the object types and objects listed in Table 12-2.

Table 12-2   Exported data from the sample application

Export file name Object type Include all linked 
componentsa

Object names

c:\temp\DMExportFiles\I
temType

CM Item Type Unchecked LibraryObjects
CustomerData

c:\temp\DMExportFiles\
Classes

Class Checked Correspondence
Document Template
Marketing Proposal
Reference Documents
RFP
Sales Proposal
Saved Search
Services Proposal
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Steps used to export the objects:

a. Check or uncheck the Include all linked sub-components for each 
listed object box depending on the type of the objects.

c:\temp\DMExportFiles\
ActionsDialogs

Action and 
Dialog

Unchecked Correspondence - Add
Correspondence - Modify
DM - Add
DM - Checkin
DM - Checkout
DM - Copy
DM - Modify
DM - Revise
DM - Version History
DM - View
DocTemplate - Add
Marketing Proposal - Add
Marketing Proposal - Modify
Proposal - Checkin
Proposal - Revise
Reference Document - Add
Reference Document - Modify
RFP - Add
RFP - Modify
Sales Proposal - Add
Sales Proposal - Add RM
Sales Proposal - Modify
Saved Search - Add
Services Proposal - Add
Services Proposal - Modify

c:\temp\DMExportFiles\
Desktop

Desktop 
Template

Checked Admin Template
Content Producer Template
Default Template
Viewers Template

c:\temp\DMExportFiles\
LibraryConfiguration

Library 
Configuration

Unchecked Library Configuration

c:\temp\DMExportFiles\
Rendition

Rendition 
Configuration

Checked Sales Rendition

c:\temp\DMExportFiles\
Jobs

Process Job 
Configuration

Checked Declare Reference Documents
(This is for automation service)

a. This is the Include all linked sub-components for each listed object option on the Export 
Library Configuration panel.

Export file name Object type Include all linked 
componentsa

Object names 
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b. Specify a new export file name for the configuration objects using the 
Browse button.

c. Click Objects and select the appropriate type from the drop-down list in 
the Select Objects panel.

d. Select the appropriate objects. Click Add after you finish.

e. Verify that the objects you select are shown in the grid and then click 
Process. 

f. After the process finishes, verify that the status of each object changed 
from Not Processed to Exported and that the export file specified is 
created.

g. Highlight all the exported objects and click Delete to clear the 
Configuration Objects grid. 

8. Click Done to close the Export Library Configuration window.

12.2.3  Export Records Manager system configuration
To export the Records Manager system configuration, do the following:

1. Log on to the Records Manager Import Export utility with a user who belongs 
to the administrators group.

2. Select a working directory by using the Browse button and select all the 
items to export by clicking on the check box at the right of each item as shown 
in Figure 12-14, except Record Host, Groups, and Users. Click Export 
when you finish.

Figure 12-14   Records Manager import export utility
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3. When the export process finishes, click OK to exit the export window as 
shown in Figure 12-15.

Figure 12-15   Export configuration window

4. Verify that one XML file was created for each selected item you chose, in the 
working directory, as shown in Figure 12-16. Then close the Records 
Manager Import Export utility.

Figure 12-16   XML exported files
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12.3  Importing system configuration steps
Following are the suggested steps to import the complete system configuration 
to the production environment:

1. Import Content Manager users and groups configuration
2. Import Document Manager system configuration
3. Import Records Manager system configuration

12.3.1  Import Content Manager users and groups configuration
To import Content Manager users and groups, do the following:

1. Open the Content Manager System Administration client and from the Tools 
menu, select Import XML as shown in Figure 12-17.

Figure 12-17   Content Manager import option

Note: After successfully exporting the whole system configuration, you have 
to move the resulting export files for each component (Content Manager, 
Document Manager, and Records Manager) into the production server or 
servers that comprise the production environment. We recommend to burn the 
files into a CD to maintain a backup of this configuration.
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2. In the new window, click Browse at the right of Administrative objects file 
as shown in Figure 12-18.

Figure 12-18   Content Manager import window

3. Look for the file where you save the user groups configuration and click Open 
as shown in Figure 12-19.

Figure 12-19   User groups export file

4. Select Process interactively option under Processing options pane and 
click Import as shown in Figure 12-20.
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Figure 12-20   Content Manager user groups import window

5. In the next window, expand User groups and verify that all the groups you 
exported are in the list as shown in Figure 12-21. Then click Continue.

Figure 12-21   User groups to import

6. In the next window, select Log error and continue and click Import to start 
the import process as shown in Figure 12-22.
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Figure 12-22   Importing selection confirmation for user groups

7. When the import successful window opens, as shown in Figure 12-23, click 
OK to exit the import process.

Figure 12-23   Successful import for user groups

8. Now open the Content Manager import window again but, this time look for 
the file where you save the users’ export file as shown in Figure 12-24. Then 
select Process interactively option and click Import.

Note: Make sure you double-check that everything is imported. We 
recommend at least check to see the last group is imported. 

At the time of this writing, the last group was not imported correctly. To get 
around it, we manually created a dummy group in the end, so the one that we 
need to import is not the last one and can be imported successfully to the 
system.
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Figure 12-24   Content Manager users import window

9. In the next window, expand Users and verify that all the users you exported 
are in the list as shown in Figure 12-25. Then click Continue.

Figure 12-25   Users to import

10.In the next window, select Log error and continue and click Import to start 
the import process as shown in Figure 12-26.
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Figure 12-26   Importing selection confirmation for users

11.When the import successful window opens, as shown in Figure 12-27, click 
OK to exit the import process.

Figure 12-27   Successful import for users

12.In the Content Manager System Administration Client, go to 
Authentication → Users, click refresh and verify all the users you exported 
are there as shown in Figure 12-28.
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Figure 12-28   Content Manager users window

13.Go to Authentication → User Groups, click refresh and verify all the user 
groups you exported are there as shown in Figure 12-29.

Figure 12-29   Content Manager user groups window
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12.3.2  Import Document Manager system configuration
To import Document Manager system configuration, do the following:

1. Open the Document Manager Designer tool, highlight the library folder and 
click Import from the control panel as shown in Figure 12-30.

Figure 12-30   Document Manager Designer import button

2. In the import window (Figure 12-31), click Browse.
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Figure 12-31   Document Manager import window

3. Now, look for the file where you saved the library attributes definition as 
shown in Figure 12-32. Then, click Open to return to the import window.

Figure 12-32   Select file to import

4. Click Next as shown in Figure 12-33.
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Figure 12-33   Library attributes import window

5. Select All from Process option, click Process import directly check box as 
shown in Figure 12-34, and then click Next.
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Figure 12-34   Library attributes selection

6. All library attribute status should change from Not verified to Update 
success as shown in Figure 12-35.
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Figure 12-35   Library attributes success import

7. Repeat the importing steps for the following files:

– File that contains Item Type definitions
– File that contains Item Type classes definitions
– File that contains actions and dialogs definitions
– File that contains desktop templates definitions
– File that contains library configuration definition 
– File that contains rendition definitions
– File that contains automation jobs definitions

Use the following as the importing steps:

a. Click Browse to look for the file.

b. Select All from Process option, click Process import directly check box 
and click Next.

c. All status should change from Not verified to Update success.

8. Click Done to close Import Library Configuration window.
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Post Document Manager configuration import process
After importing the Document Manager configuration, complete the following 
steps in order to have the system operational:

1. Change the e-mail addresses you used in the development environment in 
the e-mail notification objects to valid e-mail addresses for the production 
system.

2. Recreate the folder structures and security schemas for each folder you 
define in the development environment into the production system because 
Document Manager does not export folders.

3. Recreate saved searches if you created them in the development 
environment. You assign them to dynamic folders.

4. Configure the rendition services queues to be processed in the remote 
rendition services machines or they will be processed only in the local server.

5. Load the document templates you used in development into production in 
order to be able to use the Create from Template menu option.

6. The lifecycle map for each controlled class must be recreated in the new 
system.

7. Do not forget to perform a complete refresh of the Document Manager cache 
files before attempting to log on to the system with the Document Manager 
Desktop client.

12.3.3  Importing Records Manager system configuration

To import Records Manager system configuration, do the following:

1. To import user and groups from Content Manager, open the Records 
Manager Administration tool and go to Security → Users. From Host Filter, 
select the Content Manager Library Server database (by default ICMNLSDB) 
and click Import as shown in Figure 12-36.

Note: Before importing the Records Manager configuration files, within the 
Records Manager administration tool, import the users and groups from the 
Content Manager server.
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Figure 12-36   Records Manager user import

2. Select all the users you want to import as shown in Figure 12-37 and click 
Import.
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Figure 12-37   Import selection users

3. In the Properties section, select the File Plan Administration check box as 
shown in Figure 12-38.
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Figure 12-38   Import user window - properties

4. In the bottom of the same window, select the Is Active check box as shown in 
Figure 12-39. Then, click Save.
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Figure 12-39   Import user window - Is active

In the users window, you should see all the users you imported as shown in 
Figure 12-40.
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Figure 12-40   Imported users window

5. Click System Permissions and select all component definitions as shown in 
Figure 12-41.
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Figure 12-41   Components definitions selection

6. Click Permissions and select Add and View permissions for all users except 
DDMSERVICE user as shown in Figure 12-42. Then, click OK.
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Figure 12-42   User permissions selection

You should see the permissions assigned to the users as in Figure 12-43.
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Figure 12-43   Assigned permissions to users

7. Assign to DDMSERVICE user only View permission, because this is the 
only permission this user needs. You should see this in Figure 12-44.
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Figure 12-44   Ddmservice user view permission assigned

8. After finishing importing the Content Manager users and groups, close the 
Records Manager Administration program and open the Records Manager 
Import Export utility. Log in with a user who belongs to the administrators 
group. Select the working directory where you copied the Records Manager 
exported files and select All items to assure that the correct importing order 
will be maintained by the importing process as shown in Figure 12-45.
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Figure 12-45   Records Manager import export utility

9. Click Import to start importing the objects and when importing the objects 
finishes, click OK to close the status window as shown in Figure 12-46.

Figure 12-46   Import export utility status window

10.Close the Import Export utility.

12.4  System verification
After you successfully import all the configuration objects, you should run the 
cache manager service to refresh cache files and then verify that each service 
can connect and run with no problems. Then, you should try to log on to the 
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production system with each of the valid users defined for the system, using the 
Document Manager Desktop client, and try to add documents, move them 
through their entire life cycle (if any are configured) and try every single option in 
the client Desktop.

Verify that each configured function in the development system is working in the 
production environment, including views, searches, desktop templates, 
document renditions, e-mail notifications, and records declarations.

Testing the complete system might take from a couple of minutes, to hours, to 
days, depending on how complex your system is and how much validation and 
testing you need to do. 
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Appendix A. Case study

This appendix describes the case study we used throughout this redbook. The 
purpose of the case study is to identify common, non-industry specific, document 
management applications, to demonstrate the Document Manager (along with 
Records Manager) capabilities, and to illustrate ways to create a solution that will 
translate into any industry or corporation.

This appendix covers the following topics for the case study:

� Introduction
� Requirements
� Solution planning
� Solution design
� Records Manager options

A
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A.1  Introduction
The case study involves a hypothetical company, ZXY Technologies. It sells 
hardware, software, and services to its clients. ZXY Technologies needs an 
enterprise wide, document management solution to help the company with the 
proposal creation processes and keep track of all the correspondence related to 
the proposals. All the issued proposals also need to be maintained as corporate 
records. ZXY Technologies needs the solution to be able to support records 
management.

We use the case study to provide concrete planning and design examples that 
you can use to plan and design your solution. In addition, we use the case study 
to show you the practical steps in implementing a Document Manager solution 
configured with Records Manager options.

A.2  Requirements
ZXY Technologies needs an enterprise wide, document management solution to 
help the company with the proposal creation processes and keep track of all the 
correspondence related to the proposals.

ZXY Technologies has requirements for the following document types:

� Proposals
� Correspondence
� Records and confidential documents

A.2.1  Proposals
Every month, ZXY Technologies handles hundreds of requests for proposals 
from its clients.

Proposals are commonly used both to request information and to submit 
information. Proposal requests are issued by customers requesting pricing or 
product information and proposal responses are issued by the ZXY Technologies 
company providing pricing or product information. 

Proposals requests are sources of unstructured data. They contain information 
critical to a project or critical to serving a customer. They may come in the form of 
an e-mail, phone call, fax, or a business letter.

With proposal responses, ZXY Technologies delivers required information to 
customers based on proposal requests. There are multiple steps in the proposal 
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(response) creation process – response creation, review, approval, and delivery 
to the customers.

ZXY Technologies needs a solution to manage all documents involved in the 
proposal creation process from end-to-end. This includes managing documents 
from the beginning, when the requests for proposals arrive from customers as 
e-mails, faxes, or correspondence, until the end, when the formal proposals are 
delivered to the customers. 

The company has different departments that deal with different types of 
proposals. 

There are three types of proposals:

� Sales proposals: These are proposals related to selling hardware and 
software to external customers. They are created by salespeople and are 
delivered to customers.

� Services proposals: These are proposals related to selling services to 
external customers. They are created by consultants and are delivered to 
customers. 

� Marketing proposals: These are proposals related to marketing campaigns for 
the ZXY Technologies. They are created by marketing people and are 
delivered to internal clients within the company.

The ZXY Technologies wants to manage different proposals with separate 
templates, so that each department is responsible for the final proposal delivery. 
It also wants a system that can automatically send e-mails to people who need to 
review or approve the proposals, to accelerate the entire proposal creation 
process.

Generally, the proposal process goes through the following business steps:

1. The external or internal client sends a request for proposal.

2. The sales, consultant, or marketing people create a proposal using a 
predefined proposal template. The proposal creator then sends the proposal 
for review.

3. The reviewers are the department managers and financial people that control 
the proposal before it goes to the approved state.

4. Depending on the type of the proposal, usually, the manager of the 
department is responsible to finally approve or reject the proposal.

5. If approved, the formal proposal is sent to the external or internal customer.
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In addition, ZXY Technologies wants to automatically generate a unique ID for 
each proposal so that it is easier to track the proposals. The unique IDs can also 
be used as references in other administrative documents.

The employees in ZXY Technologies use Microstate Word to create proposals, 
but they use PDF as the standard delivery format for the final proposals to 
customers.

A.2.2  Correspondence
Everyday, there are hundreds of letters coming in and out of ZXY Technologies. 
The correspondence helps in the completion of sales. For example, the account 
manager uses information received from the sales manager (e-mails with pricing 
approvals) and information received from the customer (courier delivery of the 
request for proposal) to deliver a completed price proposal and to close a sale. 
The correspondence may also hinder the company if the correspondence is not 
managed properly and efficiently. For example, if the account manager 
referenced information from an old e-mail with out-of-date cost information and 
delivered the incorrect pricing information to the customer, ZXY Technologies 
can lose money on the eventual sales transaction. The account manager may 
also have been affected if the request for proposal did not reach the account 
manager’s desk in time to respond, or if the account manager was out of the 
office at the time and no one took over the account manager’s workload.

In summary, ZXY Technologies needs a document management system that can 
help it to capture, control, and access the selected data coming in and out 
through the basic correspondence channels of the organization.

In addition, project-related e-mails and attachments must be stored in the system 
and should be stored based on the discretion of employees of ZXY 
Technologies.

A.2.3  Records and confidential documents
Due to regulations and company policies, all finalized proposals of ZXY 
Technologies should be made official company records. ZXY Technologies 
therefore is looking for a document management system that can automatically 
declare these finalized proposals as records. In addition, it needs to have the 
ability to manually declare special documents, such as reference documents or 
correspondence used for the proposals, as records.
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A.3  Solution planning
As discussed in “Planning for a Document Manager solution” on page 48, the 
general planning process includes:

1. Identify document types.
2. Identify producers, approvers, and consumers of documents.
3. Identify document characteristics and document life cycle.
4. Define documents that should be records.

A.3.1  Document types
For the case study, we identified the following type of documents that the 
solution needs to manage:

� The Request For Proposal (RFP) documents that customer send us

� The correspondence we receive from and send to our customers

� The sales proposal documents

� The marketing proposal documents

� The services proposal documents

� References documents, such as minutes, budgets, graphics, and Microsoft 
PowerPoint presentations

� Standard document templates

A.3.2  Producers, approvers, and consumers
For the case study, we identified the following groups of users for the solution:

� Managers: They are the managers of the various departments. They have the 
responsibility to review and approve the proposal documents.

� Salespeople: They work in the sales department. They receive requests for 
proposals from customers. They are responsible for preparing the sales 
proposal documents and delivering the approved proposals to customers.

� Marketing people: They work in the marketing department. They receive 
requests for proposal from internal customers. They are responsible for 
preparing the marketing proposal documents and delivering the approved 
ones to internal customers.

� Consultants: They work in the services department. They receive requests for 
proposals from customers. They are responsible for preparing the services 
proposal documents and delivering the approved ones to customers.
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� Financial analysts: They are the company’s financial analysts. They are 
responsible for reviewing all the proposal documents to ensure that the 
financial information in the proposals is correct.

� Viewers: They work in the company, but are not directly involved with the 
proposal creation process. They are interested in viewing the proposals 
before they are delivered.

When further analyzing those who are the producers, approvers, and consumers 
of the documents, we use the following four roles:

� Approvers: 

They are the approvers of the documents. People with this role are those who 
belong to the following group:

– Managers

� Creators: 

They are the producers of the documents. People with this role are those who 
belong to the following groups:

– Consultants
– Marketing people
– Salespeople

� Reviewers: We consider them as approvers of the documents.

We consider them almost as the approvers of the documents. People with 
this role are those who belong to the following groups:

– Managers
– Financial analysts

� Viewers: 

They are the consumers of the documents. People with this role are those 
belong to the following group:

– Viewers

A.3.3  Document characteristics and life cycle
There are many characteristics for each type of document. For the simplicity of 
presenting information in this appendix, we only give an example of some of the 
characteristics we identified for a sales proposal.

Sample document characteristics of a sales proposal
The sales proposals are created in Word. Each sales proposal has a 
corresponding subject and customer information associate with it. The proposal 
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can be edited until it is reviewed and approved. There may be multiple reference 
documents associated with the sales proposal. 

Document life cycle
We identified the following business processes (life cycle):

1. Request For Proposal (RFP) and Sales Proposal process

2. RFP and Services Proposal process

3. RFP and Marketing Proposal process

4. Correspondence process

The first three business processes have similar life cycles. We explain the first 
one in detail here.

RFP and Sales Proposal business process
The process is analyzed as follows:

1. A customer needs a new product and send a Request For Proposal (RFP) to 
ZXY Technologies. 

2. The Salespeople receive the e-mail, decide to respond the customer and 
create a new sales proposal document.

3. When the proposal document is complete, a designated financial analyst and 
a corresponding manager review the proposal. 

4. If everything looks good, the manager approves the proposal.

5. Once the proposal is approved, it is converted to PDF format and is sent to 
the customer who requested the proposal. The proposal at this time is 
considered issued.

6. Once the proposal is approved and issued, it is treated as a corporate record 
and must be kept for seven years.

7. Other people in the company at this time may view the issued proposal. They 
can view the hard copy or the soft copy in PDF format.

Correspondence process
Correspondence needs to be tracked. When incoming correspondence related to 
RFPs and proposals are received by ZXY Technologies, they need to be 
attached to the associated proposals. For any outgoing correspondence sent to 
customers, the correspondence also needs to be kept with the proposals and 
tracked by the system. 
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A.3.4  Documents that should be records
All proposals that are approved and issued should be kept as corporate records. 
In addition to the proposals, the corresponding requests for proposals, and the 
associated reference documents should be considered as corporate records. 
The requests for proposals should become corporate records as soon as they 
are added to the Document Manager system. For the associated reference 
documents, users decide whether they should be made records and when to 
make them records. Once the documents become corporate records, they need 
to be kept for seven years.

A.4  Solution design
As discussed in “Designing a Document Manager system” on page 51, the steps 
in designing a Document Manager system include:

1. Define users, groups, and roles.
2. Define the data model for your document system.
3. Define document life cycles.
4. Design the Document Manager application interface.

The application interface design is not included in this appendix. Refer to “Basic 
Document Manager implementation” on page 243 for the actual implementation 
of the interface.

A.4.1  Users, groups, and roles
For the Document Manager system, we need to define users, groups, and roles. 
We also map roles to the actions you can perform in the system.

Groups
Based on the groups identified during the planning session, we define a list of 
groups as shown in Table A-1 for the Document Manager system.

Table A-1   Groups

grpSales

grpMarketing

grpServices

grpManagers

grpFinancials

grpViewer
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Users
For the case study, we define a few sample users for testing purposes as shown 
in Table A-2.

Table A-2   Users

Roles
Based on the job responsibilities that the users have, that is the roles that they 
play, as identified in the planning session, we define the roles, as shown in 
Table A-3.

Table A-3   Roles

Actions and roles mapping
Table A-4 is a matrix that maps the defined user roles to the actions that the 
users in the role can perform in a Document Manager system.

Table A-4   Mapping user roles to Document Manager actions

grpProjectManager

User Group

usrSale grpSales

usrMarketing grpMarketing

usrService grpServices

usrFinancial grpFinancials

usrManager grpManagers

usrProjectManager grpProjectManager

usrViewer grpViewer

Creators

Reviewers

Approvers

Viewers

Approvers Creators Reviewers Viewers

Add items X
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A.4.2  Data model 
In this section, we define document attributes, also known as library properties, 
item types, and classes.

Attributes (library properties)
We designed a list of attributes for the documents, as shown in Table A-5.

Table A-5   Attributes (library properties)

Checkout X X X

Copy X

Revise items X X

Modify 
properties

X X

Print X X X X

Transition X X X

View X X X X

Markup X X X

Approvers Creators Reviewers Viewers

Name Display name Attribute type Character 
type

Character 
length

Customer
Name

Customer
Name

Variable 
character

Extended 
alphanumeric

32

Customer 
Number

Customer 
Number

Variable 
character

Extended 
alphanumeric

32

RequestPropNum Request for 
Proposal 
Number

Variable 
character

Extended 
alphanumeric

32

Proposal Number Proposal 
Number

Variable 
character

Extended 
alphanumeric

32

Proposal Subject Proposal 
Subject

Variable 
character

Extended 
alphanumeric

32

Author Author Variable 
character

Extended 
alphanumeric

32
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Item types
We determine that except for the standard document templates, the other type of 
documents listed in “Document types” on page 473 all shared many common 
attributes. We conclude that we only need two item types to model the various 
document types in our solution. The item types are listed in Table A-6.

Table A-6   Item type definitions

Potential
Rev

Potential Rev Variable 
character

Extended 
alphanumeric

CreateDate Create Date Date

DeliveryDate Delivery Date Date

eMailNumber eMail Track 
Number

Double

From From Variable 
character

Extended 
alphanumeric

64

To To Variable 
character

Extended 
alphanumeric

256

MailSubject Mail Subject Variable 
character

Extended 
alphanumeric

256

DateReceived Date Received Date

Item types Description

CustomerData The CustomerData item type is for storing the following 
document types:
� Customer RFP
� Sales proposal
� Marketing proposal
� Services proposal
� Correspondence
� Reference documents

LibraryObject The LibraryObject item type is for storing the standard 
document templates and predefined DM queries. The 
predefined DM queries are specific to DM. They are the DM 
saved queries. DM queries are queries that we define and 
save to be reused.

Name Display name Attribute type Character 
type

Character 
length
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The details of the item type definitions are not presented here. Download the 
source code from the web to see the detailed item type definitions.

Classes
Table A-7 shows a listing of the classes that we designed to model the different 
types of documents represented by the CustomerData item type.

Table A-7   CustomerData Classes

Table A-8 shows a listing of the classes that we created for documents that will 
be stored under the LibraryObject item type.

Table A-8   LibraryObject Classes

A.4.3  Business processes to life cycle modelling
We define document states, detailed document life cycles, and associated states 
with classes.

Document states
Based on the document life cycle discussed in the planning session, we created 
a list of the document states as shown in Table A-9.

Table A-9   Document states

Classes Description

Correspondence For storing the correspondence documents received from 
and sent to customers.

RFP For storing the RFP documents received from customers.

Marketing Proposal For storing the marketing proposal type documents.

Sales Proposal For storing the sales proposal type documents.

Services Proposal For storing services proposal type documents.

Reference Documents For storing documents, such as meeting minutes, budgets, 
presentations, videos, and so on.

Classes Description

Document Template For storing company standard document templates.

Saved Search For storing DM predefined queries.

Draft

Review
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Document life cycle
We design the detailed processes (life cycle steps) for each process:

� RFP and sales proposal life cycle
� Correspondence life cycle

RFP and Sales Proposal life cycle
Figure A-1 shows the entire proposal life cycle, from RFP arrives to proposal 
rendition and records declaration.

Figure A-1   RFP and sales proposal life cycle
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RFP
Document

grpSales

Create
Sales Proposal Class
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2
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The detailed business process is as follows:

1. A customer needs a new product and sends a Request for Proposal (RFP) to 
ZXY Technologies. 

2. The salespeople receive the mail, decide to respond the customer, and 
create, in Document Manager, a new sales proposal class document from a 
template provided in the system.

When the proposal is added to the system:

a. The document enters the Draft state.

b. A proposal number is automatically generated.

c. A notification is sent to a project manager to create a container in Records 
Manager. The new proposal number is sent in the notification.

Once a salesperson finishes writing and modifying the proposal, the original 
owner sends the proposal for review. This moves the document to the Review 
state.

3. The project manager receives the e-mail and creates a new Record Manager 
Container with the new proposal number. 

4. Now that the Records Manager Container is created, the salesperson adds 
the RFP class document into the system. The salesperson has to fill the 
proposal number information. The automatic record declaration function of 
the system uses this information later.

When the request for proposal (RFP) document is added to the system:

a. The document enters the Incoming state.

5. In the Incoming state, the document is automatically declared as record. It is 
stored in the Proposal Number container inside the file plan.

6. When the proposal document enters the Review state, an automatic 
notification is sent to the designated finance people and managers.

They receive the notification mail and review the proposal document.

Once they finish reviewing the document, they send the proposal document 
for final approval. This moves the proposal document to the Approval state.

7. Managers review the document one last time, approve the document, and 
send the document to issue. This moves the proposal document to the Issued 
state.

8. When the proposal document enters the Issued state, the revision number is 
set to 01.

9. The document is automatically declared as a record when it enters the Issued 
state. It is assigned in the Proposal Number container inside the file plan.
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10.The proposal document is automatically rendered as a PDF. The new file is 
created with the same class but in a different state. The PDF file will be in the 
PDF state.

11.A new revision can be created when the proposals are in the Issued state. 
The new document will have a revision number of 01-0A and will be in the 
Draft state. When the new document reaches the Issued state, the original 
document with the revision number 01 will be moved to the Superseded state. 
The new document will have a new revision number of 02-0A. Additional 
revisions will follow the same steps and the revision number will increase 
automatically.

Correspondence life cycle
Correspondence is used to hold relevant documents related to RFP and 
Proposals. Figure A-2 shows the correspondence life cycle.

Figure A-2   Correspondence life cycle

There are two states involved:

� Correspondence - Incoming State
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All the received documents related to RFP and proposals need to be added to 
the system. Sales, services, or marketing people will create a new 
Correspondence class document with the Incoming state.

� Correspondence - Outgoing State

All the documents that are sent related to the RFP and proposals need to be 
added to the system. Sales, services, or marketing people will create a new 
Correspondence class document, with the Outgoing state.

Managers will create a new Correspondence class document, with the 
Outgoing state, for the last response to the customer with the proposal.

A.5  Records Manager options
To configure Records Manager functions to the Document Manager solution, we 
need to design a file plan, decide what documents should be records, and when 
to declare them. We also need to establish the retention schedule.

File plan
We designed the file plan to address a number of solution requirements. Each 
department in ZXY Technologies is required to create and manage their own 
proposals. Each proposal contains a set of documents: versions of the proposal, 
the request for proposal, and correspondence (including support documents) 
that pertain to the proposal. 

The file plan, as shown in Figure A-3, models the hierarchy of the organization 
and the proposal containers within each department. The proposal containers 
are created dynamically by the project manager as each new proposal is 
identified. Under the proposal container are the three types of records relating to 
the proposal documents.
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Figure A-3   File plan for solution

Records declaration
For the case study, the proposal documents that have been approved and go to 
the Issued state automatically become records. Any correspondence that enters 
the Incoming or Outgoing state also automatically becomes records. Other 
non-automatic record declarations are also configured in the Desktop for users to 
use.

For all the reference documents, users can decide whether they should be made 
to be records or not. Users can declare reference documents as records in their 
Desktops, using selection declaration with a predefined list of file plan 
destination.

Retention schedule
For the case study, we define a single retention schedule that applies to all of the 
proposal-related documents. This rule retains the proposal in active status for 
one year (at which point it is closed), and then the proposal is retained for seven 
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Appendix B. Additional material

This redbook refers to additional material that you can download from the 
Internet as described below. 

Locating the Web material
The Web material associated with this redbook is available in softcopy on the 
Internet from the IBM Redbooks Web server. Point your Web browser to:

ftp://www.redbooks.ibm.com/redbooks/SG247180

Alternatively, you can go to the IBM Redbooks Web site at:

ibm.com/redbooks

Select the Additional materials and open the directory that corresponds with 
the redbook form number, SG247180.

Using the Web material
The additional Web material that accompanies this redbook includes the 
following files:

File name Description
SG247180_v.zip Product installation viewlets

B
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ftp://www.redbooks.ibm.com/redbooks/SG247180
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SG247180_d.zip Export data files for the case study

System requirements for downloading the Web material
We recommend the following system configuration:

Hard disk space: 200 MB
Operating System: Windows
Processor: Pentium® IV or higher
Memory: 512 MB

How to use the Web material
Create a subdirectory (folder) on your workstation, and unzip the contents of the 
Web material zip file into this folder.
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Related publications

The publications listed in this section are considered particularly suitable for a 
more detailed discussion of the topics covered in this redbook.

IBM Redbooks
For information about ordering these publications, see “How to get IBM 
Redbooks” on page 490. Note that some of the documents referenced here may 
be available in softcopy only. 

� Content Manager Implementation and Migration Cookbook, SG24-7051

� E-mail Archiving and Records Management Integration Solution Guide Using 
CommonStore and Records Manager, SG24-6795

� Quick Reference: Records Management 101, TIPS0595

Other publications
These publications are also relevant as further information sources:

� IBM DB2 Document Manager V8.3: Installation Guide, GC18-9272

� IBM DB2 Document Manager V8.3: System Administration Guide, 
SC18-9254

� IBM Records Manager V8.3: Installation Guide, SC18-9185

� IBM Records Manager V8.3: Administrator’s Guide, SC18-9180

� IBM Records Manager V8.3: Technical Reference Guide, SC18-9181

� IBM Content Manager for Multiplatforms V8.3: Planning and Installing Your 
Content Management System, GC27-1332

� IBM DB2 Content Manager for Multiplatforms V8.3: System Administration 
Guide, SC27-1335

� IBM DB2 Content Manager Records Enabler V8.3: Installing and Configuring, 
GC18-7570

� IBM DB2 Content Manager Records Enabler V8.3: User’s Guide, SC18-7571
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Online resources
These Web sites and URLs are also relevant as further information sources:

� IBM DB2 Document Manager main page:

http://www.ibm.com/software/data/cm/docmgr/

� IBM Records Manager main page:

http://www.ibm.com/software/data/cm/cmgr/rm/

� IBM DB2 Content Manager main page:

http://www.ibm.com/software/data/cm/

� IBM DB2 Content Manager V8.3 Information Center:

http://publib.boulder.ibm.com/infocenter/cmgmt/v8r3m0

How to get IBM Redbooks
You can search for, view, or download Redbooks, Redpapers, Technotes, draft 
publications and Additional materials, as well as order hardcopy Redbooks or 
CD-ROMs, at this Web site: 

ibm.com/redbooks

Help from IBM
IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
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on practical end-to-end solution installation, configuration, 
implementation, and deployment. We use a case study to show you 
practical, implementation steps for the solution, including setting up 
basic and advanced Document Manager features and records 
declaration options within the solution.
This redbook is intended for IT architects and specialists, who will be 
responsible for planning, designing, and implementing a Document 
Manager solution with Records Manager. We recommend using this 
redbook in conjunction with existing product manuals.
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